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Geosoft License Agreement
Should there be a separate signed agreement between you and Geosoft, or between your company and
Geosoft, pertaining to the licensed use of this software, that agreement shall take precedence over the
terms of this agreement.

1. DEFINITIONS:
In this Agreement:
"Licensed Program(s)" means the actual copy of all or any portion of Geosoft’s proprietary software
technology, computer software code, components, dynamic link libraries (DLLs) licensed through the
Geosoft license server, including any modifications, improvements or updates provided by GEOSOFT.
“Effective Date” is the date the Geosoft license is installed. This date is recorded by the Geosoft License
server when the Licensed Program(s) is installed.
"Services" means the Services described on Section 4.
"Termination" means the occurrences contemplated by Section 6 and 7.

2. LICENSE:
If you have paid the license fee for a single user license of the Software, GEOSOFT grants to me a nontransferable and non-exclusive license to use the Licensed Program(s) for my own purposes and solely
in executable code format, whereby the Licensed Program(s) are being used only by myself, on one
computer, at any one time.
If you have purchased a Subscription License for the Software by paying the fee therefor, GEOSOFT
grants to me a terminable, non-transferable, and non-exclusive license to use the Licensed Program(s)
for my own purposes and solely in executable code format, whereby the Licensed Program(s) are being
used only by myself, on one computer, at any one time for the duration of the subscription service
purchase, typically one year. Under the Subscription License, the Licensed Software is licensed only for
the intended duration. If you do not renew the Subscription beyond the duration, you agree to stop using
the software, and remove the software from your systems.
Title and all intellectual property rights in and to the License Program(s), including, without limitation,
copyright, trade secrets and trademarks, shall remain with GEOSOFT and its licensor(s). I agree to
refrain from raising any objection or challenge to such intellectual property rights, or from assisting or
causing or permitting other(s) to do so, during the term of the Agreement and thereafter.
I may not assign this Agreement or any part thereof or sub-license the rights granted herein, or lend, rent,
time-share, sell or lease the software without the prior written consent of GEOSOFT.
I may not attempt to reverse engineer, de-compile or disassemble the software.
I may not copy the Licensed Programs other than for a single archival copy and reasonable number of
backup copies.
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I may not use the Licensed Program(s) for commercial network services or interactive cable or remote
processing services.
I may not make any attempt to circumvent the License Manager that controls the access to the software
use.
I may not remove or obscure any copyright, trademark, or legend or notice.

xvi | Target How-To Guide

www.geosoft.com

3. TERM:
The Term of this Agreement shall commence on the Effective Date and shall continue until termination,
as described in Section 6.

4. SERVICES:
(a)
(i) According to the terms of my initial purchase, GEOSOFT shall make available to me, without
additional fees such corrections and improvements to the Licensed Program(s) as may be generally
incorporated into the Licensed Program(s) by GEOSOFT. (Normally this will be for a period of twelve (12)
months).
(ii) GEOSOFT has a strong commitment to customer service and product support. GEOSOFT offers me,
subject to applicable Service Charge(s), continuing support in the form of email or telephone advice and
other assistance in problem diagnosis and the correction of errors or faults in the Licensed Program(s)
during the life of this License. When a problem occurs which appears to be related to errors or faults in
the Licensed Program(s), I may contact GEOSOFT and GEOSOFT will make an honest effort to solve
the problem. However, GEOSOFT cannot guarantee service results or represent or warrant that all errors
or program defects will be corrected. Also it is to be noted that each Licensed Program is designed to
operate on a Windows XP (32 bit) or Windows Vista Business (32 or 64 bit), Windows 7 (32 or 64 bit) or
Windows 8 platforms.
(iii) Further, if I request service relating to the modification of the Licensed Program(s) to meet a
particular need or to conform to a particular operating environment, GEOSOFT may, at its discretion,
modify the Licensed Program(s) to meet these particular needs, subject to applicable Services Charge
(s). However, all intellectual property or other rights which may arise from such modifications shall reside
with GEOSOFT.
(b)
(i) According to the terms of my Subscription License, GEOSOFT shall make available to me, without
additional fees such corrections and improvements to the Licensed Program(s) as may be generally
incorporated into the Licensed Program(s) by GEOSOFT. (Normally this will be for a period of twelve (12)
months).
(ii) GEOSOFT has a strong commitment to customer service and product support. GEOSOFT offers me,
subject to applicable Service Charge(s), support in the form of email or telephone advice and other
assistance in problem diagnosis and the correction of errors or faults in the Licensed Program(s) during
the life of this subscription. When a problem occurs which appears to be related to errors or faults in the
Licensed Program(s), I may contact GEOSOFT and GEOSOFT will make an honest effort to solve the
problem. However, GEOSOFT cannot guarantee service results or represent or warrant that all errors or
program defects will be corrected. Also it is to be noted that each Licensed Program is designed to
operate on a Windows XP (32 bit) or Windows Vista Business (32 or 64 bit), Windows 7 (32 or 64 bit) or
Windows 8 platforms.

5. PROTECTION AND SECURITY OF LICENSED PROGRAM:
I agree that all additions, modifications, revisions, updates and extensions to the Licensed Program(s)
shall be subject to all of the terms and conditions in this agreement.
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I acknowledge that all copies of the Licensed Program(s), provided by GEOSOFT or made by me
pursuant to this Agreement, including, without limitation, translations, compilations, partial copies,
modifications, derivative materials and/or updated materials, are proprietary, and the property of Geosoft
or its licensor'(s), and may not be distributed to any other persons, without GEOSOFT’s or its licensor(s)
prior written consent.
I will not provide or otherwise make the Licensed Program(s) available to anyone in any form without
GEOSOFT's prior written consent.

6. TERMINATION:
This agreement shall terminate upon the termination date, if any, specified in your purchase agreement
with Geosoft.
This agreement may be terminated only upon thirty-day's prior written notice to GEOSOFT.
GEOSOFT may terminate this Agreement upon prior written notice effective immediately if I fail to
comply with any of the terms and conditions of this Agreement.
This Agreement shall terminate automatically upon the institution, or consenting to the institution of
proceedings in insolvency or bankruptcy, or upon a trustee in bankruptcy or receiver being appointed for
me/us for all or a substantial portion of my/our assets.

7. EVENTS UPON TERMINATION:
I shall forthwith discontinue use of the Licensed Program(s), on the day Termination shall occur and
agree not to resume such use in the future without written authorization from GEOSOFT.
I shall uninstall and remove all software from my computer. Within thirty days after Termination, I shall
destroy all physical and digital copies of the Licensed Program(s) and certify such destruction in writing
to Geosoft within 10 days thereof.. This obligation relates, without limitation, to all copies in any form,
including translations, compilations, derivatives and updated materials, whether partial or complete, and
whether or not modified or merged into other materials as authorized herein.

8. WARRANTY:
GEOSOFT, nor its licensor(s), does not warrant that the functions contained in the Licensed Program
will meet my requirements or will operate in the combinations which may be selected for use by me, or
that the operation of the Licensed Program will be uninterrupted or error free or that all program defects
will be corrected.
Each Licensed Program shall be furnished to me in accordance with the terms of this Agreement. No
warranties either express or implied are made to me regarding the Licensed Program.
THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

9. LIMITATION OF REMEDIES:
I agree to accept responsibility for the use of the programs to achieve my intended results, and for the
results obtained from use of said Program(s). I therefore accept complete responsibility for any decision
made based on my use of the aforementioned Licensed Program(s).
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In no event shall GEOSOFT, or its licensor(s) be liable for any damages, or loss of any kind, whether
special direct, indirect, incidental or consequential, arising from use of, or performance or nonperformance of the Licensed Program(s), including but not limited to any lost profits, lost savings or other
consequential damages, or liability for use of the Licensed Program in a high-risk activity. Even if
GEOSOFT or its licensor (s) has been advised of the possibility of such damages, or for any claim
against me by any other party.

10. GENERAL:
I agree that this Agreement is a complete and exclusive statement of the agreement with GEOSOFT.
This Agreement supersedes all previous Agreements with respect to the Licensed Programs, with the
exception of a current signed Technical Service Agreements.
GEOSOFT is not responsible for failure to fulfill its obligations under the Agreement due to causes
beyond its control.
Should any part of This Agreement for any reason be declared invalid, such declaration shall not affect
the remaining portion which shall remain in full force and effect as if this Agreement had been executed
without the invalid portion thereof.
The relationship between the parties is that of independent contractors. Nothing contained in this
Agreement shall be deemed to constitute or create a partnership, association, joint venture or agency.
The provision of this Agreement shall be binding upon me and GEOSOFT and my respective successors
and permitted assigns.
This Agreement will be governed by the laws of the Province of Ontario and applicable laws of Canada.

11. ACCESSING DATA ON 3RD PARTY SITES:
Licensee shall not use the software to transfer or exchange any material where such transfer or
exchange is prohibited by intellectual property laws or other applicable laws. Geosoft neither endorses
nor assumes any responsibility for the safety, accuracy or availability of data sites or the information
contained on them. Data sites, their operation and content are the responsibility of the person or entity for
which they were created or maintained (the “Owner”). Both your use of a data site, and your right to use
or reproduce information or materials from a linked site, are subject to the terms of use governing that
particular data site. Any comments or inquiries regarding a data site must be directed to its Owner.

12. THIRD PARTY PRODUCTS
MICROSOFT BING MAPS
Microsoft Bing Maps Terms of Use can be found at: Microsoft Bing Maps and MapPoint Web Service
End User Terms of Use and Embedded Maps Service Terms of Use
Microsoft may collect information such as, but not limited to, an end user’s IP address, requests, time of
submissions and the results returned to the user, in connection with transaction requests to the
Services. All such information collected will be subject to, and used in accordance with, the data
practices described in the then-current Microsoft Online Privacy Statement, a current copy of which is
available at Microsoft Online Privacy Statement.
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Finding Help Information
There are several functions included in the basic Target help system that may be useful to your work.
The entire documentation for the system is available through the Application Help system. This
electronic library of information enables us to constantly update the information and provide you with the
most up-to-date information available. The best way to find information in this system is to use the
Search tab to perform a full-text search across all help topics.

Contacting Technical Support
North America

Europe and North Africa

Geosoft Inc.,
Queens Quay Terminal
207 Queens Quay West
Suite 810, PO Box 131
Toronto, ON Canada
M5J 1A7

Geosoft Europe Ltd.
20/21 Market Place, First Floor
Wallingford, Oxfordshire
United Kingdom
OX10 OAD

Tel +1 (416) 369-0111
Fax +1 (416) 369-9599

Tel: +44 1491 835 231
Fax: +44 1491 835 281
Email: support@geosoft.com

Email: support@geosoft.com

South America

Australia and Southeast Asia

Geosoft Latinoamerica Ltda.
Praça Floriano 51 / 19º Andar
CEP: 20031-050, Centro
Rio de Janeiro, RJ, Brasil

Geosoft Australia Pty. Ltd
14/100 Railway Road
Subiaco, WA, Australia
6008

Tel: (55-21) 2111-8150
Fax: (55-21) 2111-8181

Tel +61 (8) 9382 1900
Fax +61 (8) 9382 1911

Email: support@geosoft.com

Email: support@geosoft.com

South and Central Africa
Geosoft Africa Ltd.
Southdowns Office Park
Block A Ground Floor Unit 5
Cnr John Vorster Drive & Karee street
Irene, Centurion
South Africa 0062
Tel: +27 12 676 9360
Fax: +27 12 665 0246
Email: support@geosoft.com
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Getting Started with Target
Geosoft Target is essential exploration software that facilitates the processing and visualization of
subsurface drillhole and borehole data, enabling explorationists to better manage drill projects, from initial
planning to the evaluation stage. Target enables you to create and recreate sections in minutes, process
thousands of drillholes at a time, and generate professional-quality maps integrating geophysical,
geochemical and geological information.
Built on Geosoft's industry-leading Oasis montaj software, Target provides powerful spatial data
mapping and processing capabilities. Using Target you can import and export data directly from the
acQuire data management system, enabling you to verify and manage all your drillhole project data.
Together Target and acQuire provide a complete and powerful solution for all your exploration data
requirements.

Key features include:

Getting Started with Target
Overview of Target Capabilities

Easy data sharing and user-friendly wizards enable you to import or export data using industrystandard data formats, including ASCII, ODBC, LAS, acQuire, ArcGIS, Microstation, Surpac, and
Datamine™ files.
Rapid processing and analysis of high volume surface and drillhole data
Fast and accurate generation of drillhole plans and sections
Efficient production of high quality maps for interpretation and target definition
Effective exploration project generation and management
The Target system can be enhanced by adding the following data processing and analysis capabilities:
montaj Geochemistry extension adds advanced geochemical analysis and QA capabilities. This
extension enables geoscientists to effectively validate and analyse their surface geochemical data. It
provides rich functionality for visualizing and presenting geochemical survey data, validating data
quality and performing multivariate analysis.

Overview of Target Capabilities
The Target application provides explorationists with an easy-to-use and comprehensive data processing
and presentation solution for surface and drillhole data. This software package enables geoscientists to
manage drill projects from the initial planning to the evaluation stage.
The Target application is organized around an integrated database and streamlined menus and toolbars
that provide the following surface and drillhole capabilities:
Data Import: User-friendly Import Wizards enable you to import both surface and drillhole data from
different data sources, including ASCII, ODBC, LAS, acQuire, ArcGIS MXD, ArcGIS LYR, MapInfo,
Microstation, Datamine and Surpac. Data validation on import ensures the integrity of any sub-surface
information you generate. Interpretations or other vector map layers can be exported for use in mine
planning applications. The Geosoft voxel (3D grid) engine enables the import of ASCII XYZ, GoCAD
and UBC datasets as well as Datamine block models.
Locate and download spatial data using Seeker: Geosoft’s Seeker tool was designed to retrieve
spatial data stored on global and corporate spatial servers – Geosoft DAP servers, from the many
WMS Image servers currently available, as well as retrieve data from the Web and locally from your
desktop, using Geosoft's Desktop Cataloger.
Drillhole plans and sections: Easily create and recreate drillhole sections and plans in minutes, using
dialogs with sensible default settings. Visualize thousands of drillholes at a time. Save and share
templates with others.
Powerful data processing: Target is built on Geosoft’s Oasis montaj powerful processing engine for
working with large volume spatial data. Target provides industry-standard technology for processing
large volumes of exploration data for target generation.
Dynamic data linking: Analyse and interrogate your drillhole data in real time via dynamically linked
sections, plans, 3D, map, MXD, and database views. This also includes all data views within a map.
A map with a section view and surface view will be linked with a shadow cursor. This linking includes
all scatter plots and triplots, plan maps, section maps, 3D views, and between multiple instances of
Oasis montaj.
3D drillhole visualization: Interactive tab dialogs make it easy to create and customize 3D views of
grids and profile data. View borehole traces and Voxels (3D Grids) from different angles in 3
dimensions to spot the relationship between surface and sub-surface features. The easy-to-use 3D
subsurface visualization tool permits quick data integration from multiple sources, combining
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Getting Started with Target
Overview of Target Capabilities

surfaces, grids, profile data, drill data and geophysical data to visualize spatial relationships.
3D Voxels: A "Voxel" is another word for a 3-dimensional grid, and is created using Geosoft’s 3D
Kriging gridding method. Target includes 3D Lithology Gridding, which enables you to create a 3D
lithology grid based on drillhole lithology data. A lithology voxel grid can be created from any geologic
attribute, such as rock type, alteration, or mineralization. Also available are 3D lithology contact
surface, which enables you to create elevation grids to represent top or bottom surface of a lithology
unit based on a lithology channel in a Geosoft Drillhole database.
Fence Diagrams: Create professional fence diagrams quickly, based on selected drillholes. Fence
diagrams are especially useful when comparing down hole geology from a limited number of holes.
Fence diagrams are displayed in real world coordinates.
Surface mapping: Utilizing versatile gridding algorithms, grids and contour maps can be created using
point sample datasets (eg. streams, soils, rocks, geophysical data) from a variety of raw data sources
(ASCII, Excel, Access, and acQuire). Easy-to-use dialogs simplify the creation of grids and contours.
Interpretation can be done on all maps with CAD drawing tools, which enable a user to annotate and
define areas of interest onto new layers in the map view.
Surface and Drillhole data Integration: Combine drillhole data with all other surface data and
information to create detailed, integrated surface and subsurface maps.
Strip Log and Compositing: Create scaled graphical strip log display of selected holes or the entire
drillhole project with Target’s strip log feature. Utilize up to 32 graphical fields to display down hole
data. Using the Strip Log feature, geologists can better manage and visualize their drill projects, from
initial planning to the evaluation stage.
Professional map production: The software provides a full featured dynamic contouring algorithm with
gradient feathering and extensive labelling control for professional quality maps. Quickly create
multiple and varied types of maps, including gridded maps, surface maps, posted value maps, and
sub-location maps.
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Software and Hardware Requirements
Operating
System

Windows 8 (32-bit and 64-bit)
Windows 7 SP1 (32-bit and 64-bit) - Recommended
Windows Vista Business SP2 (32-bit and 64-bit)
Windows XP Service Pack 3 (32-bit) - Minimum requirement
Windows 2000, 95, 98, ME, NT are not supported.

CPU

A Dual Core processor is recommended. An Intel Celeron
processor is not recommended.

RAM

3+ GB recommended, 1 GB minimum required.

Graphics

Nvidia Professional 256MB 3D (OpenGL 2.0) Graphics Card
recommended.

Printer/Plotter

Any Windows® supported colour printer. Hewlett Packard®
large-format ink-jet plotters are recommended.

Installation

You must be logged on with Administrator permissions when
installing Oasis montaj.

Installation
Disk Space

2 GB or more of free space on the Program Files drive is
required for the installation process.

Data Disk
Space

Data disk space depends on the volume of project data to be
processed and the printer driver you are using, however 100
GB is recommended. This is largely based on your business
and data requirements.

Internet

Internet Connection: To use VOXI, we recommend a medium to
high-speed internet connection (512Kbps upload and 1Mbps
download or higher). The faster your internet connection, the
faster you will be able to upload your modelling information to
the VOXI cloud servers and download your results.
Internet Browser: To use the internet capabilities in Oasis
montaj or Target, you will need to install Internet Explorer 8.0 or
later. This does not mean that you have to have Internet
Explorer as your default browser; Oasis montaj and Target just
use the internet connection technology supplied in IE8.

Supporting
Software

The following software prerequisites are required and will be
downloaded and installed if not present:
• Microsoft .NET 4
• ESRI ArcEngine 10.2
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Geosoft Connect and Geosoft ID

Geosoft Connect and Geosoft ID
Geosoft Connect is a service available through the Target application. Geosoft users can sign in to their
Geosoft ID, using Geosoft Connect, to access any online service that requires a secure sign in,
including online licensing, online updates, VOXI Earth Modelling and Bing Map services. Geosoft
Connect enables you to sign in from your desktop when you are connected to the Internet.
As a customer, your Geosoft ID is the only sign in you'll need to remember when accessing any of our
services, resources, community activities or our web site.
For more information see the Geosoft ID Common Questions on the Geosoft web site.
Create your Geosoft ID
Your Geosoft ID is the only sign in you'll need to remember when accessing any of our secure online
services, including online licensing, online updates, VOXI Earth Modelling and Bing Map services.
Create Geosoft ID:

1. Connect to the Internet.
2. Go to the, Register Geosoft ID (https://www.geosoft.com/geosoftid/) web page.
3. Click the Create a Geosoft ID button. The Create a Geosoft ID web page is displayed.
4. Enter your information as required and then click the Create a Geosoft ID button.
We prefer if you use your business email for your Geosoft ID. You may get a message
saying 'A user account already exists for that e-mail address.', If you don't know or have
forgotten the associated password, you may need to reset it.
5. Once you have registered, Geosoft will immediately send you an activation link to the e-mail
address you provided (within 20 minutes).
6. When you receive the activation e-mail, click the Click to Activate link. Your Geosoft ID will be
activated.
Geosoft Connect is a service available through the Target application. You can use this
service to sign in to your Geosoft ID from your desktop, when you are connected to the
Internet.

Welcome to the Target Environment
This how-to guide walks you through the basic steps needed to know and prepare your Target
environment before moving on to work with data.
To Start Target

1. From the Start menu, click All Programs.
2. Select Geosoft and then, select Target|Target (or double click on the Target icon). The Geosoft
License Manager dialog appears.
3. In the "License Key" box, enter your 8-digit alphanumeric license key (provided with your DVDROM) and click the [Internet] button.
If you have not already signed in to your Geosoft ID, using Geosoft Connect, the Sign In with
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Getting Started with Target
Welcome to the Target Environment

your Geosoft ID dialog will be displayed. Sign in to your Geosoft ID. For more information on
your Geosoft ID see the topic Create your Geosoft ID in this Target Getting Started How-To
Guide, or see the Geosoft ID Common Questions web page
(https://www.geosoft.com/geosoftid/common-questions).
4. The Geosoft license server will retrieve your license from our Internet server and download it to
your computer.
5. The Target Graphical User Interface (GUI) opens with standard Windows style elements,
including the Main Menu, Pop-up Menus and Application Help as shown below:

Target System Files
As you work with the system, you will become familiar with a variety of standard files used for specific
functions. The following list provides a short summary of the more important files.
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Target System Files

System File Extensions

Geosoft database file

*.GDB

Map file, including plots and grids

*.MAP

Geosoft grid file

*.GRD

Colour information for grids/images

*.AGG

Geosoft voxel file

*.GEOSOFT_VOXEL

ArcGIS MXD file

*.MXD

Oasis XML file

*.XML

Geosoft eXecutable

*.GX

Geosoft script file

*.GS

Oasis menu, Oasis sub-menu

*.OMN, * .SMN

Geosoft project file

*.GPF

Geosoft projection information file

*.GI

Geosoft map file (used in the MapInfo software to
distinguish a Geosoft map file from a MapInfo (*.map)
file

*.GM

Creating a Geosoft Project
To work in Target requires an open Project. A Geosoft "Project" encompasses every item in your
working project; from the data files in your project (databases, maps, grids, ArcGIS mxd files), to the
tools used (including auxiliary tools such as histograms, scatter plots etc.), to the project setup including
the menus you have displayed and whether you are working on a map or profile and the state in which
you left it the last time you used it.
The project also controls your working folder. Projects are saved as (*.gpf) files. If you open an existing
project from a folder, the system assumes that all your project files are located in the same folder. To
streamline your work, as well as keep it organized, you may wish to make sure that your project file is in
the same folder as the other files you want to use. We recommend that each project you work on have its
own project (*.gpf) file. If you use a number of applications or add-on tools in Target that have different
menus, you can use the project to display only the menus you require.
To Create a Project

1. On the File menu click Project | New. The system displays the New Project dialog.
2. Specify a name and folder for the project. For example, name the project Drillhole and specify the
working folder as E:\GeoDemo.
Target assumes that your data is in the folder containing this project.
3. Click the Save button. The system saves the project and indicates it is open by opening the

www.geosoft.com

Target How-To Guide | 7

Getting Started with Target
Creating a Geosoft Project

Project Explorer window, enabling the buttons on the Main toolbar, and adding menus to the menu
bar. These are visual clues indicating that you are ready to start working with the system.

Closing a Project
Closing a project will save all of your project databases, maps and profiles, plus information that tells the
system whether you are working on a map or profile and the state in which you left it the last time you
used it.
To Close a Project

1. On the File menu, click Project and then click Close.
The Save Modified Documents dialog appears.
Modified Documents' refers to items in your project that you have modified since the project
was last saved, such as databases and maps.

8 | Target How-To Guide

www.geosoft.com

Getting Started with Target
Target Menus

2. Click All to save all open document(s) in your project. Alternately, you may select specific
document(s) to save by highlighting the document(s) and click Selected or click None to abandon
document(s) changes.

Target Menus
The Target System menus are displayed directly under the Title Bar when you open a project. These
dropdown menus provide direct access to all of the systems capabilities.
Loading Applications and Tools
In addition to the Target base functionality, you may be licensed to access specialised applications,
which we call "Extensions". Extensions are accessed by loading a menu file (*.omn), which in turn will
load all of the menus and sub-menus associated with that extension. Examples include ((our
geochemical analysis extension, geochemistry.omn).
Your Oasis montaj project keeps track of which menus are displayed. This means that you can have a
different set of menus displayed for each project. This is especially useful if you are working on multiple
projects and using many applications or tools. For example, if you are working on a geochemistry
project, you may want to display different menus than if you are working on an UXO project. By creating
separate projects with differing menus you can customise the Oasis montaj environment to suit your
current project.
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To Load an Application or Extension Menu

1. On the GX menu, select Load Menu. The Load Menu dialog appears.

2. Select the menu file (*.omn) from the list of files and click Open. The new menu appears on your
menu bar.
If you want to modify your default menus (i.e. load a specified menu with every new project)
you can use the GX|Global Settings|General menu to display the Default settings dialog to
change your settings. If you are really interested in system configurations and want to view all
of the System settings, open the Advanced Settings file from the GX|Global
Settings|Advancedmenu. The Advanced Settings will be displayed in the Metadata Browser.

Target Settings
The Target program has standard default settings which are designed to work well in most environments.
However if you have particular personal or computing requirements you may overwrite the defaults to
suit your needs.
To Change the Default Settings of the Target Environment

1. On the GX menu, select Global Settings and then click General. The Default settings dialog
appears.

10 | Target How-To Guide

www.geosoft.com

Getting Started with Target
Target Settings

2. Select the desired choices from the available selections.
3. Click Next to navigate through the Default settings dialogs.
4. Click Finish when complete.
For more information on the available selections, click the Help button on your dialog of
interest.
Common Default Settings
The following table summarizes some of the more frequently changed settings.
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Default menus

Select the menu files (.omn) to load as the default menus when
creating a new project. If more than one menu is selected, each
menu must be separated by the | character.

Default grid colour table

Select the default colour table to use for displaying grids.

Default symbol colour table

Select the default symbol colour table (*.tbl).

Default map font

Select the default map font. The file TRUETYPE.INI will be modified
to map the "default" font from Geosoft PLT files to the TrueType font
specified here. To change the mappings of other Geosoft fonts you
can modify the TRUETYPE.INI file directly.

Click Next for More settings

Default input grid format

Select the input grid format you would like to use by default.

Default output grid format

Select the output grid format you would like to use by default.

Default grid element type

This is the default grid element type to use for Geosoft grids. If grids
will be used with Geosoft DOS programs, select "16-bit (DOS
compatible)".

Error level reporting

If All errors are selected, you will see more error messages each
time an error occurs. This is useful for GX programmers who may
need to see more error context when debugging GX’s.

Auto Save Time
Target has an Auto Save Time feature that enables databases and maps to be saved automatically.
When AutoSave is enabled a popup dialog will be displayed asking if you want to save the changes to all
open documents.
The frequency of the AutoSave (in minutes) can be modified or shut-off from the GX|Global
Settings|Advanced menu.
Changing this setting to zero (0) shuts-off the AutoSave feature.

Setting Drillhole Preferences
Drillhole preferences are global variables, and remain set for a given installation of Target. This means
they remain the same for different data sets and projects. The values are stored in the Drill Hole
Preferences dialog.
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To Set Drillhole Preferences

1. On the DH-Data menu, select Preferences. The Drill Hole Preferences dialog is displayed.

2. Use this dialog to set the specified global variables of your project.
For more information on what these global variables mean, click the Help button at the top
right corner of this dialog.
3. Click the OK button to accept the Drillhole Preferences.

Metadata
Metadata (data about data) is captured by Target from the first time a dataset is opened by the program.
The metadata information, which is based on ISO 19115 standards, is stored inside the data (if
supported) or as a companion XML file. When you import or work with data in Target, User name, Date,
Time and any actions performed on the data will be maintained in the Metadata. When data is derived
from other data, the Metadata is passed on and the lineage of what was done to the data is maintained in
the Lineage section. Note that, memory intensive GDB processing tasks are not recorded in the lineage.
When working with script files you have the ability to turn off the XML metadata file creation.
Attributes (or metadata), information about data, can be simple or complex and the descriptive needs of
different kinds of data are infinitely diverse. To allow for this and provide flexibility, Geosoft developed
the XML Metadata Viewer and Metadata Editor to help you organize your metadata.
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Even though each Geosoft data type (Database, Grid, Map, ArcGIS MXD, Voxel, etc) exhibits many
different attributes, using these tools are easy. The current selection drives what exists inside the tool.
Metadata Viewer
Use the Metadata Viewer dialog to view the metadata associated with selected data files.
To View and/or Edit Metadata

1. On the Project Explorer window, select the data of interest.
2. Right-click and select Metadata from the pop-up menu. The Metadata Viewer appears.

3. Click Edit and the Edit Metadata dialog appears.
4. Make any necessary changes.
5. Click Close when finished and then click OK to close the Metadata Viewer.
Metadata Tool
The Metadata Tool is a context-oriented, interactive method for viewing and editing attributes assigned
to Geosoft Global Setting, DAP Data etc.
Values displayed in a grey box cannot be edited. Values displayed in a white box may be edited.
To View the Metadata Tool

1. On the GX menu, select Global Settings and then select Advanced.
The advanced global settings will be displayed in the Metadata Tool.
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2. Make any necessary changes.
3. Click OK when finished or clickCancel to close the Metadata Tool.

Shortcut Keys
Target now provides configurable Shortcut Keys (Hotkeys) enabling quick and easy access to menu
functions.
To view or modify these settings, you have two options:
Database Shortcut Keys: Select GX | Database Settings | Configure GDB Shortcut Keys.
Map Shortcut Keys: Select GX | Map Settings | Configure Map Shortcut Keys.
Both options provide an interactive dialog enabling you to configure your own shortcut keys (hotkeys) or
view the provided defaults.
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Target eLicensing
With Geosoft’s electronic licensing (eLicensing) model licenses are handled by the Geosoft license
server. This system enables licenses to be moved between machines online, via email or if necessary
by disk. Geosoft’s eLicensing management system offers many tangible and real benefits, including:
Regular upgrades and fixes. We release multiple upgrades a year (with interim patches when
possible). You can only access these with a valid eLicense
Easily transfer your license between office and home Geosoft installations
Add extensions to your license instantly
Evaluate extensions easily - for 14 days
Easy to manage "1 user - 1 license" model
Reduces costs by eliminating unauthorized use
Rent extensions for specific time periods
The eLicensing technology also enables us to add extra services and products on a regular basis
It may take some time to get used to the system and there are some restrictions that apply:
Online licensing requires secure sign in of your Geosoft ID using Geosoft Connect
Licenses are keyed to individual PCs. Therefore; you must park the License to switch it to another
computer
Licenses must also be parked before changing Operating System (for a new hard drive, for example)

Read the How-To Guide
Oasis montaj eLicense

About eLicensing Tools
The Geosoft licensing system enables licenses to be updated in seconds and to be moved between
computers. License updates or transfers can be done online, via email, or by disk if required.
The License options under File/License enable you to:
Show computer ID – Displays computer ID
View eLicense – Displays users license
Update eLicense – Enables license to be updated from license server
Park eLicense – Enables license to be parked on the Geosoft license server, and then retrieved later
Transfer eLicense – Enables license to be transferred to a different computer ID
Lock eLicense – Locks the license on the current computer
Unlock eLicense – unlocks the license on the current computer with the use of the license key

eLicensing
About eLicensing Tools

To use the Internet capabilities in Target, you will need to install Internet Explorer 7.0 or later. This
does not mean that you have to have Internet Explorer as your default browser; Target just uses
the Internet connection technology supplied in IE7 to connect to the web.

Read the How-To Guide
Oasis montaj eLicense
To Install eLicense
Your eLicense is installed from the Geosoft license server, online, via email or if necessary by disk.
First time use:

1. Connect to the Internet.
2. On the Start menu select, Programs/Geosoft/Target/License and then select Setup (or double
click on the Target icon).
The Geosoft License Manager dialog will appear.
3. In the "License Key" box, enter your 8-digit alphanumeric license key (provided with your install
DVD, or supplied to you by your Geosoft representative) and click the [Internet] button. Geosoft’s
license server will retrieve your license from our Internet server and download it to your computer.
If you have not already signed in to your Geosoft ID,using Geosoft Connect, the Sign In with
your Geosoft ID dialog will be displayed. Sign in to your Geosoft ID. For more information on
your Geosoft ID see the topic Create your Geosoft ID in the Target Getting Started How-To
Guide, or see the Geosoft ID Common Questions web page
(https://www.geosoft.com/geosoftid/common-questions).
4. All of the functionality you are licensed for will now be accessible to you.

Get Started!
Getting Started with Oasis montaj
Show Computer ID
To Show Computer ID:

1. On the File menu, select Licenseand then select Show Computer ID.
The Geosoft License Manager dialog will appear.
2. The alpha-numeric ID displayed in this window is your Computer ID.
3. Click the OK button to close the window.
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View your eLicense
You can view your Geosoft eLicense at any time to see what applications or extensions you are licensed
for.
To View your eLicense:

1. On the File menu, select License and then select View License.
Your eLicense is displayed in your default web browser.
2. The eLicense information includes your License Key, Computer ID, User Name, Company,
Support (Maintenance) Expiry date, Software build date, and other items as well as a list of your
licensed products.
3. Close the window when you have finished viewing your License.
Update eLicense
You can update your eLicense (i.e. access additional applications or extensions) by first contacting your
local Geosoft representative and then simply connecting to the Geosoft license server.
To Update your eLicense:

1. Contact your local Geosoft representative about adding additional applications or extensions to
your license.
2. Connect to the Internet.
3. Use Geosoft Connect to sign in to your Geosoft ID.
4. On the File menu, select License and then select Update License.
Your eLicense is updated with the new licensed products.
To Park (or Move) your eLicense
To park (move) license from your computer to the Geosoft license server:

1. Connect to the Internet.
2. Use Geosoft Connect to sign in to your Geosoft ID.
3. On the File menu, select License and then select Park License.
The Geosoft License Manager dialog appears.
This is a warning message that tells you that parking a license places your license on
the Geosoft license server so that it may be installed on a different computer for your
own personal use. Your license is non-transferable, and use of the license by anyone
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but you may be a violation of your license agreement.
4. It then asks you if you are sure you want to park your license? Click the Yes button. Your license
is uploaded to the Geosoft license server to be downloaded at a later time and Target closes.
5. Once the license is parked, it can be installed on another computer. After Installing Target for the
first time you will be prompted to enter your license key. You can choose to retrieve the license
directly by clicking on the [Internet] button, or if you are not connected to the Internet, click on the
e-mail button and follow the instructions. If you have parked the license, the next time you run
Target you will be prompted for your license key.
If you do not have access to the Internet,your eLicense can be transferred in a file using the
Transfer License process.
Re-installing your license:

1. Connect to the Internet.
2. Use Geosoft Connect to sign in to your Geosoft ID.
3. On the Start menu select, Programs/Geosoft/Target and then click Target.
The Geosoft License Manager dialog will appear.
4. In the "License Key" box, enter your 8-digit alphanumeric license key (provided when you "Parked"
your license) and click the [Internet] button. Geosoft’s license server will retrieve your parked
license from our Internet server and download it to your computer.
5. All of the functionality you are licensed for will now be accessible to you.
Transfer eLicense
Your eLicense can be transferred from one computer to another (from your desktop to a laptop or visaversa), using the computer ID.
Target must be installed on the destination computer to retrieve the Computer ID, which can be
viewed from the Start menu, by selecting "Geosoft|Target|Licenses|View Computer ID".
To Transfer your eLicense:

1. Open Target on your licensed computer.
2. On the File menu, select License and then select Transfer License.
The Geosoft License Manager - License Transfer dialog appears.
3. In the Target Computer ID box, enter the computer ID of the destination computer (the computer
you wish to transfer the license to) and click the OK button.
4. The file Target_Transfer.geosoft_license file will be created in your C:\ directory.
5. Move this file via media (diskette, CD, USB drive) or network to the destination computer.
6. Using Explorer locate the file (Target_Transfer.geosoft_license) on the destination computer, rightclick and from the popup menu, select Install License.
Your licensed products will be installed.
If you have access to the Internet, Parking your eLicense is the quickest and easiest method of
moving your eLicense.
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Lock eLicense
You can lock your eLicense to the current computer.
To Lock your eLicense to the current computer:

1. Connect to the Internet.
2. On the File menu, select License and then select Lock License.
The Geosoft License Manager dialog appears.
3. This is a warning message that asks, are you sure you want to LOCK the license on this
computer? You will no longer be able to move or manage the license until it is unlocked using the
license key.
4. Click the Yes button and the license will be locked on your computer until you unlock it using the
license key.
UnLock eLicense
You can unlock your eLicense from the current computer by providing the license key.
To unlock you eLicense from the current computer:

1. Connect to the Internet.
2. On the File menu, select License and then select UnLock License.
The Geosoft License Manager dialog appears.
3. In the License Key box, enter your 8-digit alphanumeric license key (provided when you "Locked"
your license) and click the Internet button.
4. Geosoft’s license server will unlock your license and enable you to move and manage it again.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.

www.geosoft.com

Target How-To Guide | 21

Working with Geosoft Databases in Target
The purpose of this How-To Guide is to give you a general overview of how to create and edit Geosoft
Databases (*.GDB).
One of the fundamental technologies in Target is its unique database architecture. This architecture is
designed to let you rapidly create and import data of many kinds (ASCII and binary) into highperformance Geosoft databases. After data is imported into a database, you have numerous options for
editing, visualizing, processing and performing other tasks.
The “window” to the database in Target is a specialized earth science spreadsheet that appears
automatically when you create a new database. This spreadsheet provides access to a wide variety of
data management, data and profile viewing, and processing capabilities.

The Geosoft Database
The Geosoft database is based on a proprietary binary database architecture that stores spatial data in a
format that enables rapid access, processing and analysis of high volume data (tested up to 10
gigabytes).
Database Lines/Groups
Organized in lines (or groups), columns and elements, the database stores all data values of a particular
type in individual columns or channels. This enables stand-alone processing of columns and eliminates
the need to write results to interim storage areas and then re-write them after processing.

The result is a significant increase in processing efficiency. This Geosoft file structure provides
additional advantages including:
Ability to process any number of lines/groups
Ability to handle lines/groups with unlimited columns
Ability to handle very large datasets (tested up to 10 gigabytes)

Working with Geosoft Databases
Target Supported Data Formats

Each database “line” has a line number, version number, line type, flight number (only required for
airborne data), survey date and selection status.
A “group” is a special kind of line. It also stores data in channels, but instead of using a name based on
line number, version number, line type and flight number, it can be named using any alpha-numeric string
(with some exceptions).
Each database “group” line has an optional “CLASS” name. Like a regular line, it has a selection status.
While all the channels in a database are accessible inside a regular line, a group line can restrict the
available, displayable channels to a smaller subset, excluding those not relevant to the group’s data.
A database may contain any number of lines and/or groups. If your survey data has not been collected on
a line basis (i.e. is random), or cannot be organized conveniently into groups that can be thought of as
lines (such as drillhole or UXO target data), you can store all data in a single "line".
An additional benefit of the Geosoft database structure is that since columns are stored
separately, this file format is capable of storing and manipulating data with different end point and
sample intervals.

Target Supported Data Formats
Target provides seamless access to both original spatial data and processed information (grids, images
and vector plots).
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Spatial Data Import Formats

Processed Data Import Formats

AMIRA format files

ArcView shape files (SHP)

ASCII data files, CSV

AutoCAD DXF (DXF)

ASEG GDF files

DATAMINE (DM)

Blocked binary data files

Geosoft plot (PLT)

Database table files (single or all tables)

Geosoft map files (MAP)

Excel Spreadsheets

Grid and image formats

Flat archive data files

MapInfo TAB files

Geosoft binary data files

Maxwell Plate files

Geosoft XYZ data files

Microstation DGN files

ODBC data files

Surpac (STR, DTM)

Picodas PDAS data files

GoCad (VO)with rotation

RMS data files

UBC (MOD, MSH, DEN, SUS)

RMS DAARC 500 binary file formats

LAS files (LAS)

USGS data files
Common Grid Formats (GRD) including

Common image formats (IMG) including

DEM formats (GLOBE, ETOPO5, USGS)

EOSAT MSS (Old 4 Band BIL)

EOSAT Fast Format

ER Mapper algorithm (ALG)

ER Mapper grid (ERS)

ER Mapper compressed (ECW)

ESRI Binary Raster (FLT)

GeoTIFF Image (TIF)

Landmark ZMAP (DAT)

GIF (GIF)

Geopack (GRD)

IMG Image (IMG)

Geosoft grid files (GRD)

JPEG 2000 (J2K and JP2)

Geosoft Hypergrid (HGD)

JPEG File Interchange Format (JPG)

Grid eXchange Format (GXF)

Landsat MSS (4 band BSQ) and Landsat TM

Surfer grid file (GRD)

PCIDSK Format (GIX)

Texaco Startrax (GRD)

Portable Network Graphics Format (PNG)

USGS (DDF, DEM)

Tagged Image File Format (TIFF)

World Geoscience (H)

Targa Image (TGA)
Uncompressed PC Paintbrush (PCX)
Windows Bitmap (BMP)

Database Menus
There are two main database menus, Database and Database Tools, as shown below:
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Database menu

Database Tools menu

Drag and Drop Geosoft Database Files
Target includes the ability to drag Geosoft database files (*.GDB) from Windows Explorer and drop them
into an open project.
The ability to drag Geosoft file formats directly from Windows Explorer and drop them into Targetfor
display is also available including grid files (*.GRD) and map files (*.MAP). Users can also drag XYZ
files and drop them into an open database file (*.GDB). Items displayed in the Project Explorer window
may also be dragged and dropped into the main Target workspace.

Creating a Geosoft Database
The Create New Database dialog enables you to create and define a new database for Target. The dialog
options enable you to set the initial size of the database and the database page size.
We recommend that you specify a Maximum Line/Group and Maximum Channel/Field number that is
representative of the final estimated project size. This strategy ensures that you have enough space
available in your project while not consuming excessive storage space. The size can be changed later
via the Maintenance menu option from the Database menu, should your project expand in scope.
Additional parameters available from the More button control the database "page size", which is the
smallest unit of memory that is read/written and stored on the database. In almost all cases, the default
page size (1024 bytes) should be sufficient since this will support a total database size of up to 4
Terabytes in size and will enable individual channels on a line to hold up to 64 Megabytes of data.
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To Create a New Database

1. On the Database menu, select New Database. The Create New Database dialog appears.

2. Specify a New database name.
3. Specify the Maximum lines/groups and Maximum channels/fields. The defaults are 200 and 50.
4. From the Compression drop-down list, choose the compression method.
You can choose either Compress for speed, Compress for size or No
compression. This depends on which type better suits your needs. For example, you
would more than likely compress for speed if you have a lot of hard drive space
available. However, if space is limited, you may wish to compress for size.
5. Click More to specify the way Target works with data in the database file.
6. Click OK. The system creates a new database with the database name that you specified with a
(*.GDB) extension and opens a Spreadsheet window with empty Channel Header Cells and Data
cells.
Create a New Line or Group
Creating a new Line or Group is easy with the Database pop-up menu.
To Create a New Line or Group

1. From the current database, select the Line or Group header cell (top left cell).
2. Right-click and select New Line or New Group from the pop-up menu.
3. The Create Line or Create Group dialog appears.
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4. Enter the parameters as required and click OK.

The new Line (or Group) will be created in your current database.
Line Types

Line
Base line
Tie line
Test line
Trend line
Special line
Random line

Edit Geosoft Database Lines and Groups
Use the Edit Line dialog to edit a database line.
To edit multiple lines, select All Selected Lines.
To Edit a Line

1. From the current database, select the Line header cell.
2. Right-click and select Edit...from the pop-up menu.
The Edit Line dialog appears.

3. Specify the Line Number and Line Version.
4. From the drop-down list select the Line Type.
5. Specify the Flight Number and Flight Date. By default, it is the import date.
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6. Check the Selected box to select the line, if desired.
7. Click OK when done.
Edit a Group
Use the Edit Group dialog to edit a database line.
To Edit a Group
1. From the current database, select the Group header cell.
2. Right-click and select Edit...from the pop-up menu. The Edit Group dialog appears.

3. Specify the Group Name and Class Name.
4. Check the Selected box to select the group, if desired.
5. When satisfied with group edits, click OK.
Save Changes to Databases
Another advantage of the Geosoft database format is that the user can decide whether to discard or save
any changes to data in a database without having to close and reopen the database.
To Save Changes to Your Database

1. On the Database menu, select Save Database Changes.
The Save Changes dialog appears.

2. Click Yes to confirm the save. The system updates your database and the changes are now
saved.
To undo changes, click the Discard Database Changes option on the Database menu. This will
revert your database to the point where it was last saved.
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To Save Database As

You may want to save your database with a different name.
1. On the Database menu, select Save Database As.... The Save database as... dialog appears.

2. Specify the name of the database (*.GDB file) and then select the Compression Type (None,
Speed or Size).
3. Click OK to confirm the save. The system saves your database with the new database name.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Target Database Maintenance
There are a number of utilities available for database maintenance. These utilities are provided to enable
the user to check the status of the database, perform maintenance tasks and add comments to the
database log file. The following is a list of the data maintenance utilities:
Database properties
Grow database
Verify database
Repair database
Defragment database
Add database comments

View Database Properties
From time-to-time, you may want to examine the database properties.
To View the Properties of a Database

1. Select the database.
2. On the Database menu, click Properties.
The Database Properties dialog appears.

Database Maintenance
Growing, Verifying and Repairing a Database

Click More to expand the database properties displayed.
We are mostly concerned with whether we are close to exceeding the limits of our Groups or Lines
and Channels.If the unused or lost space seems excessive (say greater than 20%) we might
consider Defragmenting the database.
For more information about these statistics, click the Help button on the Database
Properties dialog.
3. Click OK to close.

Growing, Verifying and Repairing a Database
Database utilities are accessed from the Database | Maintenance menu. If you find that the original size
limits that were selected for your database (lines/groups and channels/fields) were too small, you can
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increase these limits using the Grow command. If you wish to check the integrity of your database, you
use the Verify command. If your database has been corrupted (for example, if the computer failed during
a Defragment operation) you can run the Repair utility to try to recover some or all of the data.
For each of these three commands, please refer to the detailed explanations provided by clicking
the Help button on the dialog of interest.
If you attempt to import data into a database which does not have the size capacity for that data,
you will recieve an error message which will prompt you to Grow the database prior to proceeding.

Defragmenting the Database
As you work with data in the database, new and modified data are saved to the end of the database file
and to space freed within the database before the last time you saved the project. As the database
grows, you can lose space due to fragmentation or from simply erasing data.
To Defragment a Database

Make sure you have backed-up the database before using this utility
1. On the Database menu, select Maintenance and then select Defragment.
The system removes all unused space by repacking the data as efficiently as possible and
reduces the database file (*.GDB) size by the amount of freed space..

Adding Database Comments
Comments about your data can be added to the audit log of a database. Comments are useful as a place
to hold information about the data collection procedures, instrumentation and surveyors used, any
specific problems and the solutions to them, and other bits of information that may have formerly been
kept as field notes, readme files, or other notes.
The comment block is an RTF file that can be edited with the Windows Wordpad application, or another
text editor.
To Add Comments to a Database

1. On the Database menu, select Edit Database Audit Log.
This launches your editor and opens the file which is stored in your database.
2. Edit this file however you wish, adding text, pictures, etc.
3. When you are done editing, close the editor. You will be prompted to save the file. Click Save.
4. On the Database menu, select Edit Database Audit Log again. You will see the comments that
you entered .
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
.

www.geosoft.com

Target How-To Guide | 32

Working with Spreadsheets in Target
This How-To Guide walks you through displaying, editing and processing Geosoft database data in the
Spreadsheet view.

Spreadsheets
When you create or open a database, you see a spreadsheet. The Spreadsheet view is your “window” to
the Geosoft database and it also provides you with flexibility in setting up your working environment. All
data is stored securely in the underlying database (*.GDB) — you simply decide which data you want to
display in the spreadsheet and keep all other data in the background, hidden from view.
The spreadsheet is organized in rows, channels (columns) and lines (also called groups in other
applications such as drillhole plotting). Rows and columns work similar to standard spreadsheets in that
you can edit and delete them as needed. The system also enables multiple “worksheets” in your
database. Depending on the type of data you are working with (line, random line or drillhole), the
worksheets have different names. To see what type of name is used, look at the Line Header Cell
located at the top left corner of the spreadsheet. An “L” for example, indicates that you are working with
line data. If your data has not been collected on a line basis, such as Geochemistry data, you can store
all data in a single line.
General spreadsheet capabilities include:
The ability to display data from your database through a spreadsheet window
Handling of any sample interval
Full editing and mathematical processing capabilities
Process selected samples, selected channels and selected lines or groups
How the Spreadsheet Displays Project Data
The spreadsheet does not display your actual data, but rather a view of the data. This enables you to
work with data in the spreadsheet without actually making changes to the data until you decide to save
the database. After you save the database, your changes are permanent.
Depending on your type of project, the spreadsheet will display your data as either values or arrays.
For surveys where a single value is recorded at each station (for example, magnetic surveys) each
data cell will contain a single value.
For surveys where multiple readings were recorded at each station (for example, an Induced
Polarisation or electromagnetic survey) each data cell will contain multiple values.This is what we
refer to as an Array database.

Working with Spreadsheets
Displaying Data in the Spreadsheet

Displaying Data in the Spreadsheet
The system automatically displays all of your data in the Spreadsheet window.
When the system creates a database, it automatically creates line 0 (L0:0). During the data
import process, if the data that you import does not contain a line 0, and therefore there is no data
in this line, the line is automatically deleted. If the line contains data it is retained.

Channels
The cells immediately right of the ID Cell are called Channel Header Cells. These cells are used to
identify a unique type of data contained in a channel (column) of the spreadsheet. The data for a channel
appears below the channel header.
The channel headers provide a visual indication of the current status of the displayed channel. If the top
left corner of the header cell is marked by a black triangle, the channel is read-only, and it may not be
modified. A red line at the bottom of the header cell indicates that the channel has been re-sampled in
order to match the sampling rate of data from one of the other channels in the database.
Current X, Y and Z Channels
Current X, Y (and Z) channels are used to define which coordinates will be used for creating maps. For
example, you may have two sets of coordinates in your database (e.g. Geographic and projected, or
local grid); in this case you need to specify which to use when creating maps. Blue x, y (and z) markers
in the channel header cells indicate which channels are the current X, Y (and Z) channels.
Typically, you will use only X and Y, but you can also assign a Z. The Z is used in Drillhole
databases, where DH_EAST = X, DH_NORTH = Y and DH_RL = Z.
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To Set Current X and Y Channels

1. On the Coordinates menu, select Set Current X,Y, Z Coordinates.
The Set current X, Y channels dialog appears.

2. Select the names of the new coordinate channels.
3. Click OK. This makes these channels the new current X, Y (and Z) channels.The corresponding
"x", "y" or "z" appears highlighted in blue on the right of the header cell. When you change the
current coordinate channels, these markers change.
You can also use this menu item to review the current settings for the X, Y, and Z channels.
Show and Hide Channels
When you import data, all of your data is automatically displayed. You may want to hide certain channels
from display in the spreadsheet window.
To Hide a Channel (Column)

When a column is hidden, the database still contains all the data.
1. Click once on the channel header cell to select it.
2. Press the Space bar. The channel is hidden from the Spreadsheet view.
You can also right-click in the channel header cell and select Hide Column from the popup
menu.
To Display a Hidden Channel

1. Move your cursor to the top of the first empty channel header cell.
2. Right-click and select List from the popup menu.

A box appears beneath the empty channel header listing all the available channels that are not
currently being displayed in the Spreadsheet window.
3. Select the channel and click OK to display. The data channel appears.
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If you know the name of the data channel already, you can simply position the cursor on a
specific Channel Header Cell, type the name, and press Enter.
If you see '**', this indicates that the data are too wide for the spreadsheet column. To change
the width of a column, place the cursor on the dividing line between the column headers. The
mouse becomes a double arrow. Click and drag the line to the right to increase the column
width. Release the mouse button when done.
Protect and Unprotect Channels in a Spreadsheet
A black triangle in the upper left-hand corner of a channel indicates the channel is protected (i.e. readonly) and cannot be edited by the user until the protection is turned off. Original imported data are
automatically stored as protected data.
To Remove Channel Protection

1. Select (highlight) the channel header cell you want to unprotect.
2. Right-click and uncheck Protected from the popup menu.
The system removes the black triangle from the top-left corner of the channel header cell, indicating the
channel is no longer protected.
To Protect a Channel

1. To protect a channel, select the channel header cell to protect.
2. Right-click and select (check) Protected from the pop-up menu.
A black triangle appears at the top-left corner of the channel header cell, indicating that the channel is
protected.
Using the database popup menu you can also select to Protect All or Protect None of the
database channels. Check the Protect All option to protect all of the channels in your
database and Protect None to remove the protection from all of the channels.

Create Working Channels in the Geosoft Database
You can create new channels in your database to store the results of filters, mathematical expressions,
or any other processing operations that you may apply to your data. We recommend that you create a
new channel for storing any changes you make to the original imported data.
To Create a New Channel

1. From the top of an empty column, select the channel header cell (single click).
2. Type the name of the new channel.
3. Press Enter.
The Create Channel dialog appears.
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4. The Name of your channel should be displayed automatically. If required, enter the remaining
details, such as channel class, units, and display format.
5. Click OK to accept the defaults or changes you have made. The system creates a new channel in
the database and fills this channel with dummy values (i.e. *).
You can also select the channel header cell, right-click and select New from the popup
menu.
Delete a Channel from the Database
Before you can delete a channel from the Spreadsheet window, you need to verify that the channel is not
protected. If you try and delete a channel that is protected, the system will not allow you to proceed with
the deletion process.
It is important to realize that deleting a channel is very different than just hiding a channel from
Spreadsheet view. When you hide a channel from the spreadsheet, it is still in the database and can
be retrieved simply by listing the channel again. When you delete a channel, it is removed from the
Spreadsheet view and also deleted from the database.
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To Delete a Channel

1. Right-click on the channel header cell and select Delete Channel from the popup menu.

2. A Delete dialog box appears. This dialog box is a safety feature confirming that you really wish to
delete a channel from the database.
3. Click Yes to permanently delete this channel from your database.
The default is No. This is a secondary safety feature preventing you from pressing the Enter
key by mistake and deleting the channel.

Master Sample
The Master Sample option is used to force all other database channels to be sampled at the same
fiducial rate as the selected channel. The Master Sample channel is identified by a blue line under the
channel header.
This feature is useful when you want to edit data from a channel that has a larger fiducial rate (data
sampled less often) then other channels in the database.
By default, the spreadsheet window displays data using the channel with the smallest fiducial (most
frequent sampling) rate.
For example, consider a database with two channels. Channel 1 has a fiducial sampling rate of 10
readings/second. This channel is considered to be smaller (more frequent) than Channel 2, which was
sampled at 1 reading/second. By making Channel 2 the Master Sample channel, Channel 1 is displayed
at the same rate so that only every tenth fiducial is displayed.
To Activate the Master Sample

1. Right-click on the database channel header.

2. Select Master Sample from the popup menu. A blue line is displayed under the channel header.
To Remove the Master Sample

1. Right-click on the database channel header.
2. Select No Master Sample from the popup menu. The blue line is removed from under the channel
header.
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Displaying Data in the Profile View
After you open a spreadsheet and display one or more channels, you have the option of displaying them
in graphical (profile) form in a Profile window. The Profile window is composed of sub-windows called
panes, which appear directly below its corresponding database. You can display up to five separate
panes with 32 channels of data in each pane.
For additional information, see the application help Help/Help Topics.
Display Profiles
The Profile view is your "graphical window" to the Geosoft database. Profile windows are linked
dynamically to their corresponding database. When you select a value or range of values in either the
database or profile window respectively, they are also highlighted in the other window.
To Display a Profile

1. Select (highlight) the channel header cell of the channel you wish to view in the profile window.

2. Right-click and select Show Profile from the popup menu. The profile of the channel data displays
in the Profile Window immediately below the spreadsheet.

3. To see where values are located with regards to the profile line, simply select a value (or a range of
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values) in the channel and the system will highlight the corresponding area on the profile (or vice
versa).
To Display the Profile of Different Line

1. Select (highlight) the Line Header Cell in the top left corner of the spreadsheet.
2. Right-click and select List from the popup menu.

A list of all the line numbers in the current database will be displayed. You can think of each line
number as a worksheet in the Spreadsheet window. When you view a new line number, a new
worksheet is opened in the Spreadsheet window with corresponding data for that line number.
3. Click the line to display. The Profile window now displays the selected line.
When the Line Header Cell is highlighted, you can use the Database Tools Bar to scroll through
the lines by selecting Previous Line/Group or Next Line/Group.

Set Profile Options
Use the tabbed Profile dialog to specify the options for the current profile. By default, the options will
apply to the selected channel, in the image shown below this is the 'X' channel. This dialog is accessed
by right-clicking inside the Profile window and selecting Profile Options from the popup menu.
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This dialog includes five tabs: Data Info, Line Styles, Colours, Symbols, and Grid.
Y Axis Options
The Y Axis Options menu enables you to set scale options for the Y axis of the profiles in the profile
window.
To Set Y Axis Options

1. On the Profile window, right-click.
2. Select Y Axis Options from the popup menu. The Panel Y-Axis Scale Options dialog appears.

3. Select the method for Changing Lines, using the table below as a guide.
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4. Select the Profile Scaling, using the table below as a guide.
5. Click OK to change the Y Axis options.
The following table summarizes the different scaling options available to you:
Changing Lines

Scale to fit for each line

Adjusts the scale in the profile box to fit each line that is
displayed.

Same axis scale for all lines

Uses the same axis scale for all the profiles that are
displayed.

Same dynamic range, centred for each
line

Uses the same dynamic range, centred for each line
that is displayed.

Profile Scaling

Scale each profile separately

All profiles (including those from different channels) are
set to a different scale.

Same axis scale for all profiles

All profiles (including those from different channels) are
set to the same scale.

Same dynamic range, centred for each
profile

Uses the same dynamic range, centred for each
displayed profile.

X Axis Options
The X Axis Options selection enables you to select the channel to use as the X-axis. You can also
choose to automatically rescale the X-axis and/or display vertical grid lines.
To Select X Axis Channel

1. On the Profile window, right-click.
2. Select X Axis Options from the popup menu.The All-Panel Options dialog appears.
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3. Select the X-Axis to use in the profile window.
4. You can also select to Auto Rescale X-Axis.
5. Select to display Vertical Grid Lines, if desired, and at what Interval.
6. When finished, click OK. Your profile is updated.
Edit a Channel using Profile View
Before you can edit a channel, you must verify that the channel is not protected.
To Edit Data in a Channel Using the Profile View

1. Select the channel and right-click.

2. From the popup menu, select Show Profile. The system displays a profile of the data in the
Profile window below the spreadsheet.
3. Move to the Profile window and click the data to be edited. You will notice that the corresponding
data value is highlighted in the Spreadsheet view and a small box is drawn in the Profile window.
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Clicking anywhere in the Profile window will display the corresponding value in the
Spreadsheet view. You can click-and-drag to select a section of data in the Profile view.
4. Make the desired edits to the data in the spreadsheet.

Processing Data in the Spreadsheet
After you open a spreadsheet and display one or more channels, you have the option of processing the
data using the Geosoft database tools. These tools help you apply formulas and perform database
operations between channels for individual groups of points, lines or the entire database. Target offers
many options for processing and editing data in the spreadsheet. This guide shows some of the
commonly used processes.
For more information about the processing tools, please refer to the Application Help files or click
the Help button on the dialog of interest.
Calculate Statistics
Statistical information about your data can be very useful for general quality control and to ensure the
values are in range with what you would expect.
To Calculate Basic Statistics on a Channel

1. Select the data to perform the statistics on using either a double or triple click of the mouse.
Clicking (highlighting) the channel header once selects the header cell, clicking twice
selects the channel and clicking three times selects the channel in all of the selected
lines (groups) in the database.
2. On the Database Tools menu, select Report and then select Mark Statistics.
The Stat Report dialog appears.

3. Click Save Stats to save a copy of the statistical report.
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The Save Stats dialog appears.

4. Specify a name and location for the New statistics file.
5. Click OK to save the file.
6. Click OK to close the dialog box.
The following list summarizes how to obtain results on specific parts of your database:
Click once on the channel header cell to
highlight the header cell.

No statistics can be calculated.

Click twice (double click) on the channel
header cell to highlight the data in the
current line (group).

Statistics are calculated for that specific line (group) of the
database.

Click three times on the channel header
cell to highlight the data in all of the
selected lines (groups) in the database.

Channel statistics are calculated for all of the selected lines
(groups) in the database.

Edit Data using Conditional Expressions
Conditional math expressions can be used to edit data as required. For example, data spikes may be
removed from a dataset.
Example

mag<9000?mag:dummy
This formula states that if the mag value is less than 9000, the channel value will equal the mag value;
otherwise it is set to the dummy value.
To Use Conditional Expressions

1. Select the channel by double clicking the channel header (to highlight the data in the current
line/group) or triple click (to highlight the data in all the selected lines/groups in the database).
2. To edit press the equal "=" key on your keyboard. The Formula bar appears below the profile
window.

3. Enter the appropriate formula.
4. Press Enter. The formula is applied.
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Use the Channel Math Expression Tool
Use the Channel Math Expression Builder to create, save, load and execute math expressions for your
channel data. This easy-to-use standardized dialog provides numerous mathematical expressions within
a single tabbed dialog. For detailed information on the Channel Math Expression Builder, please click the
Help button.
Common tasks

The Channel Math Expression Builder includes several pre-built Common tasks, accessible from the
dropdown list.
Expression File

You can specify a pre-built expression file (*.exp) using the browse button on the Expression file field.
You can also build an expression using the builder and save it to file using the Save option.
To Access the Channel Math Expression Builder

1. On the Database Tools menu, select Channel Math.
The Channel Math Expression Builder dialog appears.

2. Enter a mathematical expression in the Expression field.
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To display the available Operators and Functions to help you build your channel math
expression, click Operators. All of the Operators and Functions that are available to
help you build your math expression are displayed.
3. Assign channels to the variable names used in step 2. Use the dropdown list to assign channels to
the variable selected. An example of a simple channel addition (C0 = C1+C2) expression is shown
below:

4. Click OK. The expression is applied.
Interpolate Data
In a situation where you remove cultural anomalies or "spikes" from magnetic data, the removed data
points are replaced by dummy (*) values. Our 'Interpolate' function enables you to interpolate these
dummy values.
To Fill Gaps in a Data Channel Using Interpolation

1. On the Database Tools menu, select Channel Tools and then select Interpolate.
The Interpolate Dummies dialog appears.

2. Select the Channel to interpolate from the dropdown list.
3. Select the Output interpolated channel from the dropdown list. You can overwrite an existing
channel by selecting it from the dropdown, or write the interpolated data to a new channel by
entering a new channel name.
4. Select the Interpolation method. For more detail on the available methods, refer to the Help
dialog..
5. Select Yes or No to Interpolate dummy edges.
6. Click OK. The system will interpolate the gaps created in the data.
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If chose to specify a new channel, the new channel with the interpolated data will not
automatically display in the spreadsheet view, as it is hidden from view by default. Simply select
the first empty Channel Header Cell, type the channel name, and press Enter. The channel will
be displayed.

Dynamic Links: Geographic Connections to your Data
Dynamic data links are "virtual" georeferenced connections between spreadsheets, profiles and maps.
Links are graphical connections that connect what you see on a map to the same location in other
displayed Map windows and to the original data in Spreadsheet and Profile windows. These links work in
multi-directions so you can select any window and see the equivalent data in the other windows you are
using.
Dynamic linking helps you to build knowledge quickly and make more informed decisions, through
enabling real-time and visual quality control, processing and analysis of your data.
Working with Dynamic Linking
At the most basic level, you can use dynamic linking to link spreadsheet data and profiles.
1. When you work with Spreadsheet and Profile windows and select one or more cells in the
spreadsheet, the system automatically shows you and locates the corresponding data in the
Profile window (or vice-versa).
2. When you work with spreadsheet, profile, and map windows and select a point on the map, the
system automatically highlights the corresponding data in the other windows (or vice-versa).
3. You can access the data linking tools on the Map Tools toolbar . The Shadow Cursor button (
enables you to view data for a single line/group. To view data for multiple lines/groups use the
Shadow Cursor Data Linking button (

)

).

Down Hole linking: The Shadow Cursor Data Linking tool technology also enables you to
track your down hole data in section plots and plan maps. For example, if you have plotted
a section on your map, you can use this button to dynamically link the data plotted on the
section to the database and profiles. When you move the "Shadow Cursor with Dynamic
Linking" on the map, the database and profile views will update to show the corresponding
data. If the corresponding data are in a different database line/group, then the spreadsheet
window will automatically display this line/group. When you select a value in the database
or a point on a profile, the "Shadow Cursor Data Linking" tool will update in the map view.
4. You can also create links between map extents (i.e. pan and zoom multiple maps will occur
simultaneously). This functionality is enabled via the Change Extent tools (
Map Tools toolbar.

), on the

Note that, you can only use database linking if your map contains line/group linking items (i.e. survey
lines, symbols, down hole sections or an ArcGIS LYR file).The system scrolls through the corresponding
database, updating the Spreadsheet and Profile windows automatically to reflect the currently selected
line/group.
Link Data Dynamically
Dynamic links are “virtual” georeferenced connections between spreadsheets, profiles and maps. These
links work in two-directions so you can select any window and see the equivalent data in the other
windows you are using.
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To Link Spreadsheet, Profile and Map Data

Desktop linking enables you to place a special Link cursor on one or more maps and locate a specific
part of the data.
1. Make sure only the desired map and the database are open in your project.
Do not remove them from your project, just close (minimise) any other map, grid or
database items that are currently open in your project.
2. From the Window menu, select Tile Vertically. The system arranges your database window and
map window side by side.
3. The system automatically turns on a map link and activates the Shadow Cursors button on the
Map Editing toolbar. You can tell a button is activated because it will appear to be depressed more
than the other buttons on the toolbar.
4. Click on a value in the database or on a point in the profile view, and you see that the Link cursor
(large black cross) moves to the same location on the map. This type of linking enables you to
quickly identify discrete anomalies on a map and view their corresponding values in the database.
5. You can display multiple maps and use this function to locate and visualize the same anomaly
locations for different data types. It is quite useful for quality control (searching for anomalous
noise spikes, for example) and for multi-parameter interpretation.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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In Target, working with map coordinate systems requires that the map coordinate system information be
attached to any database, grid or map. Once you have attached a coordinate system to a set of
coordinates,Target will deal with any re-projections that may be required to properly display data from
different coordinate systems together on your maps.
When dealing with coordinate systems, it is important to be aware that the geographic location (X,Y) of
any objects are either an implied or a known coordinate system. If you do nothing to define coordinate
systems in your data, Target will assume that all locations (X,Y) are in the same coordinate system,
which is unknown.
You must define coordinate systems if you want to:
Annotate maps with longitude, latitude locations
Convert the location of information (data or grids) from one map coordinate system to another
Display information on a map that is in a different map coordinate system
Defined a warped coordinate system to fit data to a desired map coordinate system
If you do not need to do any of these things, you do not have to deal with projections.
Coordinate systems can be defined for any pair of channels in a database, for a grid coordinate system,
and for a data view in a map. In most cases, all that is required is to define the coordinate system of the
"X" and "Y" channels of an original database. This coordinate system will then be passed on to grids
when data from that database is gridded, and maps created from this data will also inherit this coordinate
system. Coordinate systems of data channels, grids and map views can also be viewed and modified at
any time, although the modification of coordinate systems does require specific and accurate knowledge
of the projection information.
Target features "smart projections" that reproject data "on-the-fly" as it is displayed. This functionality
enables maps to have several views; each containing a different set of projected coordinates. In
addition, dynamic links between maps and data are maintained, even if different coordinate systems are
used.

Coordinate Systems in Target
In Target a coordinate system is always attached or applied to something. This can be a coordinate pair
on a database, a grid, or a map view. Before you can apply a coordinate system, you will need to know
the following information about your data:
The type of projection coordinates that contain the location information for your data.
Projected (x,y) - the coordinates are in a known projected coordinate system, such as UTM, or some
other map-based coordinate system.
or

Coordinate Systems
Define X, Y Channels

Geographic (long,lat) - the coordinates are longitudes and latitudes in degrees. Only a datum is
required.
When importing data that includes an attached Geographic Coordinate system, note that
Geosoft only supports decimal degrees (ddd.dd) or full Latitude-Longitude (ddd.mm.ss.ss).
Depending on the type of data, you may also need:
The coordinate projection subset to use (e.g. UTM, USA State Plane)
The units of measurement you want to use (e.g. feet, metres)
The Datum (or ellipsoid) to use (i.e. WGS 84 / UTM zone 44N) and local datum to use
When you define (or modify) a coordinate system the coordinates of the data (database, grid or
map view) remain unchanged. This process only sets the “coordinate system label”. However,
when you reproject data into another coordinate system the numerical representation of the
coordinates will change.

Define X, Y Channels
Once your data has been successfully imported into Target, you can set the coordinate system and
projection information for your database.
Defining Channels
One of the first steps in setting a coordinate system is defining your X and Y channels. This can be done
during the import process, or will be automatically set if your coordinate channels are called X and Y by
default.
You cannot create a map until your X and Y channels are defined.
In Target we have introduced "current" X and Y (and Z) channels. This feature enables users to select
the channels that they would like to use as the current X and Y (and Z) channels (for example, East,
North, and Relative Level).
Markers have been added to the channel header to indicate which channels are currently defined to be
the "current" X, Y (and Z) channels. The markers are little rectangles on the right side of the header cell,
and contain "x", "y" (or "z") in reversed display (like the triangle protection symbol on the left).
When you alter the current coordinate channels, these markers change too. Normally, you will just get
"x" and "y", but if you have a "Z" channel it will get the "z". The "z" will be used in Drillhole databases,
where DH_EAST = "x", DH_NORTH = "y" and DH_RL = "z".
All grids, maps, and databases derived from a database that has coordinate system information
attached to it, will inherit that coordinate system information.
To Define X and Y channels

When you first import your data, your X and Y coordinate channels may be called East and North (or any
other valid naming system).
1. On the Coordinates menu, select Set Current X, Y, Z, Coordinates. The Set current X, Y
channels dialog box appears.
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2. Select Current X and Y channels from the drop-down list.
3. Select the Current Z channel, if applicable.
4. Click OK. Your database now has set X and Y channels which can be seen by the inverse x and y
on the right side of the channel header cell.

Projected (X,Y) Coordinate System
The Target Coordinate System interface has been designed to make creating, editing or viewing
coordinate systems a simple, one-step process. Target uses a single dialog to set and modify coordinate
system settings. The Coordinate System tool also now supports ESRI projection files (PRJ).
The Coordinate System Dialog
Whenever you work with coordinate systems in Target, the coordinate system information for the current
database, grid, or view is displayed in the Coordinate System dialog. When the fields in the dialog are
shaded grey, you can only view the information. If the dialog box fields are white, you may edit the
values.
The dialog also includes a Copy from button that displays the Copy Coordinate System From dialog.
Use this dialog to copy a coordinate system from another file. The file types supported include,
Database, Grid, Geosoft Voxel, Geosoft projection (*.prj), ESRI projection (*.prj), Geosoft warp (*.wrp),
Geosoft polygon (*.ply) and GMSYS model.
To define a coordinate system, you must know the type of coordinate system that is used for the data. If
the wrong coordinate system type is specified, Target may return strange results or take an unusually
long time to process the data.
If the database contains no coordinate system information, the Unknown radio button is
automatically selected in the Coordinate System dialog box.
Setting a Projected Coordinate System for a Database
Use the Projected (x,y) coordinate system if your database coordinates are in a known projected
coordinate system, such as UTM, or some other map-based coordinate system. A coordinate system
can be defined from any pair of channels in a database. These two channels must contain coordinate
information. Normally, the X and Y coordinate channels are used.
To Set a Projected (X, Y) Coordinate System for Database Channels

This procedure assumes you have an open a database which contains at least two channels with
coordinate information (X, Y).
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1. On the Coordinates menu, click Coordinate System. The Georeference database channels
dialog appears.

2. Select the X and Y coordinate channels that you will use to set the coordinate system
3. From the Set as current X,Y? drop-down list, select Yes.
4. Click Coordinate System. The Coordinate System dialog appears. This dialog displays the
current coordinate system information for the database.

5. Select the Projected (x,y) radio button. The appropriate dialog parameters are enabled.
6. Verify the Length units are correct.
7. Select the Datum and Local datum transform from the drop-down lists. The Local datum
transform drop-down list provides all the local datum transforms, which apply to the selected
Datum.
8. Select the Projection method. Choose one of the available pre-defined projections from the list.
The list contains all projections currently defined by EPSG (v4.2). In cases where the coordinate
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system can only be viewed, and not modified, this control is replaced with a label containing the
name of the local datum transform.
If the coordinate system method you want to use does not exist, but you know the
parameters for it, you can click the Projection method drop-down menu,which actives a
New button to access the New Projection Method dialog. Use this dialog to create a new
(custom) coordinate system method.
9. When all the Coordinate System settings are correct, click OK.
Set Projected Coordinate System of a Grid
Normally, when you create a grid from a database that already has location (coordinate) channels with a
defined coordinate system, the coordinate system information in the database is automatically applied to
the grid. You can modify the current coordinate system or define a new one from the Grid and Image
menu.
To ensure consistency between your databases and grids it is good practice to define a
coordinate system for your database before creating grids from it.
To Modify or Define a Projected Coordinate System of a Grid

When the fields in any dialog box are shaded grey, you can only view the information. If the dialog box
fields are white, you may edit the values.
1. On the Grid and Image menu, select Properties. The Grid Properties dialog appears.

2. Browse to the grid you want to modify.
3. Click Next. The Grid Properties dialog appears. This dialog reports all of the basic information
about the selected grid.
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4. Click Modify to display the Modify Grid Properties dialog. This dialog displays the information that
is used to locate the grid in a real coordinate system.

Changing anything in this dialog will have the effect of moving or changing the apparent
size of the grid when displayed on a map.
5. Click CoordSys to modify (or define) the map coordinate system of the grid file. The Coordinate
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System dialog appears. This dialog displays the current coordinate system information for the grid.

6. Select the Projected (x,y) Coordinate system radio button.
7. Verify the Length units are correct.
8. Select the Datum and Local datum transform from the drop-down lists. The Local datum
transform drop-down list provides all the local datum transforms, which apply to the selected
Datum.
9. Select the Projection method. Choose one of the available pre-defined projections from the list.
The list contains all projections currently defined by EPSG (v4.2). In cases where the coordinate
system can only be viewed, and not modified, this control is replaced with a label containing the
name of the local datum transform.
If the coordinate system method you want to use does not exist, but you know the
parameters for it, you can click the Projection method drop-down menu,which actives a
New button to access the New Projection Method dialog. Use this dialog to create a new
(custom) coordinate system method.
10. When all the Coordinate System settings are correct, click OK. The Modify Grid Properties dialog
appears.
11. Click OK to apply the changes to the grid file and the Grid Properties dialog will be displayed.
12. Click Exit to close the dialog.
Create New Map from Projected (X, Y) Coordinates
In Target maps have several Views that contain information about the map. Coordinate system
information for a map is contained in the Data View. Base map information is contained in the Base
View.
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When you create a new map, the system either reads the manually entered coordinates or scans a userspecified database or grid file and attaches their coordinate system and coordinate attributes to the
specified map view.
Use the New map from x,y menu item to create a new blank map to fit the data range specified. The data
range can be entered manually, or it can be determined from the range of selected data in a database or
from a grid range. The first step is to create a new map using the coordinate system from an existing
database or grid.
To Define a Map Coordinate System for a New Map from Projected (X,Y) Data

1. On the Map Tools menu, select New Map and then select New Map from X,Y.
The Data range to map dialog appears. This dialog shows the data range (coordinate), units and
coordinate system information from the last coordinate system that was used.

2. To change the coordinate system information you can scan an existing database or grid. Follow
the procedures below depending on where the coordinate system information resides.
To Scan a Database for Data Range and Coordinate System Information

1. Click Scan Data. The system scans the current database open in your project. The new data
range and coordinate system information obtained from the database appears in the Data Range to
Map dialog box.
To Scan a Grid for Data Range and Coordinate System Information

1. Click Scan Grid. The Get range from a grid file dialog box appears.

2. Browse to the grid file.
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3. Click OK.The new data range and coordinate system information, obtained from the grid, appears
in the Data Range to Map dialog box.
To Define the Coordinate System

1. Click Coordinate System to view the coordinate system information. The Coordinate System
dialog box appears. This dialog will display the known coordinate system information as defined in
the scanned database or grid file.

When the fields in any dialog box are shaded grey, you can only view the information. If the
dialog box fields are white, you may edit the values.
2. If all the coordinate system settings are correct, click OK to apply the coordinate system and the
Data range to map dialog will again be displayed.
3. Click Next to continue. The Create a New Map dialog box will be displayed.
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4. Specify a Map name for the new map.
You can also select a Template to use for your map layout.
5. To automatically calculate the map scale, click Scale.The default scale that will fit the defined
data range to the specified template will be displayed. You can modify this value to a more
appropriate scale.
6. Click Finish when you are done. The system will create a new (blank) map with coordinate
system information in the Data View.

Geographic (long, lat) Coordinate System
The Target Coordinate System interface has been designed to make creating, editing or viewing
coordinate systems a simple, one-step process. Target uses a single dialog to set and modify coordinate
system settings. The Coordinate System tool also now supports ESRI projection files (PRJ).
The Coordinate System Dialog
Whenever you work with coordinate systems in Target, the coordinate system information for the current
database, grid, or view is displayed in the Coordinate System dialog. When the fields in the dialog are
shaded grey, you can only view the information. If the dialog box fields are white, you may edit the
values.
The dialog also includes a Copy from button that displays the Copy Coordinate System From dialog.
Use this dialog to copy a coordinate system from another file. The file types supported include,
Database, Grid, Geosoft Voxel, Geosoft projection (*.prj), ESRI projection (*.prj), Geosoft warp (*.wrp),
Geosoft polygon (*.ply) and GMSYS model.
To define a coordinate system, you must know the type of coordinate system that is used for the data. If
the wrong coordinate system type is specified, Target may return strange results or take an unusually
long time to process the data.
If the database contains no coordinate system information, the Unknown radio button is
automatically selected in the Coordinate System dialog box.
Setting a Geographic Coordinate System for a Database
Use a Geographic (long, lat) coordinate system if your database coordinates are in longitudes and
latitudes degrees and only a datum is required. A coordinate system can be defined from any pair of
channels in a database. These two channels must contain coordinate information. Normally, the X and Y
coordinate channels are used.
Before you begin, use the Edit Channel dialog to confirm the Format type is Geographic as shown below:
When importing data that includes an attached Geographic Coordinate system Geosoft only
supports decimal degrees (ddd.dd) or full Latitude-Longitude (ddd.mm.ss.ss).
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To set a Geographic (Long, Lat) Coordinate System for a Database

This procedure assumes you have an open a database which contains at least two channels with
longitude and latitude information.
When you select a Geographic (long,lat) coordinate system the geographic coordinates will be
displayed as a Cartesian system with units of degrees. This means that you will not be able to
display latitude and longitude annotations in the base map because the X, Y coordinate system of
the map will be represented by the long, lat coordinates.
1. On the Coordinates menu, click Coordinate System.
The Georeference database channels dialog box appears.

2. Select the X and Y coordinate channels that you will use to set the coordinate system and then
click the Coordinate System button.
The Coordinate System dialog box appears.
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3. Select the Geographic (long,lat) radio button. The appropriate dialog parameters are enabled.
You will note that the Length units have been set to match the units used by the coordinate
system and can not be changed.
4. Select the Datum and Local datum transform from the dropdown lists. The Local datum transform
drop-down list provides all the local datum transforms, which apply to the selected Datum.
5. When all the Coordinate System settings are correct, click OK to apply the coordinate system.
If your Longitude, Latitude channels display double asterisks (**), that only indicates that the
channels are too narrow to display the data. Widen the channels and the data will be properly
displayed.
New Map from Geographic Coordinates
In Target maps have several views that contain information about the map. Coordinate system
information for a map is contained in a data view. Base map information is contained in the base map
view.
When you create a new map, the system either reads the manually entered coordinates or scans a userspecified database or grid file and attaches their coordinate system and coordinate attributes to the
specified map view.
The projected base map created from a latitude-longitude range will be windowed based on lines
of latitude and longitude, not X and Y, and the data window will be oriented so that North is up at
the centre of the map.
To create a new map from Latitude-Longitude requires a database that has a Projected (x,y) coordinate
system.
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When using latitude-longitude degrees as the coordinates of your data and/or a geographic coordinate
system you need to use New map from x,y menu item The resulting map will have latitude and longitude
displayed in a right angled Cartesian coordinate system.
With a Projected (x,y) coordinate system, you can display Latitude and Longitude annotations on
the basemap of a new map created from x,y coordinates.
To Define a Map Coordinate System for a New Map from Geographic Coordinates

The first step is to create a new map using the coordinate system from an existing database or grid. After
creating a map from Longitude/Latitude the data view of the new map will have a warp attached to it.
This is because when we create a Longitude/Latitude map we warp the view so that North is at the top
and centred.
If you remove the warp on your map, new elements may not be positioned correctly.
1. On the Map Tools menu, select New Map.
2. Select New map from Lat,Long. The Data range to map dialog appears. This dialog shows the
data range (coordinates), units, and coordinate system information from the current (selected)
database in your project.

3. To change the coordinate system information, you will need to either scan an existing database or
grid for the coordinate system information. Follow the procedures below depending on where the
coordinate system information resides.
To Scan a Database for the Data Range and Coordinate System Information

1. Click Scan Data. The system scans the current database open in your project. The new data
range, and coordinate system information obtained from the database appear in the Data Range to
Map dialog box.
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To scan a grid for the data range and coordinate system information

1. Click Scan Grid. The Get range from a grid file dialog box appears.

2. Browse to the grid file.
3. Click OK.The new data range, and coordinate system information obtained from the grid appear in
the Data Range to Map dialog box.
To Define the Coordinate System

1. Click Coordinate System to view the coordinate system information. The Coordinate System
dialog box appears. This dialog will display the known coordinate system information as defined in
the scanned database or grid file.

When the fields in any dialog box are shaded grey, you can only view the information. If the
dialog box fields are white, you may edit the values.
2. If all the coordinate system settings are correct, click OK to apply the coordinate system and the
Data range to map dialog will again be displayed.
3. Click Next to continue. The Create a New Map dialog box will be displayed.
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4. Specify a Map name for the new map.
You can also select Templates to use for your map layout.
5. To automatically calculate the map scale, click Scale.The default scale that will fit the defined
data range to the specified template will be displayed. You can modify this value to a more
appropriate scale.
6. Click Finish when you are done. The system will create a new (blank) map with coordinate
system information in the Data View.

Displaying Data with Different Coordinate Systems on a Map
Since grids, images, data and maps can have different coordinate system information, you may want to
display one or more types of coordinate systems on a map. The following is a list of data types that you
can attach coordinate system information to and place on a map:
Grid or image
Located data
ArcGIS LYR
ArcView SHP
MapInfo data
Vector files such as DXFs, etc
To Display Different Coordinate Systems on a Map

1. Identify the coordinate system for each data type (i.e. grids, images, maps, or located data).
Data types with different coordinate systems can be placed on the same map. However,
make sure the data cover the same geographical area.
2. Data that is imported into a map is re-projected into the map coordinate system when it is
displayed. For example, if you place a grid with latitude/longitude coordinate system coordinates
on a map defined in UTM coordinates, the system will display the grid on the map in the map’s
coordinate system while preserving the grid’s coordinate system information. In this example, the
lat/long meridians on the grid would appear curved, while the UTM meridians would appear
straight.
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Create and Apply Warps on a Grid
Warping is useful when you have an un-referenced grid file in an unknown coordinate system or an unreferenced image.
Relocate data, define one control point
Scale and rotate data, define two points
Scale in X and Y and rotate, define 3 control points
Perform a quadrilateral warp, define 4 control points
To Define a Warp

1. On the Coordinates menu, select Georeferencing and then select Define a Warp. The Warp file
Creation dialog appears.

2. Specify an Output Warp file name (.wrp) .
3. Select the Warp Type from the drop-down list.
You will be prompted to enter a number of control points, depending on the warp type. If 4-point
Quadrilateral Warp is chosen then the points must be specified in a clockwise or anti-clockwise
direction to avoid a mid-point twist of the output data. Each control point will have an old coordinate
and a new coordinate. The Multipoint warp (more than 4 points) is best for small translations
relative to the units of distance on the map.
4. Select the Definition Mode.
In Interactive mode, both the old and new coordinates are defined using the mouse on the current
map. In Semi-interactive mode the old coordinate is defined on the current map, but the new
coordinate is entered in a dialog, using the old positions as default values. In Manual mode, both
the old and new positions are entered in a dialog window.
Semi-interactive mode enables you to select the points on the map that you are warping
from (for example, the corners of a bitmap) and then manually input the points (in UTMs)
that you are translating to. If you find that you cannot accurately select these points, try the
other modes (interactive and manual) to enter the four points. Remember, that you can use
the right mouse menu to zoom, shrink, and pan around the map while you are selecting the
points.
5. Click OK. The Map projection box appears asking you to Define the output coordinate system?.
6. Click Yes if you wish to define the coordinate system of the map or click No to continue applying
the warp.
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If you clicked Yes above, the Coordinate System dialog will appear. Refer to the
Application Help files for details on defining the Coordinate System.
7. If you clicked No above or have defined the coordinate system, the Define Warp control
pointsdialog appears.
8. This dialog tells you to click on the point location for each point in your warp file, you will then be
prompted to specify the new “warped” location in the following dialog. Click OK to when you are
ready continue. The cursor changes to a cross-hair enabling you to locate the first point.

9. Left-click to assign the first point. Once you have located the first point, the Assign new
coordinatedialog appears.

10. Specify the New X and Y coordinates. Temporary circles will be placed on the locations that you
select with the cross-hair cursor. These circles will be removed once all of the control points have
been set and the warp control file has been created.
If you have multiple coordinates to define, click Next to specify the next coordinate point
location. Continue this until you have specified all coordinates.
11. Click Finish. The warp is created.
To Apply A Warp to a Grid

1. On the Coordinates menu, select Georeferencing and then select Warp a Grid. The Warp a grid
dialog appears.

www.geosoft.com

Target How-To Guide | 66

Coordinate Systems
Create and Apply Warps on a Grid

2. From the drop-down list, select the Grid file to warp.
3. Browse to the Warp definition file (.wrp) from your project directory.
4. Specify the New warped grid file name and a New cell size (optional), if required.
5. Click Next to continue. The New warped grid dialog appears.

6. When all parameters are correct, click Finish to warp the specified grid file.
Warping Image Files
If you want to warp an image file (i.e. tiff, bmp) and the file is large, you may only want to attach the warp
to the file. "Attaching" the warp is suitable if you have a very large file that is stored on a CD, for
instance. The warp process is repeated every time you display the file to a projected map but the original
file remains unchanged.
When you warp an image, the warped output image must be a Geosoft COLOUR grid (*.grd) File type in
order to keep the colours of the original image.
If the image of the new warped grid appears twisted or is an incorrect size, check the warp points are in a
circular order and the points are correctly located within the defined map area.
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Converting Elevations
The Geoid height menu option enables you to convert GPS elevations to elevations relative to the geoid.
Geoid height (GEOID GX) will create a channel of the geoid height relative to the GRS 80 spheroid for a
given pair of coordinate channels. This GX requires a grid of the geoid model, which is the elevation of
the geoid in metres relative to the GRS 80 spheroid, which is found in the Target/etc directory. For more
information, please refer to the GEOID GX help topic.
How-To Guide Publication Date: 29/04/2014
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In mineral exploration, the initial focus of any exploration program is to identify potential targets for
drilling. After potential targets are determined, the project moves into a “proving” phase led by a geologist
experienced in obtaining and interpreting drillhole data. A complete drilling program will acquire many
types of data ranging from surface data including, topography, geophysics, geochemistry to drillhole data
including, hole location (i.e. collar details), surveys (i.e. 3-Dimensional orientation), geologic rock types
and descriptions, drill hole geochemical assays and borehole geophysical logs.
The Target system enables the import of a wide range of data types, including geology, geochemistry,
geophysics and GIS. The user-friendly Import Wizards enable you to import data from different data
sources, including ASCII, Excel, Access, and acQuire Technology Solutions' acQuire. Data can also be
imported from CAD and GIS packages, such as Microstation, DXF format, MapInfo and ArcView.

Import Surface Data
Many of Target’s features have been developed to provide integration with other Geosoft applications,
including the montaj Geochemistry extension. Target provides the tools to import geochemistry survey
and assay data and then merge and verify the data into a single database. Any mismatch between
Sample numbers in either database will be reported in a merge report file.
Survey data must include the Sample numbers, X, Y locations and can optionally include Sample types
(standards and duplicates). Assay data must include the Sample numbers with their associated Assay
values. When importing Assay data into Target all elements are assigned the ‘class’ ASSAY, enabling
the identification and extraction of the standards and duplicates using montaj Geochemistry tools. All
montaj Geochemistry tools work with Assay data imported via the Target application.
In the following examples we import survey data and assay data and then merge the survey data into the
assay database.
When importing combined geochemistry data sets (survey and assay data combined in one
dataset), import using the Import assay menu option to ensure that the assay values are
assigned to the 'ASSAY' class.
Import Survey Data
Survey data must include the Sample names, X, Y locations and optionally Sample types (standards and
duplicates).Survey information can be imported from a tabular ASCII file (including Excel CSV format
files), an external database table, or the clipboard.
For detailed information click the Help button on your dialog of interest.
To Import Survey Data

1. On the Surface Mapping menu, select Import Data and then select Import Survey Data.
The Import SURVEY data dialog will appear.

Target Surface Data Import and Quality Control
Import Surface Data

2. Select the data source and then use the Browse button to select the survey file from your working
folder. If you leave the Import template blank the default template (_chsurvey.i3) will be created in
your project directory.
3. Click Next>. The Create New Database dialog will appear.

4. Specify the new database information and click the OK button.
The system scans the survey import file and displays the first of three dialog boxes from the
Geochemistry Import Wizard will appear.
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5. Choose the data type that best describes your data and click the Next>button.
The second Geochemistry Import Wizard dialog will appear.
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6. Depending on the previously selected data type you may be asked to define the column delimiters
and string handling and then click the Next button.
The third Geochemistry Import Wizard dialog will appear.

7. Specify channel types and parameters for each imported channel (column) and click the Finish
button.
The survey data will be imported into the new database and displayed in a spreadsheet window in
your open project.
At this point, the Geochemistry extension tools can be used for users with this license. Refer
to the Help for more information.
Importing Assay Data
Assay data must include the Sample names with their associated Assay values. When importing Assay
data into Target all elements are assigned the ‘class’ ASSAY, enabling the identification and extraction
of the standards and duplicates using montaj Geochemistry tools. All montaj Geochemistry tools work
with Assay data imported via the Target application.
To Import Assay Data

1. On the Surface Mapping menu, select Import Data and then select Import Assay Data.
The Import ASSAY data dialog will appear.
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If you have loaded a Channel attribute file that contains detection limits for each element,
choose 'Yes' for the 'Convert negatives?' option in the Import Assay Data dialog, any value
less than the detection limit (including those less than 0.0) will be replaced with a value that
is one half the detection limit.
2. Select the Data source and then use the Browse button to select the assay file from your project
folder. If you leave the Import template blank the default template (_chassay.i3) will be created in
your project directory.
3. Select the parameters from the Lab ID and Assay method dropdown lists.
To add new Lab ID and Assay methods items, type the new information in the appropriate
box; the dropdown list will be automatically updated. To manage the lists by adding or
deleting items, click the Lab IDs or Assays buttons to display the appropriate dialog. User
defined pick lists are stored in the \Geosoft\Oasis montaj\user\csv\ directory. For more
information, click the Help button.
4. Specify the remaining import file parameters. For detailed information on the import assay data
parameters, click the Help button.
5. Click the Next> button. The Create New Database dialog is displayed.
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6. Specify a filename for the import database and the parameters for Maximum soil surveys/lines,
Maximum field/channels, and Compression type.
7. Click the OK button. The new database is displayed in the background of your project (and under
Databases in the Project Explorer window) and the first of the Geochemistry Import Wizard
dialogs is displayed.

8. Choose the data type that best describes your data (Delimited or Fixed Field). In the four fields in
the middle of the dialog, specify which line in the file contains the data headings (i.e. channel
names), data units (ppm, ppb, %, etc.), which line to begin importing data, and the number of lines
to display in the preview window.
9. Click the Next> button and the second Import Wizard dialog is displayed.
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10. Select the column delimiters (type of character or white space used to separate the column text)
and then click the Next> button.
The system displays the third Import Wizard dialog.
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The Import Wizard scans your data to determine the type of data with which you are
working (i.e. Channel Type). It is a good idea to review your data to ensure that the wizard
selected the correct channel types.
The Parameters box displays the Field name, Label, Data type, Data format and Dummy
value of the column currently highlighted in the preview window. The message below the
preview window indicates how many channels remain unspecified. Each channel must
have a name to continue the import process.
11. When you are finished modifying the channels, click the Finish button. The data will be imported
into the database and a spreadsheet window is displayed, indicating that the import process is
finished.

Merge Survey and Assay Data
Target provides the tools to import geochemistry survey and assay data and then verify and merge the
data into a single database. Any mismatch between Sample names in either database will be reported in
a merge report file.
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Survey data must include the Sample names, X, Y locations and can optionally included Sample types
(standards and duplicates). Assay data must include the Sample names with their associated Assay
values. When importing Assay data into Target all elements are assigned the ‘class’ ASSAY, enabling
the identification and extraction of the standards and duplicates using montaj Geochemistry tools.
Many of Target’s features have been developed to provide integration with other Geosoft applications,
including the montaj Geochemistry extension. All montaj Geochemistry tools work with Assay data
imported via the Target application.
To Merge Survey and Assay Data

1. On the Surface Mapping menu, select Import Data and then select Merge and Verify Data.
The Merge survey data into assays dialog will appear.

2. Select the Assay database and Survey database from your working directory, and then select
whether to View merge report, or not?
For more information on these or any dialog parameters, click the Help on the dialog of
interest.
3. Click the OK button. The survey database will be merged with the assay database and the merge
report file (chmerge.txt) will be displayed in your project.
At this point, the Geochemistry extension tools can be used for users who are licensed to use
it. Refer to the Help for more information.
Save a Database
It is always a good habit to save changes you make to your databases, including new databases.
To Save your Databases

1. Select (highlight) the database to be saved, and click the Save Database Changes button on the
main Standard Bar.
The database will be saved in your current working folder.
How-To Guide Publication Date: 29/04/2014
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Quality Control
After your data has been imported correctly into the system, your master database should contain only
valid or correct data. Practical experience in exploration geochemistry, however, shows that this is often
not the case and quality control may be required, even after data import. The Target system is intended
to streamline quality control by providing a single environment for quickly calculating summary statistics
and manipulating data values. In addition, you may want to further evaluate your data by applying math
expressions and evaluating results, or by editing or removing individual (problem) data values.
Calculating and Saving Statistics
The Target system quickly calculates and displays statistical analysis of your ASSAY channels. The
system also enables the export of the ASSAY channel statistics to a txt file. The txt file is saved to your
current project directory.
To Calculate and Save Statistics

1. Open and select your database.
2. Click twice on the channel header cell to highlight the data in the current line and then right-click.
Clicking three times on the channel header cell highlights the data in all of the selected lines
(groups) in the database.
3. From the pop-up menu select Statistics.
The Stats Report dialog is displayed.

Key fields you should examine carefully include the number of items and the number of dummies.
The following table describes the summary statistical values that are reported.
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Channel

Name of the channel.

Line(s)

Name of the Line(s) reported.

Fid Range

Range of fiducial values.

Num of items

Number of “non-dummy” items in the channel.

Num of dummies

Number of blank items. Dummies are ignored in the calculation.

Minimum

Minimum value in the channel.

Maximum

Maximum value in the channel.

Mean

Arithmetic mean or average value. This is equal to the sum of all values
divided by the number of items.

Standard deviation

Standard deviation in the data. This is equal to the square root of the
variance in the data, and is an estimator for the “width” of the data.

Arithmetic sum

The sum of all of the values in the channel.

4. To save the statistics, click the Save Stats button.
The Save Stats dialog is displayed.

5. Specify a New statistics file name and click the OK button. The statistics file will be saved in your
project directory and the Stats Report dialog will again be displayed.
6. Click the OK button to continue.
How-To Guide Publication Date: 29/04/2014
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Working with montaj Geochemistry Tools
Many of Target's features have been developed to provide integration with other Geosoft software
extensions, including the Geochemistry application. The following how-to guide has been provided for
users who have a license for the montaj Geochemistry extension, and would like to extract the standards
and duplicates from their assay database.
When importing assay data into Target all elements are assigned the ‘class’ ASSAY, enabling the
identification and extraction of the standards and duplicates using Geochemistry tools. All Geochemistry
tools work with assay data imported via the Target application. The Target system also provides the
ability to auto convert negative or below detection limit assays when importing.
Loading the Geochemistry Menus
Before you can start working with the Geochemistry features, you must load the Geochemistry menus.
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You can add Geochemistry as another default menu by adding it to the Default menus
parameter on the Edit|Settings|General dialog.
To Load the Geochemistry Menus Manually

1. On the GX menu, click Load Menu. The Load menu dialog appears.
2. Select geochemistry.omn from the list of files and click the OK button. The system displays three
new menus on your menu bar (GeochemImport, GeochemMap and GeochemAnalyse).
For detailed information on working with the Geochemistry tools, download the Geochemistry extension
How-To Guides from the Geosoft web site.
How-To Guide Publication Date: 29/04/2014
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Maps provide a key tool for interpretation for many earth science applications. Target provides a wide
range of surface mapping capabilities. Using Target’s versatile gridding routines, grids can be created
using point sample datasets (e.g. streams, soils, rocks, geophysical data, geochemistry data) from a
variety of raw data sources (ASCII, Excel, Access, and acQuire). Target provides a full featured
dynamic contouring algorithm with gradient feathering and extensive labelling control for professional
quality presentation results. Easy-to-use design wizards simplify the creation of grids and contours.
Quickly create multiple and varied types of maps, including gridded maps, surface maps, posted value
maps and sub-location maps. Interpretation can be done on all maps with CAD drawing tools, which
enable a user to annotate and define areas of interest onto new layers in the map view.
The purpose of this How-To Guide is to help you become aware of the key components and capabilities
of the surface mapping process to prepare you for plotting your results. In this exercise, you will be:
Creating a Surface Map
Plotting Survey Lines and Profile Plots
Symbol Plotting
Gridding Data
Plotting Contours

Creating a New Map
Target Can be used to produce an intelligent entity called a Map. Physically a map is a special graphic
file (*.MAP) containing drawings and images. We call the map intelligent because it enables you to edit it
interactively, apply dynamic linking and track the map creation processes.When you create or open a
map in Target, the system displays a Map window in the project. For a new map, the window is initially
empty. For an existing map, all map elements are displayed when the window opens.
An important component of the map is the map template. Templates control placement of base map
elements (surrounds), contours, grids, plots, images and any other graphics elements that you may
require in your completed map. For more information on mapping, map components and working with
maps see the Application Help.
To Create a New Map

1. Select the database you wish to create a map from in your current project.
2. On the Surface Mapping menu, select New map and then select New map from E,N.
The Data range to map dialog appears.

Target Surface Data Mapping
Creating a Base Map

3. Click the Scan data button to have the system query the database for the Minimum X, Y and
Maximum X, Y coordinates, Distance units and the Coordinate System information, or enter the
desired data range manually.
If the scanned data or grid file does not have an established unit, "metres" is assumed. It is
important that the distance units accurately reflect the units of the data range. The default
unit can be modified from the Default Settings dialog, found on the GX|Global
Settings|Generalmenu.
4. Click the Next> button.
The Create a New Map dialog appears.

5. Enter a Map name. Using the dropdown list, select the Map Template and then click the Scale
button.
The system automatically calculates a scale that will fit the data on the map template. It's
recommended that you increase the scale up to a more appropriate 'round' number (e.g. from
19255 to 20000).
6. Click the Finish button to display the new blank map.

Creating a Base Map
Maps are composed of views. A view is a coordinate translation and a masking region and is used to
organise and display information on a map. Maps consist of a Base view, which uses paper coordinates
with an origin at the bottom left corner of the page, and a Data view, which uses ground coordinates.
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You can customize your base map with many elements, including map surround, north arrow, scale bar,
reference grids, latitude/longitude annotations, text blocks/balloons and titles. The layout of your base
map can either be map or figure style. Figure style maps have a layout with the title, scale bar and north
arrow located at the bottom of the map, whereas map style maps have a layout with the title box, scale
bar and north arrow along the right hand side of the map. The following images show the difference in
layout between the two styles.

To Create and Plot a Figure Style Base Map

1. Make sure your map file is open and selected in the project.
2. On the Surface Mapping menu, select Base Map and then select Draw Base Map.
The Basemap layout dialog appears.
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This dialog is the first dialog in the base map layout wizard. The type of Map style that you choose
here will reflect the type of dialogs to follow.
For this example, we select the figure style.
3. Select thefigure style.
4. Click Next> to continue.
The Figure style base map dialog appears.

5. Specify the display characteristics of the base map elements.
For detailed information on each setting, click the Help button.
6. Set the North direction. If blank, no North arrow is drawn.
7. You can specify different types of display styles for the Reference grid via the dropdown list.
8. Configure the other base map options as desired.
9. Click Next> to continue.
The Figure titles dialog box appears.
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10. You can specify the map titles and sub-titles, if desired.
11. Click Finish to plot the base map on your current open map.
To Create and Plot a Map Style Base Map

1. Make sure your map file is open and selected in the project.
2. On the Map Tools menu, select Base Map and then select Draw base map.
The Basemap layout dialog appears.

This dialog box is the first dialog box in the base map layout wizard. The type of Map style that you
choose here will reflect the type of dialog boxes to follow.
For this example, we select the Map style.
3. Select map.
4. Click Next> to continue.
The Full map style base map dialog appears.
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For detailed information on each setting, click the Help button.
5. Set the North direction. If blank, no North arrow is drawn.
6. You can specify different types of display styles for the Reference grid via the dropdown list.
7. Configure the other base map options as desired.
8. When complete, click Next>.
The Map title block dialog appears.
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9. You can specify the map titles and sub-titles, if desired.
10. Click Finish to plot the base map on the current open map.

Moving Around the Map
Once you have your map displayed, you may want to zoom into the map so that more detail is displayed.
You may also wish to move around the map using other options.
You can also access these commands by right-clicking on a map and selecting the options from
the pop-up menu.
Map Layout
The following is a list of some of the different types of viewing options available for moving around and
viewing the map with ease:
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Zoom Box

Click this button to activate the Zoom Box. Click on the map, then while holding
down the left mouse button and move your cursor to box in the area of the map
you want to zoom. Click to select the area. Click the mouse button again to zoom
to the area selected.
Once the box has been defined, the cursor and the box are linked and by
moving the cursor around the map you can move the box to another
location, and then click the left mouse button to zoom to the boxed area.

Pan

Click this button to Pan around in the currently selected map. Click the left mouse
button and while holding the button down, move the hand cursor to pan around
the current map area.

Interactive Zoom

Click this button to activate the interactive zoom. Click on the area of the map you
want to zoom (e.g. an anomalous location on a grid), then while holding down the
left mouse button, move your cursor left to zoom out and right to zoom in on the
selected area.
Click this button to zoom in and increase the displayed map features by 50%.

Zoom In
Click this button to zoom out and shrink the displayed map features by 50%.

Zoom Out
Click this button to display the whole map area in the map window.

Full Map
Click this button to zoom to the selected map view or group.

Zoom to
Selection

Previous Extent

Click this button to undo all changes that you have made since the last time you
saved the map. This command is useful for removing text and graphics that you
may have added accidentally.
When working on a map, you may prefer to use this command periodically so that
you undo only a few changes at a time rather than your entire set of map edits and
other changes.

Next Extent

Click this button to redo the latest changes that you have made since the last time
you saved the map. This command is useful for adding text and graphics that you
may have removed accidentally.
If you manually resize the map window or perform editing on the map you may
need to redraw the map to refresh its current view

Redraw
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Map Tools

The Map Tools menu provides several options which enable you to control how your map appears and
which menus are active. The last three buttons on the toolbar determine on which maps zooming occurs:
This Map Only button will zoom only the current map, which will be highlighted.
All Maps button will zoom all the maps, which share the same coordinate system.
Other Maps Only button will zoom all the other maps, which share the same coordinate system, with
the exception of the current map. This enables the use of one map as a reference.
To find out the function of the other buttons on the Map Tools Bar, hold the cursor over the button
until a description appears.
Map Pop-Up Menus
Map Views

Map Groups

Map Window Status Bar
The projection information in the status bar is cleared when there are no active maps.
Configurable Hotkeys
Target provides configurable Hotkeys enabling quick and easy access to menu items including all map
tools. To access the Shortcut Keys dialog, an interactive dialog enabling you to set your own Hotkeys or
view the defaults, select the GX|Database Settings|Configure GDB Shortcut Keys menu item.
How-To Guide Publication Date: 29/04/2014
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Survey Line and Profile Plotting
The Target system provides the capability to plot survey lines for line-oriented Geoscience surveys, for
example, airborne magnetic survey data. The system also provides the capability to display plan view
profiles of the data values for each survey line.We recommend that you experiment with these options
with your own line data.
To Plot Survey Lines (Line Path)

1. Select the open map with which you want to work.
2. On the Surface Mapping menu, select Survey Lines and then select Line Path.
The Line path plot dialog appears.
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3. Change the line colour to black or another colour.
4. Click OK. Target displays the survey line path on your map.
For more information on plotting survey line paths, click the Help button on the Line path plot
dialog.
To Plot Profiles

1. Select the open map with which you want to work.
2. Select the Surface Mapping menu, select Survey Lines and then select Profile.
The Profile plot dialog appears.
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3. Use the dropdown menu to select the channel to display in profile view.
4. Change the line colour to red or another colour.
5. Click OK. Target displays the profile of the channel values on your map.
For more information on plotting profiles on your map, click the Help button on the Profile plot
dialog.

Plotting Symbols and Legends
The Target system provides the ability to create a variety of symbol type plots for spatially located Earth
Science data. Symbol plotting is ideally suited for the presentation of data sets that are not lineorientated such as geochemical survey results.
Target enables you to create fixed size coloured symbols or symbols that are sized in proportion to the
data values. Colours can be based on a variety of colour files, including zone (*.ZON), table (*.TBL) or
image transform (*.ITR). Symbols can have different fill and edge colours. The fill and edge colours are
independent, so they can be set to different values for different channels.
The symbol plots available from the Surface Mapping|Symbols menu, include:
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Location Plots
The most basic type of symbol plotting in Target is to draw location plot symbols on a map for all data
points in the database.
To Plot Location Plot Symbols:

1. Select (highlight) your map.
2. On the Surface Mapping menu, select Symbols and then select Locations.
The Symbol plot dialog appears.

3. Specify the parameters for your symbols.
4. Click the OK button and the system plots and displays the survey locations on your map.
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A mask channel is a channel that can be used to subset a database and has its CLASS
attribute set to “MASK”. If you have a mask channel, and it is selected, only those locations
where the corresponding mask channel value is not a dummy will be used. For more
information on Mask Channels, see the Application Help System.
Post Data Values
Assay data values can be posted next to sample locations on your map.
To Post Assay Values

1. Select (highlight) the map to post assay data values on, as well as the database to extract posting
information from.
2. On the Surface Mapping menu, select Symbols and then select Postings.
The Post data values on a map dialog appears.
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3. From the Post channel dropdown, select the channel you would like to create postings from.
4. Specify any other parameters for your posted data values as shown above. Click the OK button
and the system plots and displays the assay data values on your map.
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Plotting Range Classified Symbols
The Range Classified Symbols are the most flexible of the entire symbol tools collection. It enables
different ranges of data to be plotted using different symbols, colours and sizes.
To Plot Range Classified Symbols

1. Select (highlight) the map you want to plot range classified symbols.
2. On the Surface Mapping menu, select Symbols, then select Range Classified.
The Classified symbol plot dialog appears.

www.geosoft.com

Target How-To Guide | 95

Target Surface Data Mapping
Plotting Symbols and Legends

3. Fill in this form and click the Ranges button when you're done.
The Specify Ranges dialog appears.

4. Specify the extent of each range by entering the maximum value for each range.
5. Click the Symbols button.
The Specify Symbols dialog appears.

6. Specify the desired symbol shape for each range.Click the OK button to return to the Specify
Ranges dialog and then click the Sizes button.
The Specify Sizes dialog appears.
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7. Specify the Symbol Size for each level. Click the OK button to return to the Specify Ranges
dialog, then click the Colours button.
The system displays the Specify Fill Colours dialog.

8. Choose the colours by clicking inside the colour boxes and the Color Tool will appear. Select a
colour from the basic colour palette or click the Define Custom Colors>> button to select a
custom colour. Repeat this step for all the colour levels and then click the OK button to return to
the Specify Ranges dialog box.
9. Click the OK button on the Specify Ranges dialog to return to the Classified symbol plot dialog.
10. Click the Plot button. The system plots the classified symbols for all ranges on the map.
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Plotting Symbol Legend
When you use Range Classified symbols you will want to then create a legend showing the symbol
colours and size ranges used on the map.
To Plot Symbol Legends

1. Select (highlight) the map you would like to post the symbol legend to.
2. On the Surface Mappingmenu, select Symbols and then select Symbol Legend.
The Classified Symbol Legend dialog will appear.
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3. Specify the fields and click the Plot button. The system plots the legend at the lower left corner of
the map. Note that, selecting the Locate button enables you to interactively select any location on
your map to place the legend.
You can move the legend to a more appropriate location by simply selecting the legend
group, holding down the left mouse button and then moving the legend to an appropriate
location on your map.
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When you select this option, the system automatically records the colour, symbol and size
settings you specified when creating the Range Classified Symbols. This makes generating a
legend easy.
This option is also used for plotting legends for the zoned colour symbols where a (*.ITR) file
must be specified. A (*.ITR) file is created when the zoned colour symbols are plotted. The
default name is the, "channel-name.itr", e.g. "Au.itr".

Gridding Data
Gridding refers to the process of interpolating data onto an equally spaced “grid” of "cells" or "nodes" in a
specified coordinate system, such as X-Y. In the Surface Mapping component of Target, both Minimum
Curvature and Kriging gridding methods are available.
These two gridding methods (Minimum Curvature and Kriging) are typically used when the data is not
sampled along lines that run in roughly the same direction. Such data are often called random, because
they give a random appearance when the data locations are plotted. Also, line data with survey lines that
are orthogonal (or have random directions) should also be gridded using the Minimum Curvature or
Kriging methods.
The following figure illustrates these types of data:

Surface Gridding using Minimum Curvature
The Minimum Curvature gridding method (RANGRID GX) fits a minimum curvature surface to the data
points. A minimum curvature surface is the smoothest possible surface that will fit the given data values.
To perform minimum curvature gridding, you must supply the Channel to grid, Output grid name and Grid
cell size (optional). In addition, you also have a variety of advanced options, including the ability to:
Specify data limits and clipping
Grid the original data or log of the data (using cut-offs or a data range)
Specify desampling values (for low-pass filtering) and blanking distance (for removing values beyond
a certain distance)
Specify the tolerance to which the minimum curvature surface must match the data points. The
default is 1.0% of the Z range of the data. Also specify the percentage of points that must meet the
tolerance for the iterations for the current processing step to stop
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Specify the maximum number of iterations to allow
Adjust the tension to produce a true minimum curvature grid or to increase the tension to reduce
overshooting problems in areas where data coverage is sparse
The Minimum curvature gridding algorithm generates a grid file (*.grd) and grid report file (*.log).
To Grid using the Minimum Curvature Method

1. Make sure your database file is open and selected in the project.
2. On the Surface Mapping menu, select Gridding and then select Minimum Curvature.
The Minimum Curvature Gridding dialog will appear.

3. Select the Channel to grid from the dropdown list.
4. Specify the Name of new grid file.
5. Specify the Grid cell size. This should normally be ½ to ¼ the nominal sample interval. If not
specified, the data points are assumed to be evenly distributed and the default cell size will be. ¼*
(sqrt (grid area / #data points)).
For more information on the Advanced gridding parameters, click the Help button.
7. Click the OK button. The system processes the data and displays the grid in a “map” window and
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in the Project Explorer window.

Displaying a Grid
There are a number of options for displaying grids; these include displaying single grids, colour-shaded
grids, ternary image grids, two, three and four-grid composites and 3D grids. In this example, we will
display a colour shaded grid.
Grids appear in the Project Explorer under "Grids". Opening a grid opens a view of the grid in its own
internal "map". A grid map view is just like a real map and can accept any graphics that a map can. It can
also be saved as a map, in which case the map will appear in the "Map" section of the Project Explorer.
When displaying grids, you must specify a colour table to use (supplied with the product). You
may want to experiment with different colour tables to see how they affect your image.
To Display a Colour-Shaded Grid on a Map:

1. Open and select your map.
2. On the Surface Mapping menu, select Grid and Image Display and then select Colour-Shaded
Grid.
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The Colour-shaded grid image dialog appears.

3. Select the Grid name.
4. Select the remaining grid display parameters and click the Current Map button to display the
colour-shaded grid on your current map.
Alternatively, you can select the New map button to display the colour-shaded grid to a new map.

Plotting Contours
Contours refer to the lines drawn at specified intervals or multiples of intervals on your map based on a
gridded dataset. After you create a grid, you may want to contour your data and display these contours
on your map. In Target, contouring is specially designed to handle the very large dynamic data ranges
that characterize Earth Science data sets.
For more information on plotting contours, refer to the Adding Contours to Maps Help Topic.
Target provides a Quick Contour option and a Define (or Custom) Contour option. The Quick Contour
option uses intelligent default parameters and the Define (or Custom) Contour option uses user specified
parameters.
In the following example we will use the Quick (automatic) method.
To Create a Quick Contour

1. Select (highlight) your *.map file in your project.
2. On the Surface Mapping menu, select Contour and then select Quick.
The Contour dialog will appear.
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3. Use the dropdown list to select the Grid file you want to derive the contours from.
4. Click the OK button.
5. The contours are drawn on the map.

To define custom contours use the Create a contour plot of a grid dialog, found on the
"Surface Mapping|Contour|Define Contours" menu.
For more information click the Help button on your dialog of interest.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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This How-To Guide introduces you to the basic Geological interpretation and CAD functions available in
Target. The procedures are designed to show you how you can use these tools for drawing a geological
interpretation.
Topics covered in this How-To Guide:
Import Geological data
Display an interpretation map
Create and work with map groups
Zoom for better viewing detail
Drawing lines, poly-lines and polygons
Use colour and polygon colour tools
Create and edit rock code files

Importing Geological Data
A Geosoft database is capable of handling a wide variety of geological parameters ranging from rock
codes, extended text descriptions, alteration types, contact data such as fractures or faults, and other
core log information that is important in your drilling project.
Drilling data from many different sources can be imported into the program, including ASCII/text,
Microsoft Excel, Microsoft Access, ODBC, Acquire and LAS files. The example below shows how to
import ASCII/text format; for more information on these formats, select the appropriate option from the
DH-Import menu and click on the Help button.
To Import Geological Data (from an ASCII/text file):

1. On the DH-Data menu, select Import and then Text file.
The Drill Hole – Ascii Import Wizard dialog appears.

2. Using the Browse button, select the file from your working directory and click the Open button.
The system returns you to the Drill Hole – ASCII Import Wizard dialog and displays the file name
you wish to import.
3. Click the Wizard button to begin the wizard for importing your data into a specific format, or click
the Template button to use an existing database format.

Target Geological Interpretation using CAD Tools
Displaying an Interpretation Map

You can go back and re-import or overwrite your data using these same steps.
You are now ready to begin working with your data. More geological data can always be added
later using the same Import Wizard.

Displaying an Interpretation Map
In this section we will open a previously created map. For more information on creating maps in Target,
see the Target Surface Data Mapping or Drillhole Data Mapping How-To Guides.
In order to edit a map, it must first be available in the Project Explorer.
To Open a Map

1. On the Map menu, select Open map.
The Open Map dialog box appears.

2. Select the map file in your project directory and click Open.
The map appears in the map window.

Map Groups
Map Groups organize map objects for display. You can use the View/Group Manager Tool to display and
edit the views and groups in a map.
View/Group Manager Tool
This tool (see example below) consists of a ‘tree’ structure that contains branches representing the Data
views and the Base views. Under each view, groups are listed according to their layer on the map.
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Each group in a view shows an icon beside its name that identifies the group as either a map vector
object or an aggregate object. Views can either be normal 2D views or 3D views.
The check box controls and indicates visibility of an item.
To select a single item in the tree, click on the item desired. Multiple selections of groups within a view
can be achieved by holding the <Ctrl> key and clicking on the desired items. Changing the selection
during group editing will end group editing without cancelling any current changes.
The effect of a double-click on any item depends on the state of the map. If in shadow cursor mode, the
map will switch to either group or view selection mode and select the item that was clicked upon. If the
map is already in either of these selection modes, a double-click has the same effect as hitting the Edit
button or using the activate shortcut key (default <Enter> key).
The group on the top layer (closest to the front) is listed first, followed by the next layer behind it, followed
by the rest of the layers to the bottom layer at the end of the list. It is possible to control the render order
in the tree by using the Drag-n-Drop technology. The Drag-n-Drop capability enables you to move map
groups up and down within views and also to move views relative to each other.

www.geosoft.com

Target How-To Guide | 107

Target Geological Interpretation using CAD Tools
Map Groups

Rendering Options

Render images
first
Auto-Redraw

Render (draw) the images groups first.

Automatically redraw the map when a change is made to it.
Redraws the map when changes are made to the groups in the View/Group
Manager and the Auto-Redraw option is off.

Redraw

Frozen Scale

Freezes the scale of the currently selected map group, independent of the view
scale of the map. For example, when zooming in the text size in a group will not
grow but remain the same size on the screen.

Visible Scale

Scale range in which the currently selected group will be visible. For example,
individual groups may be made visible only at specific scales. Then, while
zooming, if the map scale is outside the range, the group is not drawn.

The View/Group Manager Tool is a “modeless” dialog, which means it can remain open while you work
on your map. It can be toggled on or off using the “M” hot key and can even be docked on the side of your
screen or at the top with the toolbars.
Other Tool Options

The other Tool options include moving, masking, transparency settings, editing and deleting.
Moveable
Masked to View

Enables the movement of the selected group on the map using the cursor.
Masks the selected view using the mask applied to the view. This option enables
you to apply a mask to selected groups within a view.

Mask to Group
region

Select the extended view mask applied to the view. This option enables you to
save the mask into the map and activate it on specific groups in the view.

Transparency

Enables the Transparency Slider (Transparent - Opaque). Move the slider to the
transparency level wanted for the selected group.

Edit

Click to edit (or activate) the selected item.
Double-click on a group or view in a map or using the activate shortcut
key (default Enter key) to activate the edit mode for that item. The edit
mode depends on the item; group edit mode for vector groups, colour tool
for images and colour symbols and 3D Viewer for 3D views.

Delete

Click to delete the selected View/Group.
If you delete a group my mistake or make any other undesired changes, you can
click the Undo last map change button on the Standard Toolbar or use the
shortcut (default Ctrl-Z) at any time to undo any changes and revert to the
original map.

Creating a New Group
The following procedure demonstrates how to create a new map group.
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To Create a New Group

1. On the Surface Mapping menu, select CAD Tools and then select New Group.
The Create a new empty group in a view dialog appears.

2. From the View drop-down list, select the existing view in which to place the new group.
3. Specify the New group name.
4. Click OK. The new group is created and selected in your current map window and the Map Group
Editing Bar is enabled.
Selecting and Editing Groups
When you create a new group, this group becomes selected and you can edit it. A group is open for
editing whenever you see the Map Group Editing Bar displayed.

Editing Using the View/Group Manager Tool

This tool provides a single dialog that enables you to switch between different groups, change their
properties (moveable, hidden, masked), and change their layering order (move groups to the front or
back).
1. Verify that Map Group Mode is selected.
2. On the Map Tools Bar, select View/Group Manager.
The View/Group Manager Tool is displayed. The currently selected group is highlighted. To switch
to another group, click on the group name so that it becomes highlighted.
3. Click Edit and the group is selected in edit mode on your map and the Map Group Editing Bar is
displayed.
4. When you are done editing the group, right-click and select End Editing from the pop-up menu.

s
You can also edit groups using the Mapping pop-up menu. You may find this method
quicker when you are editing and switching between groups frequently.
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Editing Using the Pop-Up Menu

1. Verify that Map Group Modeis selected.
2. Right-click on the map and select Groups from the pop-up menu.

3. Select the name of the group you would like to select.
4. Right-click on the map again and select Edit this group from the pop-up menu. The group is
selected in edit mode and the Map Group Editing Bar appears.
5. To edit Symbol or Text attributes, right-click again and select Select All from the pop-up menu.
Then right-click again and from the pop-up menu, select to edit the Attribute (Text or Symbol), as
shown below.

6. When you are done editing the group, right-click and select End Editing from the pop-up menu.

Render Images
Check the Render images box to render (draw) the images groups first. This option is useful when you
add an image to your map, and would like to draw this group first.
Hiding and Moving Map Groups
The procedures below demonstrate how to hide and move groups on a map.
To Hide a Group on a Map

When you have many groups on a map, you may not want to display all of them on your final map. The
procedure below shows you how to hide a group on your map.
1. Verify that Map Group Mode is selected and then click View/Group Manager.
The View/Group Manager Tool appears.
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2.
3. In the View/Group Manager Tool, select (highlight) the group you want to hide.
4. Remove the check box from the box directly in front of the icon. The group is hidden.
To display the group, add the check mark back again.
To Move a Group

To move a group around a map with your cursor, you must first select the Movable option for that group.
Once this option is set, you can move the group by selecting it and moving it with the cursor.
1. From the View/Group Manager Tool, select (highlight) the name of the group.
2. Place a check in the Movable box (as shown below).

You can also click Movable from the pop-up menu.
3. Place the cursor anywhere inside the group on the map. The cursor will change into a set of
directional arrows.
4. Click-and-drag the group in the direction you want to move it.
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Masking a Group
Masking a group involves using a polygon or rectangular mask file to make only a specific area of a group
visible. To mask a group, you must first create and apply a mask to a view. You can then use this mask
on specific groups in the view areas of the group outside the mask. The following three procedures show
you the steps to create a mask, apply it to a view, and turn masking on for a group.
To Create a Rectangular PLY File

This procedure demonstrates interactive creation of a Rectangular PLY file. You can also create Polygon
or Geographic PLY files. Please refer to the Application Help files for more information.
1. On the Database Tools menu, select Window Data.
2. Select Create Rectangular PLY file. The Define a rectangular plot mask dialog appears.
3. Click Interactive. The Define rectangle dialog box appears.

4. Click OK to continue.
5. Use the mouse to draw a rectangle on the map . The Define a rectangular plot mask dialog is then
displayed with the coordinates of the rectangle, as shown in the example below.

6. Specify the Output mask file.
7. From the dropdown list select Inclusive or Exclusive. This determines what is visible when the
mask is applied to a group. For example, if you select Inclusive, only features inside the rectangle
mask will be visible.
8. Click New File to save the mask file. The file is saved.
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To Apply a Mask to a View

1. On the Map Tools menu, select Masking.
2. Select Apply View Mask. The Reset view clip region. dialog appears.

3. Browse to the Clip polygon file (*.ply) to apply.
4. From the dropdown list, select the Map view where the clip mask should be applied.
5. Select yes from the Clip all groups dropdown list to force all groups in the view to be clipped.
Otherwise, select no.
6. Click OK. The mask is applied to the view.
To Mask a Group

1. Verify Map Group Mode is selected and select the map.
2. Click View/Group Manager.
3. Select (highlight) the group you want to mask.
4. Place a check mark in the Masked to View box (as shown below).

5. Click Redraw. The map is redrawn to display only the section of the grid inside the mask.
You can also turn Masking on or off by selecting a group in a map. On the Map Tools menu,
select Masking and then select Clear View Mask. The mask will be cleared from the View.
Zoom In for Better Viewing Detail
The Zoom In option enables you to enlarge an area of interest for better viewing detail.
To Use the Zoom In Option
1. Click the Zoom In button (
In from the popup list.

) on the Map Layout Bar, or right click on the map and select Zoom

2. Your cursor will turn into a crosshair (
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). Define a box by clicking the top left and bottom right corners of the area of interest. Then click
once to execute the zoom command.
3. The system zooms into the defined area.

Lines, Poly-Lines and Polygons
You can use the line and the poly-line tools to draw linear features such as dykes and faults. You can
then connect these lines and create shaded polygons to mark different geological or geophysical
anomalies in your project area. This How-To Guide demonstrates several common poly-line and polygon
procedures.
For detailed information on using the Map Group Editing Bar, please refer to the Application Help
files.
Drawing Poly-Lines
The procedure below shows you how to draw poly-lines on your map and how to create polygons from
these lines.
A poly-line can change direction. Use the Draw a Straight Line on Map button to draw a straight
line.
This procedure also shows you how to use the Snap to point and Snap to line tools, which are useful for
ensuring that your lines connect each other without overlapping. The Map Group Editing Bar is used to
create lines, polylines and polygons.

Drawing Poly-Lines to Identify Linear Features

1. Verify Map Group Mode is selected.
2. Right-click the map, and select Groupsfrom the popup menu.

3. Select the group to be edited.
4. Right-click on the map and select Edit This Group from the popup menu. The Map Group Editing
Bar is displayed.
5. On the Map Group Editing Bar, click Draw a Poly-line on Map.
6. Click the cursor on the place you want the line to start, and then move the mouse, clicking
wherever you want to change direction.
7. When you are finished, right-click and select Done from the popup menu. The poly-line appears.
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An example of a poly-line is shown below.

Using Snap to Point and Snap to Line

You can connect poly-lines to create polygons.
1. Click Draw a Poly-Line on Map.
2. Right-click and select Snap to Point or Snap to Line from the popup menu. This determines
whether the new poly-line begins from a location along the existing line or a point on the line.
The cursor will change to a circle with a shaded centre. When you move the cursor over
a point or node along the line, the cursor changes to a target symbol with the shaded
circle indicating the location of the point.
3. Move the cursor and click-and-drag to define the shape of the line. Draw the poly-line(s) as
desired.
4. When complete, right-click and select Done from the pop-up menu.
5. Click Esc to cancel the Snap To mode.
Changing Line Attributes
This procedure shows you how to modify the attributes (thickness, colour and pattern) of lines. An
example is shown below.
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Changing Line Attributes

1. Left-click (select) the line you would like to edit. Sizing handles are displayed around the line,
indicating it is selected.
2. Right-click and select Attributes from the pop-up menu. The Polyline Attributes dialog box
appears.

3. In the Thickness box, you can specify the line thickness in millimetres (0.1 is the default).
4. To change the line colour, click on the Draw Colour box. A colour palette dialog box is displayed
for you to choose a colour.
5. To change the line pattern, make sure there is a check mark in Styled Line check box. Double click
in the Styled Line box to display the Line Attributes dialog box.
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6. From the Pattern Family dropdown list, you can select from a variety of different sets of patterns
for the line.
7. You can also set the Pitch (which is the distance between the symbols or dashes in the line) and
the line Thickness.
8. Click OKwhen you are finished.
9. Check Smooth Line to smooth the rough edges in the poly-line into smooth curves.
10. Click OK to apply the changes to the line or click Cancel to exit the dialog without making any
changes.
Creating Polygons from Lines
After delineating different areas of your map with poly-lines and/or straight lines, you can use these lines
to create polygons. This process will convert all the lines in the current group into polygons. If you have
lines that you do not want converted to polygons either create these lines in a different group or ensure
that the lines are not connected to other lines to create polygons.
To Create Polygons from Lines

1. On the Surface Mapping menu, select CAD Tools and then select Get Polygons from Group.
The Create polygon file from group dialog appears.
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2. From the Select a View\Group dropdown list, select the View or Group to convert to polygons.
3. Specify the Output polygon file.
4. Click OK to create a polygon file from your lines in the selected group.
Creating Polygon Fills

You can create fills for the closed polygons you created above.
1. On the Map Tools menu, select Create Fills for Closed Polylines.
The Create a polygon area group from a line group dialog appears.

2. Use the Line group to process dropdown list to select the group of lines that you want to convert
to polygons.
3. The Use colours or patterns dropdown list has three options for shading polygons: Colours,
Patterns or Both.
4. The Number of units indicates the number of boxes of categories you want to create in the legend.
The default is 10. You can edit these boxes later.
5. Select Yes if you wish to add a legend to the map.
6. Click OK to continue.
7. Specify the legend settings in the Legend dialog, if you are adding a legend.
8. Click OK to create polygons and a legend similar to the map below.
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Editing Polygons and Legend Boxes

You can edit both polygons and their associated legend boxes in the same way.
1. Verify Map Group Mode is selected.
2. Double-click the polygon or box you want to edit. The Polygon Attributes dialog appears.

3. To change the line colour, click the Edge Colour box. A colour palette dialog box is displayed for
you to choose a colour. To turn line colouring off (i.e. make the line invisible) remove the check
mark from the Draw Edge check box.
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4. You can select a line pattern and/or colour using the Styled Edge and Style boxes.
5. To display a polygon fill, check the Fill check box.
6. You can select a Solid Fill colour by selecting the radio button and choosing a colour using the
Colour palette.
7. Select Pattern Fill to display the Pattern Attributes dialog and select a pattern fill and colour.
8. You can also set the Tile Size and Tile Density, which changes the space between the pattern
symbols and the Line Thickness (% of Tile Size), which changes the size of the individual pattern
symbols.
Click Refresh to see what the pattern will look like in the example box.
9. Click OK when you are finished selecting polygon attributes to apply the changes or Cancel to exit
the dialog without making any changes.
Using the Polygon Attributes Tool
Using the Get Polygon Attributes tool (eyedropper) and the Apply Polygon Attributes tool (bucket) on the
Map Group Editing Bar, you can copy fill colours and patterns from one polygon and apply them to
another polygon.
Get Polygon Attributes

The image cursor changes to an eyedropper.

Apply Polygon Attributes

The image cursor changes to a bucket.

To Copy Polygon Attributes from one Polygon to Another

1. Click the Get Colour button on the Map Group Editing Bar. The image cursor will change to an
eyedropper.
2. To get a colour (and pattern) from a polygon, click with the eyedropper on the polygon containing
the colour you want to copy. The cursor will change to a bucket.
3. Click on the polygon to which you want to apply the fill. The polygon now contains the new colour
(and pattern).
Polygon Edit Tools

A Polygon Edit toolbar is provided with Oasis montaj. These tools enable you to edit polygon vertices,
add exclusion regions to polygons, and switch between editing the vertices of main polygons (Islands)
and vertices of the exclusion regions polygons (Holes).
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Edit Vertices
The Edit Vertices option is available on the Map Edit
pop-up menu when you are in Group Edit mode and
have a polygon selected on your current map.
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Polygon Edit Tools

Description
Edits the vertices of a previously created polygon.

Edit Vertices
Adds new vertices to a polygon.
Add Vertices
Deletes vertices from a polygon.
Delete Vertices
Add a new rectangular “Island” to a previously created polygon.
Add New Rectangular
Island
Adds a new polygon “Island” to a previously created polygon.
Add New Polygon Island
Draws a new N-sided polygon “Island” to a previously created polygon.
Add New N-Sided Polygon
Island
Adds a new rectangular “Hole” to a previously created polygon “Island”.
Add New Rectangular
Hole
Adds a new polygon “Hole” to a previously created polygon “Island”.
Add New Polygon Hole
Draws a new N-sided polygon “Hole” to a previously created polygon
“Island”.
Add New N-Sided Polygon
Hole
Cycles (switch) to the previous Hole or Island.
Cycle to Previous Hole/Island
Cycles (switch) to the next Hole or Island.
Cycle to Next Hole/Island
Deletes the current Hole or Island.
Delete Current Hole/Island
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Add/Remove Vertices on a Polygon

Vertices can be added or removed from polygons by using the plus (+) and minus (-) keys on your
Number Keypad.
The plus (+) and minus (-) keys on the main alpha-numeric keypad will not work; you MUST use
the Number Keypad only.
To Access the Edit Polygon Vertices Option

1. Click Map Group Mode.
2. Select the group on your map that includes the polygon you wish to edit.
3. While holding your cursor over your map, right click and select Edit This Group from the pop-up
menu. The group will now be in Edit mode (you will see a box with hatch marks around the group,
this is a visual clue that you are in Edit mode).
4. Select the polygon to edit.
5. Right-click and select Edit Vertices from the pop-up menu. The vertices on your map will change
from grey to white.
To Add Additional Vertices on a Polygon

1. While in Edit mode, select Edit Vertices from the pop-up menu.
2. Place your cursor, between two vertices on the polygon, where you want to place the new vertice
(s).
3. Press and hold the “+” key on your Number Keypad. A plus sign is added to your cursor.
4. While holding down the “+” key, use your mouse to select the location for the new vertice(s).
You can also select Add Vertices from the Polygon Edit Bar. Your cursor will change to a
cross-hair and it will be linked to the polygon lines. Left-click to add new vertices to the
polygon.
To Remove Vertices from a Polygon

1. While in Edit mode, select Edit Vertices from the pop-up menu.
2. Place your cursor on the vertice(s) you want removed.
3. Press and hold the “-” key on your Number Keypad. A vertices selection box and a minus sign are
added to your cursor.
4. While holding down the “-” key, use your mouse to select the vertices to be removed.
You can also select the Delete Vertices button from the Polygon Edit Bar. Your cursor will
change to a vertices selection box with a minus sign added. Left-click to delete vertice(s) from
the polygon.

Creating and Editing Rock Code Files
Rock codes and their associated patterns are usually used with From-To data to display pattern fills on
maps. You can use the editing tool to edit the rock codes in an existing file or to create a new file
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To Create a NewRock Code File:

1. On the DH-Plot menu, select Edit Rock Codes.
The Drill- Hole - Edit Rock Codes dialog appears. Note that the default rock code file "agso.csv"
will be displayed, or the rock code file that was last used in your drillhole project.

You can set the default rock code file at anytime by using the Preferences option on the DHData menu.
2. For the Rock codes list file (*.csv), enter a file name for your new rock code file. This will create a
new rock code file .csv file. You can also open and edit an existing rock code file from this dialog.
3. Click Edit. The Edit Rock Codes dialog appears.
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4. Click Populate from channel.
The select data source dialog appears. This dialog enables you to select a current database
channel from which the rock code file will be automatically updated.

5. From the Channel/Database dropdown list, select your desired channel and click OK.
6. A message window opens indicating that there are new items to import into the rock code file.
Click Yes.
The Edit Rock Codes dialog box is now populated with the codes from your chosen channel within
your From-To database.
To Edit Individual Rock Codes

1. In the Edit Rock Codes dialog click in the Description box beside a rock code to provide a short
description of the rock type.
2. Click in the Pattern box beside a rock code to edit its colour and/or pattern.
The Pattern Attributes dialog appears. You can use this dialog to select the Pattern Family,
Pattern, Colour, Background Colour, Tile Size, Tile Density and Line Thickness.
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3. Select a pattern type via the Pattern Family dropdown menu.
4. Click in the Colour box to change the colour of the pattern.
5. The size and density of the pattern shapes can be set via the Tile Size and Tile Density boxes.
6. The Example pane shows you how your rock code pattern will look as you change the above
parameters.
7. Once you are satisfied with the pattern for the rock code click OK to save it and the system will
return you to the Edit Rock Codes dialog.
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Applying Filters in Target
Filters are usually applied to geophysical data in order to remove noise/errors, remove regional trends
and/or enhance certain geological features. The objective is to select a filter and parameters that do not
introduce additional noise into the data.
1D filters are applied to a channel of data in a database, while 2D filters are applied to gridded data and
are commonly used during image processing.
This How-To Guide walks you through the basic steps for applying a 1D filter to a channel in a database
and a 2D filter to a gridded dataset.

Filter Menus
There are two main Filter menus included with theTarget system . The database filters can be found on
the Database Tools|Filtersmenu, and the grid filters can be found on the Grid and Image|Filters menu, as
shown below.
Database Tools|Filters menu

Grid and Image|Filters menu

Apply a Filter to a Database Channel
Removing spikes or noise from data, while preserving significant or relevant geological features, is the
most common application of Database Filters. The objective is to select the filter and filter parameters
that accomplish this, while not introducing any artifacts into the data.
In this section you will apply the Non Linear Filter which can be used to remove very short wavelength,
high amplitude features from the data.

Applying Filters
Apply a Filter to a Database Channel

Displaying a Profile
After you open a spreadsheet and display one or more channels, you have the option of displaying them
in graphical (profile) form in a Profile window. The Profile window is composed of sub-windows called
panes, which appear directly below its corresponding database. You can display up to five separate
panes with 32 channels of data in each pane.
To Display a Profile

1. Select (highlight) the profile window pane you want to display a profile in. The vertical bar on the
left will be highlighted.
2. Select (highlight) the Channel Header Cell in your database you wish to profile, right-click and from
the popup menu select, Show Profile.
The channel data will be displayed in the profile window, similar to the profile example below.

Displaying a Profile of Different Line
If you have line data, you will probably want to look at multiple lines of your data.
To Display the Profile of Different Line

1. Select (highlight) the Line Header Cell in the top left corner of the spreadsheet.
2. Right-click and select List from the popup menu.

A list of all the line numbers in the current database will be displayed. You can think of each line
number as a worksheet in the Spreadsheet window.
3. Click the line to display. The Profile window now displays the selected line.
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When the Line Header Cell is highlighted, you can use the Database Tools Bar to scroll through
the lines by selecting Previous Line/Group or Next Line/Group. You can also use the Page Up
and Page Down keys on your keyboard to scroll through the lines.
Applying a Non-Linear Spatial Domain Filter
The Non-Linear Spatial Domain Filter is a particularly effective way to remove spikes from magnetic
data, but it can also be effective for removing short wavelength features, such as signal arising from
unwanted near surface geological or cultural features. The non-linear filter is always applied before the
linear filter.
To Apply the Non-Linear Filter

1. From the Database Tools menu, select Filters, then select Non Linear Filter.
The Non-linear Filter dialog box appears.

2. Use the dropdown list to select the Channel to filter.
3. Specify (type) the Output channel name, or select a channel using the dropdown list.
4. Enter a Filter Width. Note that, this is the maximum width of the noise measured in data points.
Features that are wider than this width will not be altered by the filter.
5. Specify the Filter Tolerance. Only noise of greater amplitude than this tolerance value will be
altered.
6. Click the OK button.
Now you can compare the filtered and unfiltered channel profiles.
To View the Profile of the Filtered Channel

1. Right-click in the header cell of the channel containing the filtered data, and select Show Profile.
The filtered profile along with the original data profile will be displayed in the profile window.
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Applying a Filter to a Grid
Grid filters are commonly used to smooth a grid before contouring in order to improve the appearance of
the contours. In this application, 1 to 3 passes are usually sufficient. Another useful application is
filtering to remove regional data trends by producing a curvature grid. To do this, a 3x3 Convolution
(Hanning) filter is passed once over a gridded dataset and the ouput curvature grid is then subtracted
from the original grid. This creates a residual gridded dataset, where the residual is proportional to the
curvature in the original grid, with zero values indicating inflection points. The curvature grid may also be
subsequently filtered to smooth noise.

Applying Grid Filter
In this section you will apply the 3x3 Convolution (Hanning) filter to remove the high frequency
component of your data. You can then subtract this "smoothed" grid from the original grid to create a
residual grid.
To apply a filter to a grid

1. From the Grid and Image menu, select Filters, and then select 3x3 Convolution.
TheGrid Filtersdialog appears.

2. From the Input Grid File list, select your input grid.
3. For the New resultant Grid, enter the name of the new filtered grid.
4. From the OPTION 1 - Select a Predefined Filter list, select Hanning.
5. Click the OK button.
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The new smoothed mag grid opens in a display window.

Applying Grid Math
With the Grid Math Expression Builder, you can create, save, load and apply mathematical expressions
involving one or more grids in your project.
In this section you will create a residual grid by subtracting the filtered grid from your original grid.
To Subtract Grids

1. From the Grid and Image menu, select Grid Math.
The Grid Math Expression Builder dialog appears.
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2. In the Expression box, enter G0= G1– G2.
3. In the Assign grids box, click in the list beside the G0 channel and type the name of the new
residual grid.
A new grid, with this name, will be created when this expression is computed.
4. From the list beside G1, select the original grid.
5. From the list beside G2, select the filtered grid.
6. Click the OK button.
A new residual grid is created and opens in a display window.
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The residual grid represents the high frequency information in the magnetic data, which
represents very shallow geological or cultural features. Note the shape and orientation of
individual features is now evident within the larger areas of anomalous high magnetic intensity.
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Working with Scripts in Target
Scripting refers to the act of creating and running a file that will carry out many operations in a row. If you
perform a task repeatedly in Target, you can automate the task using a script. Geosoft Scripts are ASCII
files (with a *.gs extension) that contain a series of actions or commands that are grouped together in a
single file to accomplish a task automatically. This How-to Guide is intended to provide you with a basic
introduction to Geosoft Scripts in Target.
Some typical uses for scripts include:

Automate complex or repetitive tasks
Create standard map layouts
Run Target functions from the DOS command prompt
Process large amounts of data overnight
Geosoft Scripts work by recording the actions you perform on a dataset. When you run a script, the
commands you recorded are executed on data in a specified project. You can run scripts either
interactively in Target or from the command line using the Oasis montaj Scripts Processor (OMS.exe).
For more information on using Scripts, see the Creating Scripts In Oasis montaj Technical Note,
available online at: www.geosoft.com/resources/technotes/

Batch Processing with Scripts
Target Scripts are ASCII files that define a series of processing actions to be performed on selected
datasets. You can run scripts interactively in Target using the script toolbar buttons or the Scripting
commands found under the GX menu.
To Create a Script File

1. On the GX menu, select Scripting and then select Record Script.
The Create Script File dialog appears

Working with Scripts
Batch Processing with Scripts

2. Specify a File name
3. Click Save.
4. Perform your scripting actions.
5. On the GX menu, click Stop recording.... The system stops recording your actions. All of your
actions were recorded and saved to the specified script *.gs file.
Click the Help button for more information on creating a Script file.
To view a Script

1. On the Edit menu, click Edit a File.
The Edit file... dialog appears.

2. Using the Browse button, select the script file from your project folder.
3. Click OK. The system opens up the file in your default text editor.
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Example

In the example below, we created a script file using the script file record option. This operation writes a
script file (*.GS) by recording each GX that you run during the session until you stop script recording
(from the GX menu). The resulting (*.GS) file contains sufficient parameter and database information to
run the selected GXs in the same sequence. We recorded a script of two different GXs - added a line
path and line profiles to a map.
Below is the recorded script file test.GS.
The two GXs that were recorded are shown beside the GX command: PATH and PROFILE.
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/------------------------------------------------------------------------/ LOG OPENED : Mon Sep 10 15:37:30 2012
/------------------------------------------------------------------------CURRENT Map,"e:\testing\Magnetics.map"
CURRENT Grid,"e:\testing\mag.grd(GRD)"
CURRENT Database,"e:\testing\Mag.gdb"
SETINI PATH.LINE_COLOR="K"
SETINI PATH.LINE_THICKNESS="0.15"
SETINI PATH.TICKFLAG="0"
SETINI PATH.LABEL_FORMAT="TL"
SETINI PATH.LABEL_DIR="0"
SETINI PATH.LABEL_COMPASS="0"
SETINI PATH.LABEL_LOCATION="1"
SETINI PATH.LABEL_SIZE="2.5"
SETINI PATH.LABEL_COLOR="K"
SETINI PATH.LABEL_WEIGHT="0"
SETINI PATH.H_OFFSET="2"
SETINI PATH.V_OFFSET="0"
SETINI PATH.GAP="0"
SETINI PATH.THINRES="0.02"
GX path.gx
CURRENT Map,"e:\testing\Magnetics.map"
CURRENT Grid,"e:\testing\mag.grd(GRD)"
CURRENT Database,"e:\testing\Mag.gdb"
SETINI PROFILE.CHANNEL="mag"
SETINI PROFILE.SCALE="100"
SETINI PROFILE.BASE=""
SETINI PROFILE.LOG="0"
SETINI PROFILE.LOGBASE="1.0"
SETINI PROFILE.SMOOTH="0"
SETINI PROFILE.COLOR="MY"
SETINI PROFILE.THICKNESS="0.15"
SETINI PROFILE.STYLE="0"
SETINI PROFILE.PITCH="5"
SETINI PROFILE.PFILCOL="N"
SETINI PROFILE.NFILCOL="N"
SETINI PROFILE.GAP=""
SETINI PROFILE.JOIN="1"
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SETINI PROFILE.PLOTORDER="1"
GX profile.gx
/------------------------------------------------------------------------/ LOG CLOSED : Mon Sep 10 15:37:46 2012
/-------------------------------------------------------------------------

For more information on using Scripts, see the Creating Scripts In Oasis montaj Technical Note,
available online at: www.geosoft.com/resources/technotes/
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Target Drillhole Projects
The Target Drillhole system has been developed using Geosoft’s unique three-dimensional database
structure. These databases are linked by a common project name that provides easier data
management.
In this How-To Guide, we will guide you through the key steps necessary to start a new Drillhole Project.
We will also demonstrate how to refresh the constituent drill project databases from the original data
sources, export a subset of your current Drillhole Project to a new Drillhole Project, and convert an old
Wholeplot database into a new Drillhole Project databases.

Starting a New Target Drillhole Project
When you start a new Drillhole Project an empty "Collar" database is created and displayed in the project
window. With the Drillhole system, individual ‘data type’ databases are created to enable easier data
management, and are displayed in the Project Explorer. These databases are linked by a common
project name, which appears at the start of the individual database names. For example, separate
databases for collar, survey, assay, and geology are created and linked by project name.
In a Drillhole Project named "Prospect" the following databases could be created:
Prospect_Collar.gdb (collar information)
Prospect_Survey.gdb (hole dip-azimuth survey information)
Prospect_Geology.gdb (geology information – The "Geology" label is user specified)
Prospect_Assays.gdb (assay information - the "Assay" label is user-specified)
When the Drillhole system is used, it scans the open project for all the project databases
currently loaded in the project to see which data is available. If you close one of the project
databases, it will not be visible to the system and will not be used when processing your data.
While working with a Drillhole Project, if you wish to "hide" one of the project databases,
minimize it instead of closing it in order that Target can continue to access it. You can see which
databases are in your project by viewing the list under Databases in the Project Explorer.
Projections can be set during project set-up when the "Specify coordinate system on import?" is enabled
on the Edit|Oasis montaj Settings dialog.

Naming a Drillhole Project
The Drillhole Project name will be added, as a prefix, to all of your project databases (collar, survey,
assay, geology, and other types of related information).
To Name a Drillhole Project

1. On the DH-Data menu, select New Project.
The Drill Hole – New Project dialog is displayed.

Drillhole Projects
Refreshing a Drillhole Project

2. Specify a new Project name.
3. Specify the Maximum holes.
4. You can leave the Maximum data fields to the default value (100) or change it to an appropriate
value.
We recommend that you specify a number that is representative of the final estimated
project size. This strategy ensures that you have enough space available in your project
while not consuming excessive storage space.
5. Click OK. The collar database with the project name is displayed.
Saving your Databases
It is always a good habit to save changes you make to your databases, including new databases.
To Save Drillhole Databases

1. Select (highlight) the database to be saved.
2. On the Database menu select Save Database Changes.
The Save Changes dialog appears.
3. Click the Yes button. The database will be saved in your current working folder.

Refreshing a Drillhole Project
Use the Refresh Project menu item to refresh the constituent Drillhole Project databases from the
original data sources.
This dialog works only with databases that have been created using the wizards for the
ASCII, XLS/Database or ODBC imports on databases created since Target v6.0.
There are two Import modeoptions available for refreshing a Drillhole Project: Overwrite and
Append/Merge.
To Refresh a Drillhole Project

1. On the DH-Data menu, select Refresh Project.
The Refresh Drill Project Data dialog appears.
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2. Specify the Import mode as Overwrite or Append/Merge.
If you select Overwrite and the database existed it is first deleted and the data re-imported
into a newly created database. However, if you select Append/Merge the existing
database is preserved. If the import data contains a hole which did not previously exist in
the database, the hole is added. If data is imported into a hole which already exists in the
database, the following process is followed: If the From-To intervals or Depth values are
identical in the existing and in the imported data, then the different fields/channels are
overwritten in-place. Pre-existing channels which are not imported are preserved.
However, if the from-to or depth values in the imported data do not match the pre-existing
hole data, then the original data is deleted, and the new data is imported into a newly
created database table.
3. Click the OK button. The Drillhole Project databases are refreshed from the original data sources.
For more information on refreshing your Drillhole Project, click the Help button on the Refresh
Drill Project Data dialog.

Subset a Drillhole Project
Use the Subset Project menu item to export a subset Drillhole Project to a new Drillhole Project. The
project can be subset by selecting all holes, selected holes, or holes selected from the two-panel
selection tool.
To Subset a Drillhole Project

1. On the DH-Data menu, select Subset Project.
The Export to a new Drill Project dialog appears.

2. Specify the New project name.The project name cannot contain any underscore characters "_".
Note that, you can use the same project name as the original project, as long as you export to a
different folder.
3. Using the dropdown list you can select the Holes to export as Selected holes, All holes, or Select
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from list.
4. To change the folder for the subset project, click the Directory button.
The Browse For Folder dialog appears.
5. Locate the folder to save the subset project and click the OK button.
The Export to a new Drill Project dialog is again displayed.
6. Click the OK button.
The subset project is exported as a new Drillhole Project.
For more information on sub-setting a Drillhole Project, click the Help button on the Export to a
new Drill project dialog.

Converting an old Wholeplot Database to a Drillhole Project
Use the Convert to Project menu item to convert an old-style Wholeplot Drillhole database into a new
Drillhole Project.
Old-style Wholeplot Drillhole databases contained not only the collar table, but tables for survey, assay
and lithology data. With many holes, this became unwieldy. The new Drillhole Project divides the data
into separate databases, one contains the collar table, one contains the survey information, and there is
one database for each type of assay or lithology (geology) data.
To Convert an old Drillhole Database to a Drillhole Project

1. On the DH-Data menu, select Convert to Project.
The Convert old Wholeplot Database to New Multi-DB Project dialog appears.

2. Using the Old Wholeplot database file drop-down list, select the database to convert. Then,
specify the new project name.
3. Click OK and the Wholeplot database is converted into a new Drillhole Project.
How-To Guide Publication Date: 29/04/2014
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Import Drillhole Data in Target
During drilling, the geologist acquires and integrates data from different sources and formats. The Target
system automatically detects the type of data that is being imported, including:
Drillhole (collar) locations
Surveys
Point Data
From to Data
There are two ways to define drillholes and add data to your project in Target:
Import data already stored in CSV/text or XLS/database data format. A common example is a
geochemical assay file, which is commonly delivered to you on disk or via email by an assay
laboratory in Excel XLS format. Depending on project needs, you may also initially have geological
data, collar data or survey data in text or data files.
Manually enter data. If you are performing a grassroots exploration project, you may only have one or
two holes to work with initially. In this case, you may just want to add some basic collar location or
projected survey information to your project.
This how-to guide will explain the differences between these four types of data, as well as the
procedures for importing already stored data types. For information on entering or editing data, see the
How-to Guide "How to Edit Data in Target" found in our online technical documentation
repository: http://www.geosoft.com/support/downloads/technical-documentation.

Drillhole Data Types
The Target system detects whether your data is drillhole (collar) data, survey, from-to, or point data
based on the way your database is set up. In the following section, we will run through an example of
each kind of data.
Collar Data
Collar information must contain unique Hole ID, Easting (X), Northing (Y), Elevation (Relative Level) and
Total Depth (EOH). The X, Y and Depth must all be in the same units. Note that in the data example
below, the Azimuth and Dip are also included in the collar file.

Import Drillhole Data in Target
Drillhole Data Types

Survey Data
(Optional) Hole deviation information in Hole ID, Depth, Azimuth, Dip format or Hole ID, Depth, Easting,
Northing, Elevation format. Note that a survey file is only required if a hole has actually been surveyed
and the dip and azimuth change at depth.

From - To Data
From-To data is data acquired over specified depth intervals down the hole. For example, at a 1 m
interval with a measurement starting at 0 m and extending to 139 m. From-To data must include the Hole
ID, Depth From, Depth To and some data values.
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Point Data

Point data is data acquired in discrete measurements made at a specific depth, for instance 85.6 m. It
must include the Hole ID, Depth and some data values. In this example, a Geophysical property log
(borehole geophysics) in Single Point data format is shown.

Import using CSV/Text Format Data
The Drillhole system enables the import of data stored in CSV/text data format. The Drill Hole Import
Wizard guides you through the import process, and automatically displays your data in a Spreadsheet
window. The spreadsheet window is similar to Excel in appearance with specialized Earth Science
capabilities, including built-in data manipulation tools.
Importing Collar Data
When entering data in the Drillhole system, you must start with collar data. The system creates a unique
collar database that you can use to view all drillholes in the project at a glance. You can also plot an initial
plan map showing all holes for review purposes. A collar file must exist before survey or assay data can
be imported, and before plans and sections can be created. The Target system enables the import of
data stored in CSV/text or XLS/database data format.
The steps below show how to import collar data in ASCII format.
To Import Collar Data

1. On the DH-Data menu, click Importselect Text File.
The Drill Hole – ASCII Import dialog is displayed

2. Using the Browse button, select the collar data (.csv) file from your working directory.
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The Import Mode enables either a previously created database to be overwritten
(Overwrite) or new and/or updated Drillhole information can be added to a previously
created database (Append/Merge). For more information, click the Help button.
3. Click the Wizard button. The Drill Hole Import Wizard is displayed.

Note that the system will determine your Data Input format as Ascii Data and intuitively
predict the Types of Data to import as Hole Collar Data.
The Target Drill Hole Import Wizard enables you to easily import data from any ASCII
spreadsheet or data file. The Import Wizard supports both Delimited and Fixed Field ASCII
files. The Import Wizard also imports Microsoft Excel Comma Separated Value (CSV),
Comma Delimited, White Space Delimited and Tab Delimited data files. The window at the
bottom of the dialog box shows the file that is being imported. For more information about
the Drill Hole Import Wizard settings click the Helpbutton on the individual Wizard dialogs.
4. Use the horizontal scroll bar to see all of the fields in the file or simply click the Next> button. The
system displays the second dialog box in the Drill Hole Import Wizard.
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5. In the four fields in the middle of the dialog box, specify which line in the file contains the data
headings (i.e. channel names), data units (“m” or “ft” etc.), which line to begin importing data and
the number of lines to display in the preview window.
6. Click the Next> button. The system displays the third dialog box in the Drill Hole Import Wizard.
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7. Specify the Column delimiters as Microsoft Excel CSV for the type of character used to separate
the column text.
8. Click the Next> button to continue. The system displays the fourth and final dialog box in the Drill
Hole Import Wizard.
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9. The Import Wizard has scanned your data and determined the type of data with which you are
working (i.e. Channel Type). It is always good practice to review your data to ensure that the
wizard has selected the correct columns. The Parameters area in the dialog box shows the name
and type of data of the column highlighted in the preview window.
In the Parameters section, the Data Type for channels that contain alphanumeric data (for
example, sample numbers, rock codes etc.) must be classified as String.
10. Click the Finish button. The system imports the collar data and displays it in the spreadsheet
window.

Importing Survey Data

Various types of surveys (acid, gyroscope, magnetic orientation, etc.) can be used to record hole depth
(depth measured from the drillhole collar at the surface). For Target, you can use survey data in one of
two forms:
Hole

Depth

Azimuth

Dip

Hole

Depth

Easting

Northing

Elevation

Before importing data, you must make sure that you have all fields as shown in one of these
configurations (i.e. these fields are required on import).
By convention:
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Depth is the distance measured into the hole from the collar, increasing from zero.
Azimuth is in degrees, increasing positively in a clockwise sense from North (i.e. N is 0 degrees, E is
90 degrees).
Depth, Easting, Northing and Elevation are in the same units as default units set in the Oasis montaj
Default settings dialog (GX|Global Settings|General).
To Import Survey Data:

1. On the DH-Data menu select Import, and then select the Text file.
The Drill Hole – ASCII Import dialog is displayed.

2. Using the Browse button, select the survey data file from your working directory and click the
Wizard button.
The system scans the file and displays the first of four dialog boxes from the Drill Hole Import
Wizard.

3. Select the Data Import Format as well as the Types of Data to import, if your data hasn't defaulted
to the right selection.
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4. Click the Next> button to display the second Drill Hole Import Wizard dialog.

5. Select the File Type and fill in the row properties. You can view the rest of your data in the preview
window if desired.
6. Click the Next> button to display the third Drill Hole Import Wizard dialog.
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7. Select the type of character or white space used to separate the column text.
8. Click the Next> button to display the final Drill Hole Import Wizard dialog.
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9. Select the Channel Type and Parameters for each of the channels you would like to edit. You may
switch the channel you are editing by clicking on it in the preview window.
10. Click the Finish button. The system imports the data and displays it in the spreadsheet window.

Import using XLS/Database Format Data
Target provides the capability to read directly from common database formats. The Drill Hole Import
Wizard guides you through the import process, and automatically displays your data in a Spreadsheet
window. The spreadsheet window is similar to Excel in appearance with specialized Earth Science
capabilities, including built-in data manipulation tools.
The following lists the typical ODBC drivers that come installed with a Microsoft Windows system:
Microsoft Access Driver (*.mdb)
Microsoft Excel Driver (*.xls)
Microsoft dBase Driver (*.dbf)
Microsoft Paradox Driver (*.db)
Microsoft FoxPro VFP Driver (*.dbf)
Microsoft Visual FoxPro Driver
Importing From - To Data
From-To data is data acquired over specified depth intervals down the hole. For example, at a 1 m
interval with a measurement starting at 0 m and extending to 139 m. Two examples of From - To data
are; geochemical assay data and geological rock codes.
To Import From – To Data:

1. On the DH-Data menu, click Import, and then click XLS|Database.
The Drill Hole – Import External Database dialog is displayed.
2. Using the Browse button, select the file from your working directory and click the Open button.
The system returns you to the Drill Hole – Import External Database dialog box and displays the
file name you wish to import.
3. The system scans the file and displays the first of three Drill Hole Import Wizard dialog boxes.
Note that the system has determined that the Types of Data to import are From-To Data.
4. Click the Next> button to display the second dialog box in the Drill Hole Import Wizard.
5. The Import Wizard has scanned your data and determined the Channel Type for each of the
Database Fields. It is always good practice to review your data to ensure that the wizard has
selected the correct columns.
When importing Assay data all elements are assigned the Class ‘Assay’ (Channel Type).
Standards and Duplicates are also identified, enabling Geochemistry users to extract the
information using the normal Geochemistry tools.
6. Click the Next> button to display the third dialog box in the Drill Hole Import Wizard.
7. The purpose of this dialog box is to enable you to specify a unique name or description for your
data. The name chosen will be appended to the corresponding holes in the database for easier
access and recognition of your data.
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8. Specify a Data Name for this data and click the Finish button. The system imports the assay data
and displays it in the spreadsheet window.
Importing Point Data
Point data is data acquired in discrete measurements made at a specific depth, for instance 85.6 m.
To Import Point Data:
1. On the DH-Data menu click Import, and then click XLS|Database. The Drill Hole – ImportExternal
Database dialog is displayed.
2. Using the Browse button, select the file from your working directory and click the Open button.
The system returns you to the Drill Hole – Import External Database dialog box and displays the
file name you wish to import.
3. Click the OK button. The system scans the file and displays the first of three Drill Hole Import
Wizard dialog boxes. Specify that the Types of Data to import as Point Data.
4. Click the Next> button to display the second dialog box in the Drill Hole Import Wizard.
5. The Import Wizard has scanned your data and determined the Channel Type for each of the
Database Fields. It is always good practice to review your data to ensure that the wizard has
selected the correct columns.
When importing Assay data all elements are assigned the Class ‘Assay’ (Channel Type).
Standards and Duplicates are also identified, enabling Geochemistry users to extract the
information using the normal Geochemistry tools.
6. Click the Next> button to display the third dialog box in the Drill Hole Import Wizard.
7. The purpose of this dialog box is to enable you to specify a unique name or description for your
data. The name chosen will be appended to the corresponding holes in the database for easier
access and recognition of your data.
8. Specify a Data Name for this data and click the Finish button. The system imports the assay data
and displays it in the spreadsheet window.

Importing Geochemistry Drillhole Data
Geochemical assay data are typically acquired by obtaining core or rotary drill samples over specific
depth ranges (From-To ranges) and sending samples to an assay laboratory. Numerical results are
typically returned from the laboratory in electronic format and can be imported quickly into the system.
Before import, you must make sure that your data files contain the following information – HOLE ID,
FROM, TO and a series of ASSAY results.
To Import Geochemical Data

1. On the DH-Data menu, click Import and then select Text File.
The Drill Hole – Ascii Import Wizard dialog is displayed

155 | Target How-To Guide

www.geosoft.com

Import Drillhole Data in Target
Importing Geochemistry Drillhole Data

2.
3. Using the Browse button, select the geochemical assay file from your working directory.
4. Click the Open button. The system returns you to the Drill Hole – ASCII Import Wizard dialog box
and displays the file name you wish to import.
5. Click the OK button. The system scans the file and displays the first of five dialog boxes from the
Drill Hole Import Wizard. Here the system has determined that the Data Input Format is ASCII
Data. The Types of Data to import should default to From-To Data, based on the information you
have provided.

6. Click the Next> button. The system displays the second dialog box in the Drill Hole Import
Wizard.
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7. In the four fields in the middle of the dialog box specify which line in the file contains the data
headings (i.e. channel names), data units (“m” or “ft” etc.), which line to begin importing data and
the number of lines to display in the preview window.
When importing Assay data all elements are assigned the Class ‘ASSAY’ (Channel Type).
Standards and Duplicates are also identified, enabling montaj Geochemistry users to
extract the information using the normal Geochemistry tools.
8. Click the Next> button. The system displays the third dialog box in the Drill Hole Import Wizard.
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9. Specify the Column delimiters for the type of character used to separate the column text.
10. Click the Next> button. The system displays the fourth dialog box in the Drill Hole Import Wizard.
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11. Highlight a channel by clicking on it and specify the Channel Type and Parameters for each
channel you would like to edit.
12. Before the import is complete, the system displays a fifth dialog box. The purpose of this dialog
box is to enable you to specify a unique name or description for your data. The name chosen will
be appended to the corresponding holes in the database for easier access and recognition of your
data.

13. Specify a Data Name for this data (e.g. Assay) and click the Finish button. The system imports
your data and displays it in the spreadsheet window.
At this point, the Geochemistry extension tools can be used for users with this license.
Refer to the Help for more information.

Creating a Composite Database
The Drillhole system provides the ability to create a composite database from an input From-To assay
database. The composite database will include all the selected holes from the input database and the
From, To, Mask channels and all the assay channels from the input database.
The From and To channel data values are determined by the interval method and values selected. The
Mask channel data values in the output database are set to 1. All assay channel data are composite
values determined by the composite From/To data and the input assay channel data as well as any
reject options applied
The composite method ensures that the integrated value in the output database matches the integrated
value over the equivalent interval in the input database (apart from those cases where a weighting
channel is used).
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To Create a Composite Database

1. On the DH-Data menu, click Composite Database.
The Drill Hole Composite Databasedialog is displayed.

2. Using the Input assay database dropdown list, select the input "assay" database and continue
specifying or selecting the dialog parameters that best suits your data. Click the Next> button to
move to the next dialog.
3. Click the Finish button to create the composite From-To assay database. For more information on
the Drillhole Composite Database dialog parameters click the Help button.

GIS Import
The Target system also includes a wide range of GIS import formats as shown on the Surface Mapping |
GIS Import menu below:

For detailed information on these GIS Import formats, click the Help button on the individual
dialogs.

Save a Database
It is always a good habit to save changes you make to your databases, including new databases.
To Save your Databases

1. Select (highlight) the database to be saved, and click the Save Database Changes button on the
main Standard Bar.
The database will be saved in your current working folder.
How-To Guide Publication Date: 29/04/2014
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The Target system is intended to streamline geochemical quality control by providing a single
environment for quickly calculating summary statistics and manipulating data values.
The Target Drillhole system performs a small number of vital Quality Control and Quality Assurance
(QA/QC) tests when importing your data. These tests include anything that will impact the whole project,
for example duplicated Hole IDs. An Import.log will be displayed after importing if such problems are
found.
Target also provides the tools to enable you to perform detailed QA/QC tests on each of the five different
data types (Collar Data, Dip/Azimuth Survey, Easting-Northing Survey, From-To Data, and Point Data).
The Drill Hole - QAQC tools dialog asks you to select the type of data to perform the QA/QC tests on.
For each data type there are different sets of options you can enable/disable using the Options button.
Each test produces its own log file; e.g. Collars (Collars.log), From-To (FromToData.Log), All data
(QAQC.log). If no problems are found you receive a message such as: "No problems were detected with
the Dip-Azimuth Survey data."
To Run the QA/QC test:

1. On the DH-Data menu click QA/QC.
The Drill Hole - QAQC tools dialog is displayed.

2. From the Data Type to QAQC dropdown list, select All Data to run the tests on all the data in your
current project.
For more information on the QA/QC tests, click the Help button on the Drill Hole - QAQC
tools dialog.
3. Using the Hole selection dropdown list, select to run the QA/QA tests on the Selected holes, All
holes or to Select holes from list.
4. Click the OK button to run the test. If no errors are found the Drill hole QA/QC dialog will be
displayed telling you that no problems were detected.

Target Quality Control and Quality Assurance
Verifying Selected Drillholes

5. Otherwise a log will open listing the errors from each data type, as shown below.

If you run this test on a data type that you do not have in your current project you will be
prompted with the Drillhole QA/QC dialog telling you that no data of this type exists in the
project.

Verifying Selected Drillholes
You might want to have only a select group of drillholes to run QA/QC tests on. There are a variety of
methods available in the Target system to determine the holes selected. The Hole Selection Tool is one
such method, found under the DH-Plot|Select Holes menu. For an explanation about the remaining
methods, read the How-to Guide "Target Drillhole Mapping" found on the Geosoft web site
(http://www.geosoft.com).
To Verify selected Drillholes with the Hole Selection Tool:

1. On the DH-Plot menu, select Select holes and then select the Selection Tool.
The Hole Selection Tool is displayed.
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2. Using this tool you can verify that the holes from the correct location have been selected.
3. If additional holes need to be added or removed there are a number of methods for doing so using
the Hole Selection Tool.
For more information, click the Help button on the Hole Selection Tool dialog.

Setting QA/QC Options
The Target system provides the tools enabling you to perform Quality Control and Quality Assurance
tests on each of the five different data types (Collar Data, Dip/Azimuth Survey, Easting-Northing
Survey, From-To Data, and Point Data).
The Drill hole - QAQC tools dialog asks you to select the type of data to perform the QA/QC tests on. For
each type there are a different set of options you can enable/disable using the Options button. All are
enabled by default except the hole curvature test. This parameter requires you to specify a value for the
curvature -- if it is set it to 0 or left blank the test doesn't run. The system saves the settings to the
Advanced Settings file (GX|Global Settings|Advanced).
Each test produces its own log file; e.g. Collars (Collars.log), From-To (FromToData.Log), All data
(QAQC.log). If no problems are found you receive a message such as: "No problems were detected with
the Dip-Azimuth Survey data."
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The following sections detail the QA/QC options available for each data type:
QA/QC - Collar data options
QA/QC - Dip-azimuth survey options
QA/QC - East-North survey options
QA/QC - From-To data options
QA/QC - Point data options
To Set QA/QC Options

1. On the DH-Data menu, select QA/QC.
The Drill Hole-QAQC tools dialog appears.
2. Use the Data Type to QAQC dropdown list to select the data type you want to perform the QA/QC
test on.
3. To access the list of options that the selected data type will use for testing, click the Options
button.
The QA/QC- * data options dialog will be displayed. Depending on your selected data type, you will
be presented with a list of QA/QC options.
4. Use the dropdown lists to select whether to perform that specific test on your data or not.
5. Once you have made any necessary modifications to your test options, click the <Back button to
return to the Drill hole - QAQC tools dialog.
6. Click OK to run the QA/QC test. Your results will be presented in your current project.
Collar Data Options
The following table lists the options for the "Collar" data type.
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Option

Description

Dummy East,
North or RL

Values of East, North or RL that are dummy values are flagged.

Duplicated
Locations

Duplicated collar locations are flagged. Though multiple holes can
be drilled from the same collar, this may indicate a data entry error.

Reversed
Easting/Northing

A simple test is performed on each collar location: The area covered
by all the collars if each hole location (one at a time) is specified with
Easting and Northings reversed is compared to the original area.
This test succeeds because reversing the two values generally
produces a location far away from the rest of the collars, and the
total area covered by all the holes changes markedly. This test can
break down if more than a single collar’s Eastings and Northings are
reversed.

Dip out of range
–90 to 90

Dips outside this range (which are not dummies) are flagged. On
import, dummy dips are set to 90 or –90, depending on the defined
dip sign convention.

Azimuth out of
range -360 to 360

Azimuths outside this range (which are not dummies) are flagged.
On import, dummy azimuth values are set to 0.

Dip sign
discrepancy

If a dip value has the opposite sign of the current dip convention, it is
flagged. This would indicate a hole heading back to the surface.

Top of hole
depth less than 0

While the collar may be located at a distance down the hole from the
original "Top" value, it cannot be located before the start of the hole
itself.
This error is reported just once per hole in any single database.

Hole depth less
than 0

The hole depth should be greater than or equal to 0. Hole depths in
the range 0 to 1.0 are reset to 1.0 on import so that the start of the
hole will plot on maps.
This error is reported just once per hole in any single database.

Hole depth less
than top of hole

The total depth of the hole must exceed the location of the start of
the hole.

Dip-Azimuth Survey Options
The following table lists the options for the "Dip-azimuth survey" data type.
All are enabled by default except the hole curvature test. This parameter requires you to specify a
value for the curvature -- if it is set it to 0 or left blank the test doesn't run.
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Option

Description

Dummy
Depth

Values of depth that are dummy values are flagged.

Depth less
than hole
top

Values of depth less than the defined hole top depth are flagged.

Depth
greater than
hole bottom

Values of depth greater than the defined hole bottom depth are flagged.
The hole bottom depth is automatically reset to the maximum hole depth
defined in the survey.

This error is reported just once per hole in any single database.

This error is reported just once per hole in any single database.

Duplicated
Depths

Duplicated depth values are flagged. Only one dip-azimuth value can be
defined at a single depth.

Out-ofsequence
Depths

Depths that decrease from the previous value are flagged. Depths should
increase. Out-of-sequence depths may indicate an error in the depth
values. In practice, depths are sorted before the hole is re-surveyed.

Dummy Dip
or Azimuth

Flags dip or azimuth values which are undefined. The last dip and azimuth
for a hole may be left undefined (dummy).

Dip out of
range –90
to 90

Dips outside this range (which are not dummies) are flagged. On import,
dummy dips are set to 90 or –90, depending on the defined dip sign
convention.

Azimuth
out of range
-360 to 360

Azimuths outside this range (which are not dummies) are flagged. On
import, dummy azimuth values are set to 0.

Dip sign
discrepancy

If a dip value has the opposite sign of the current dip convention, it is
flagged. This would indicate a hole heading back to the surface.

Max
curvature degrees per
meter (or
feet)

One indication of erroneous depth, dip or azimuth values is the "creation"
of a hole that bends crazily at a certain location. Curvature is the
mathematical description of how fast the borehole bends. If this value is left
blank, or zero, no check is performed. A maximum of 10 degrees per meter
means that it would be okay if the hole could be formed into a circle with a
circumference of 36 meters.

East-North survey options
The following table lists the options for the "East-North survey" data type.
All are enabled by default except the hole curvature test. This parameter requires you to specify a
value for the curvature -- if it is set it to 0 or left blank the test doesn't run.
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Option

Description

Dummy East,
North or RL

Values of East, North or RL that are dummy values are flagged.

Duplicated
Locations

Duplicated depth values are flagged. Only one dip-azimuth value
can be defined at a single depth.

Reversed
Easting/Northing

A simple test is performed on each surveyed location: The horizontal
(East-North) distance between successive hole locations is
measured, then compared with the distance if the East and North
values in the second location are reversed. This test succeeds
because reversing the two values generally produces a location far
away from the rest of the points, but has the opposite effect if the
values were reversed to begin with. This test can break down if more
than a single location’s Eastings and Northings are reversed.

Broken trend in
RL

Generally a descending hole continues to descend and an
ascending hole continues to ascend. This test flags locations where
the change in successive RL changes sign. This can occur
legitimately when a hole passes through the horizontal, but normally
occurs due to an error in the RL value.

Max curvature degrees per
meter (or feet)

One indication of erroneous east, north or RL h values is the
"creation" of a hole that bends crazily at a certain location. Curvature
is the mathematical description of how fast the borehole bends. If this
value is left blank, or zero, no check is performed. A maximum of 10
degrees per meter means that it would be okay if the hole could be
formed into a circle with a circumference of 36 meters.

From-To data options
The following table lists the options for the "From-To data" data type.
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Option

Description

Dummy
From or To

Values of depth that are dummy values are flagged.

From
greater than
To

Intervals are flagged if the "From" value is greater than the "To" value.
Intervals cannot have negative thickness.

From
equals To

Intervals are flagged if the "From" value is equal the "To" value. Some
"Point" data sets are represented as From-To data sets with the From and
To values equal, so this test is not always desired.

From or To
less than
hole top

No data can be plotted above the top of the surveyed hole. In practice,
intervals are truncated to the top of the surveyed hole depth. This error is
reported just once per hole in any single database.

From or To
greater than
hole bottom

No data can be plotted beyond the surveyed hole depth. In practice,
intervals are truncated to the surveyed hole depth. This error is reported
just once per hole in any single database.

Duplicated
From-To
intervals

Only a single data definition can exist for any given From-To interval, so
duplicates will be ignored when plotting.

Out-ofsequence
Depths

Depths that decrease from the previous value are flagged. Depths should
increase. Out-of-sequence intervals may indicate an error in the depth
values. In practice, intervals are sorted before plotting.

Overlapping
intervals

Intervals are flagged if they overlap with the previous interval. The "From"
of the second interval must be greater than or equal the "To" of the
previous interval.

Missing
intervals

Intervals where the "From" value is greater than the previous interval’s "To"
value are flagged. In practice, this situation is often valid. Its presence in
data that is supposed to be "complete" in depth may indicate an error in
one of the "From" or "To" values.

Duplicated
sample
numbers

In some data sets, such as geochemical data, each measurement is
identified with a unique sample number or code. This test looks for
duplicated sample numbers (codes).

Point data options
The following table lists the options for the "Point data" data type.
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Option

Description

Dummy
Depth

Values of depth that are dummy values are flagged.

Depth less
than hole
top

No data can be plotted above the top of the surveyed hole. In practice,
intervals are truncated to the top of the surveyed hole depth. This error is
reported just once per hole in any single database.

Depth
greater
than hole
bottom

No data can be plotted beyond the surveyed hole depth. In practice,
intervals are truncated to the surveyed hole depth. This error is reported just
once per hole in any single database.

Duplicated
Depths

Only a single data definition can exist for any given depth, so duplicates will
be ignored when plotting.

Out-ofsequence
Depths

Depths that decrease from the previous value are flagged. Depths should
increase. Out-of-sequence depths may indicate an error in the depth
values. In practice, data are sorted by depth before plotting.

Duplicated
sample
numbers

In some data sets, such as geochemical data, each measurement is
identified with a unique sample number or code. This test looks for
duplicated sample numbers (codes).
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Editing Drillhole Databases in Target
The purpose of this How-To Guide is to provide you with a general overview of how to edit drillhole
databases. Drillhole databases, like all Geosoft databases, can be edited both manually and
interactively. The following procedures will guide you through the basic drillhole database editing
functions. For more information see the application Help.

Creating New Channels
You can create new channels in your database to store the results of filters, mathematical expressions,
or any other processing operations. We recommend that you create a new channel for storing any
changes you make to the original imported data.
To Create a New Channel

1. Move to the top of the next empty column and highlight the channel header cell using a single click
of your left mouse button.
2. Type in the name of the new channel and press the Enter key on your keyboard. The Create
Channel dialog appears. Note that, you can also select the channel header cell, right-click and
from the popup menu select New, to display the Create Channel dialog.

3. The Name of your channel should be displayed. If required, fill in the other information, such as

Editing Drillhole Databases in Target
Adding New Drillhole

channel Class, Units, and Display Format.
4. Click the OK button and the system creates a new channel in the database and fills this channel
with dummy values.
To Work in the New Channel

1. On the Database Tools menu, select Channel Tools and then select Copy Channel.
The system displays the Copy a channel dialog.

2. Using the Copy FROM dropdown list, select a channel you want to copy from, and using the TO
dropdown list, select your new channel. Leaving the remaining parameters to the intelligent default
values.
3. Click the OKbutton. The system copies values from the picked channel into the your newly
created channel.

Adding New Drillhole
With the New Drill Hole tool you can both manually and interactively add new drillholes to your project.
There are a number of different ways of defining a new drill hole:
based on the collar and end-of-hole locations
based on setting a target location to be intersected from a given dip and azimuth
based on the collar location, dip and azimuth
Adding a New Drillhole:

1. On the DH-Data menu, click New Drill Hole.
The New Drill Hole dialog is displayed.
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2. Fill in the required fields and click OK to add the drillhole to your project database.
Click Interactive to interactively select a drillhole on your map by drawing a line to it. The
Colour Coordinates and End of Hole Coordinates fields will be automatically generated.

Editing a Drillhole
The Target system enables you to manually edit current drillhole collar information and save the changes
to your project database. By using this editing tool, any edits you make to a drillhole will be reflected in all
the databases.
To Edit a Drillhole:

1. On the DH-Data menu, click Edit Drill Hole.
The Edit Drill Hole dialog is displayed.
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2. Using the Drill Hole name dropdown list, select the drillhole to edit.
3. Make the changes to the drillhole information as required and click the OK button to add the
information to your drillhole project databases.

Deleting a Drillhole
The Drillhole system enables you to delete a drillhole from your project collar database. To delete holes
and tables of holes that do not appear in the collar database, use the Remove unregistered holes menu
item.
This tool deletes not only the hole in the database, but any tables associated with the selected
hole(s) in the survey and assay databases.
To Delete a Drillhole from the Collar Database

1. On the DH-Data menu, click Delete Drillhole.
The Delete Hole(s) dialog is displayed.
2. Using the Drill Hole or Mask dropdown list, select the drillhole to delete, and click the OK button.
The drillhole will be removed from your collar and associated databases.
Masks can use the "*" or "?" wildcards, where "*" can substitute for any number of characters,
and "?" substitutes for a single character. For example, "AC*" will delete all holes beginning with
the letters "AC".

Refresh Extents
The Drillhole system provides the ability to refresh all drillhole extents. This is useful after you have
edited or added new drillholes to your project.
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To Refresh Data Extents

1. On the DH-Data menu, click Refresh Extents. All data extents are recomputed and updated in the
Collar database.

Refresh XYZ
The Drillhole system provides the ability to re-compute and display all XYZ locations for Survey and
Assay databases. This is useful after you have edited or added new drillholes to your project.
To Refresh XYZ Data

1. On the DH-Data menu, click Refresh XYZ.
All XYZ locations are recomputed for your Survey and Assay databases.

Removing Unregistered Drillholes
The Drillhole system enables you to delete holes not registered in the collar database. This may be
necessary when the user deletes rows in the collar table directly, and so tables for the deleted holes may
remain in the survey or assay databases. To delete holes that are registered in the collar database, use
the Delete drillholes menu item.
To Remove Unregistered Drillholes

1. On the DH-Data menu, click Remove unregistered holes.
All holes and tables of holes that do not appear in the collar table will be removed.

Masking Data by Code
The Drillhole system provides the ability to create or update a mask channel based on values matched
from any other channel. If a mask channel is enabled, only those data values whose corresponding mask
channel value is not a dummy will be plotted or exported.
To Mask Data by Code:

1. On the DH-Plot menu, click Select data by code.
The Set Mask using code dialog is displayed.
2. Using the Data channel dropdown list, select the data channel (column) to mask. Then, by using
the Mask channel dropdown list select a mask channel or type the name of a new mask channel.
3. Using the Append/New and the Hole selection dropdown lists, select the appropriate values.
4. Click the OK button.
The Select Codes dialog will appear.
5. In the Code box, select the "number" or "text string" to match.
6. Click the OK button to mask the data channel based on the code.

Masking Data by Range
The Drillhole system provides the ability to set the mask channel depending on whether values in a
specified channel are within a specified range. If a mask channel is enabled, only those data values
whose corresponding mask channel value is not a dummy will be plotted or exported.
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To Mask Data by Range

1. On the DH-Plot menu, click Select Data by Range.
The Set Mask based on data range dialog is displayed.

2. Using the Data channel drop-down list, select the data channel (column) to mask.
3. Then, by using the Mask channel drop-down list select a mask channel or type the name of a new
mask channel.
4. In the Minimum value and Maximum value boxes, specify the data channel values.
5. The Mask, Minimum type and Maximum type boxes enable you to select if you are masking inside
or outside the mask range, and select if the data ranges are inclusive or exclusive regarding the
first and last values.
For more information, click the Help button on the dialog.
6. Use the Hole selection drop-down list to select all holes or selected holes.
7. Click the OK button to mask the data channel based on the data range.

Calculating and Saving Statistics
The Target system quickly calculates and displays statistical analysis of your ASSAY channels. The
system also enables the export of the ASSAY channel statistics to a txt file. The txt file is saved to your
current project directory.
To Calculate and Save Statistics
1. Open and select your database.
2. Click twice on the channel header cell to highlight the data in the current line and then right-click.
Clicking three times on the channel header cell highlights the data in all of the selected lines
(groups) in the database.
3. From the pop-up menu select Statistics.
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The Stats Report dialog is displayed.

Key fields you should examine carefully include the number of items and the number of dummies.
The following table describes the summary statistical values that are reported.
Channel

Name of the channel.

Line(s)

Name of the Line(s) reported.

Fid Range

Range of fiducial values.

Num of items

Number of “non-dummy” items in the channel.

Num of dummies

Number of blank items. Dummies are ignored in the calculation.

Minimum

Minimum value in the channel.

Maximum

Maximum value in the channel.

Mean

Arithmetic mean or average value. This is equal to the sum of all values
divided by the number of items.

Standard deviation

Standard deviation in the data. This is equal to the square root of the
variance in the data, and is an estimator for the “width” of the data.

Arithmetic sum

The sum of all of the values in the channel.

4. To save the statistics, click the Save Stats button.
The Save Stats dialog is displayed.
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5. Specify a New statistics file name and click the OK button. The statistics file will be saved in your
project directory and the Stats Report dialog will again be displayed.
6. Click the OK button to continue.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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The Target system enables you to create a new blank map to fit a defined data range. The data range
can be entered manually, or it can be determined from the range of selected data in a database or from a
grid. The Target system includes several options for selecting holes to include on a map. The methods
included in this how-to guide include:
Selecting/deselecting all drillholes
Selecting holes from a list
Selecting holes by name
Selecting holes using the Hole Selection Tool
This how-to guide also walks you through creating several types of maps. The map creation topics in this
guide include:
Creating a new map
Creating a base map
Creating a plan map
Creating section and stacked section plots

Selecting Holes
A key requirement for the geologists and geochemists that are evaluating and presenting drillhole data is
the ability to select various combinations of drillholes for optimal visualization and plotting. Selecting
holes is also necessary for querying and creating data, as one may need to interpolate across holes to fix
how their data is displayed. The Target system provides a comprehensive set of options for performing
this task. The basic methods of hole selections are listed below.
Selecting (or Deselecting) All Holes: Enables quick development of master plan maps or resetting
of drillholes prior to making new selections.
Selecting Holes by Name or Name Mask: Enables batch selection of multiple holes with
systematic drillhole identifiers. Requires a standard drillhole naming scheme for identifying related
holes. For information on Name mask parameters, click the Help button on the Select holes by name
dialog.
Selecting Holes by List: Enables custom selection of single or multiple holes via a list of all the
holes in the database. Requires pre-existing knowledge of holes.
Selecting Holes by Plan map: Enables rapid visual selection of single or multiple holes by using a
polygon defining tool to select holes along regular or irregular sections, on a plan map. Useful for quick
evaluation of project data.
Select Holes by Collar table data: Enables custom selection of holes based on values from a
channel in the collar table channel. Once a channel from the collar table has been selected, the twopanel selection tool is displayed with all the available items which can be selected. Select one or
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more, and then all holes with corresponding matching values will be selected.
Select Holes by Polygon File: Enables the selection of holes based on a polygon (PLY) file. This is
useful for claims boundaries, etc.
Select Holes by the Selection Tool: Enables interactive selection of single or multiple holes by
area. The Hole Selection Tool includes a plan view of the drill survey area as well as display and
selection tools.
In addition, the system also enables you to save and load your selections.
Save and/or Load Selections: Enables you to save the current hole selections, or load previous hole
selections from a selection file (*.sel).
Selecting/Deselecting All Drillholes
There are a number of methods available in the Drillhole system to select drillholes. If you want to work
with all the drillholes in your database, or would like to deselect them all, follow the steps below.
To Select All Drillholes

1. On the DH-Plot menu, click Select Holes and then select Select all Holes.
All the drillholes in your drillhole project will be selected.
To Deselect All Drillholes

1. On the DH-Plot menu, click Select Holes and then select Deselect all Holes.
All the drillholes in your drillhole project will be deselected.
Selecting Holes from List
There are a number of methods available in the Drillhole system to select drillholes. This method uses
the Select Holes from List dialog.
To Select Drillholes from List

1. On the DH-Plot menu, click Select Holes and then select Selection Tool.
The Hole Selection Tool will appear.
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2. Using this tool, scroll down through the list of drill holes in the Selected and Not Selected lists and
verify that the correct holes have been selected.
3. Using the arrow buttons select or deselect additional drillholes as needed. Click OK to exit the
dialog.
Selecting Holes by Name
There are a variety of methods available in the Drillhole system to select the drillholes. In this example,
we will show how to select drillholes by name or name mask (wild-card characters allowed).
To Select Drillholes by Name

1. On the DH-Plot menu, click Select holes and then select By name or Name Mask.
The Select holes by name dialog will appear.
2. In the Name mask (* and ? accepted) box, specify the hole(s) and using the Select or de-select
dropdown list, specify if you want to select or de-select the data.
3. From the Overwrite or append dropdown list select Overwrite to update the selection state of every
hole, based on whether the hole name matches the name mask. Select Append and only holes
matching the input mask will have their selection state altered, enabling this tool to be used in a
cumulative mode.
4. Click OK to select drillholes by name.
Selecting Holes from Plan Map
You will sometimes want to concentrate on an area of focus from a project “Plan” map. This will enable
you to display only the area of the project that is of interest to you.

www.geosoft.com

Target How-To Guide | 180

Target Drillhole Mapping
Selecting Holes

To Select Drillholes from Plan Map

1. Make sure your plan map is open and selected in your project.
If you previously selected one or many drillholes, you will need to first deselect all holes by
clicking Deselect all holes.
2. On the DH-Plot menu, click Select Holes.
3. Select From Plan Map. The Define polygon dialog will be displayed.

4. Click the OK button to interactively define a polygon on your map.
5. Using your mouse, define a polygon around the holes in the plan map you wish to select as an area
of interest. An example is shown below:
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6. When finished,right-click and select Done from the popup menu. The system selects the holes
within the defined boundary.
Selecting Holes using the Hole Selection Tool
The Hole Selection Tool enables custom selection of single or multiple holes using a dialog that displays
a plan view of the drillhole project. This tool enables you to view "all holes", "selected holes" and holes
including "full traces" or "labels". You can select interactively by drawing a polygon or by clicking holes
individually. This method is best used if you have pre-existing knowledge of your drillholes and is an
excellent way to preview the locations of your drillhole and the extents of your drillhole traces.
Selecting Drillholes using the Hole Selection Tool

1. On the DH-Plot menu, click Select Holes and then select Selection Tool.
The Hole Selection Tool will appear.

2. In the Display section of the dialog, select All holes or Selected holes and select if holes include
Full Traces and Hole Labels.
3. The drillhole plan view area can be modified using the Zoom In button (
button (
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4. In the Selection Tools section of the dialog you can select the Select All or Select None buttons,
or depending on the Selection Mode you can Select/Deselect single holes (
using rectangle tool (

) or Select/Deselect using polygon tool (

), Select/Deselect

).

5. To deselect all the holes click the Select None button.
6. Set the Selection Mode to Select and using the Select/Deselect buttons described above (single
holes, rectangle tool, polygon tool), select the drillholes. Selected drillholes will be highlighted,
while deselected holes will be faded, as shown below.

Creating a New Map
Target Can be used to produce an intelligent entity called a Map. Physically a map is a special graphic
file (*.MAP) containing drawings and images. We call the map intelligent because it enables you to edit it
interactively, apply dynamic linking and track the map creation processes.When you create or open a
map in Target, the system displays a Map window in the project. For a new map, the window is initially
empty. For an existing map, all map elements are displayed when the window opens.
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An important component of the map is the map template. Templates control placement of base map
elements (surrounds), contours, grids, plots, images and any other graphics elements that you may
require in your completed map. For more information on mapping, map components and working with
maps see the Application Help.
To Create a New Map

1. Select the database you wish to create a map from in your current project.
2. On the Surface Mapping menu, select New map and then select New map from E,N.
The Data range to map dialog appears.

3. Click the Scan data button to have the system query the database for the Minimum X, Y and
Maximum X, Y coordinates, Distance units and the Coordinate System information, or enter the
desired data range manually.
If the scanned data or grid file does not have an established unit, "metres" is assumed. It is
important that the distance units accurately reflect the units of the data range. The default
unit can be modified from the Default Settings dialog, found on the GX|Global
Settings|Generalmenu.
4. Click the Next> button.
The Create a New Map dialog appears.

5. Enter a Map name. Using the dropdown list, select the Map Template and then click the Scale
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button.
The system automatically calculates a scale that will fit the data on the map template. It's
recommended that you increase the scale up to a more appropriate 'round' number (e.g. from
19255 to 20000).
6. Click the Finish button to display the new blank map.

Creating a Base Map
Maps are composed of views. A view is a coordinate translation and a masking region and is used to
organise and display information on a map. Maps consist of a Base view, which uses paper coordinates
with an origin at the bottom left corner of the page, and a Data view, which uses ground coordinates.
You can customize your base map with many elements, including map surround, north arrow, scale bar,
reference grids, latitude/longitude annotations, text blocks/balloons and titles. The layout of your base
map can either be map or figure style. Figure style maps have a layout with the title, scale bar and north
arrow located at the bottom of the map, whereas map style maps have a layout with the title box, scale
bar and north arrow along the right hand side of the map. The following images show the difference in
layout between the two styles.

To Create and Plot a Figure Style Base Map

1. Make sure your map file is open and selected in the project.
2. On the Surface Mapping menu, select Base Map and then select Draw Base Map.
The Basemap layout dialog appears.
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This dialog is the first dialog in the base map layout wizard. The type of Map style that you choose
here will reflect the type of dialogs to follow.
For this example, we select the figure style.
3. Select thefigure style.
4. Click Next> to continue.
The Figure style base map dialog appears.

www.geosoft.com

Target How-To Guide | 186

Target Drillhole Mapping
Creating a Base Map

5. Specify the display characteristics of the base map elements.
For detailed information on each setting, click the Help button.
6. Set the North direction. If blank, no North arrow is drawn.
7. You can specify different types of display styles for the Reference grid via the dropdown list.
8. Configure the other base map options as desired.
9. Click Next> to continue.
The Figure titles dialog box appears.

10. You can specify the map titles and sub-titles, if desired.
11. Click Finish to plot the base map on your current open map.
To Create and Plot a Map Style Base Map

1. Make sure your map file is open and selected in the project.
2. On the Map Tools menu, select Base Map and then select Draw base map.
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The Basemap layout dialog appears.

This dialog box is the first dialog box in the base map layout wizard. The type of Map style that you
choose here will reflect the type of dialog boxes to follow.
For this example, we select the Map style.
3. Select map.
4. Click Next> to continue.
The Full map style base map dialog appears.
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For detailed information on each setting, click the Help button.
5. Set the North direction. If blank, no North arrow is drawn.
6. You can specify different types of display styles for the Reference grid via the dropdown list.
7. Configure the other base map options as desired.
8. When complete, click Next>.
The Map title block dialog appears.
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9. You can specify the map titles and sub-titles, if desired.
10. Click Finish to plot the base map on the current open map.

Creating a Plan Map
Plan maps provide surface views of drillhole collars, co-ordinates, positioning grids, drillhole traces and
other information, such as the title block and a list of the holes. In the Drillhole system, plan maps
represent an important organizational and navigational tool that enables you to quickly display drillhole
collars and evaluate drilling progress, display drillhole traces to help establish subsurface drilling
coverage, and construct drillhole sections.
You can replot your Plan map using the Replot Holes on Existing Plan or Section option, from the DHPlot menu. This option enables you to regenerate your current Plan (or Section) maps by simply
replotting the holes without eliminating any added groups, such as interpretations, images, or grids.
To Create a Plan Map

1. On the DH-Plot menu, click Plan map.
The Plan Map Parameters dialog will appear.

www.geosoft.com

Target How-To Guide | 190

Target Drillhole Mapping
Creating a Plan Map

2. Fill in the information across the various tabs of this dialog.
For more information on the Plan Map Parameters dialog boxes, click the Help button on
the individual tabs.
3. Click OK to generate your plan map. By default the collar locations are plotted using a circle
symbol. There are several parameters available to help you customise the display of your plan
map. The following table describes each tab in the Plan Map Parameters dialog box.
Tab

Tab Description

Plan Location

Use this tab to specify the location of the plan map.

Collars

Use this tab to select specific symbols for plotting hole collars

Hole Traces

Use this tab to define the hole traces on the plan map

Data

Use this tab to specify the data and plot type for your map.

Reference Grids

Use this tab to specify the parameters for displaying reference grids of local
eastings and northings on the plan map

Plan Grid

Use this tab to plot a plan grid on the map.

Save/Load

Use this tab to load and/or save map and data plotting parameters to a file for
sharing or for reuse.

Slices

Use this tab to plot a slice from a Voxel or 3D DXF, 3D Shapefile, or Geosoft
Geosurface on a Plan or Section map.
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Creating a Section Plot
Section maps provide cross sectional views of drillhole traces, co-ordinates, reference grids, assay
values and geological units. Section maps represent an important tool that enables you to display
drillhole traces to help establish subsurface drilling coverage and visualize the geology and related
geochemistry beneath the surface.
Before you can start creating your section maps you first must select the drillholes you want to view in
your section.
The drillhole section plot options are provided in easy-to-use tab menus, enabling quick access to all the
settings from a single dialog. The dialog include sensible defaults; enabling easy creation of drillhole
sections.
You can replot your Section map using the Replot Holes on Existing Plan or Section option, from the DHPlot menu. This option enables you to regenerate your current Section (or Plan) maps by simply
replotting the holes without eliminating any added groups, such as interpretations, images, or grids.
To Create a Section Plot:

1. On the DH-Plot menu, click Section.
The Section parameters dialog will appear.

2. To specify the section location parameters, select the Section Location tab. Select the Location
and Orientation, Section Azimuth, Vertical Extent and Multiple Sections parameters, or accept the
default values. Note that if you select multiple sections each section will be displayed in individual
maps. To plot multiple sections on a single map, see the following Creating a Stacked Section Plot
option.
To plot multiple sections on a single map, see the section.
3. You can edit the location coordinates either by specifying the values in the Easting Ref or Northing
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Ref boxes or by clicking the Define button to interactively select the location coordinates from the
plan map.
4. To plot a topography profile across the section, select the Topography tab and select the Plot
topography on section box to enable the topography parameters. Using the Browse button, locate
and select the topography grid file to use to calculate the topographic profile across the section. To
edit the line style, click on the Line Style box beside the grid file name.
5. To plot data along the hole traces in the section, select the Data tab.
The Plot boxes enable/disable the Data selection dropdown list. This is a convenient way to
select or de-select individual data plots, without clearing or re-selecting the data from the Data
lists.
6. Select data channel(s) available in the drillhole project from the Data dropdown list. The selections
combine the name of the channel, along with the identifier for the component database in which the
channel is found.
7. Using the Plot Type dropdown lists, select the plotting type for the data previously selected.
Select plot type(s) from the dropdown list. Plot types displayed are based on the data type of the
selected Data. Numeric channel selections include Bar plot, Grid: Kriging, Grid: Min curvature,
Numeric bands, Post values, and Profile. String or text channel selections include Comments,
Post text, Rock code patterns, and Text bands.
8. To specify the plan map window parameters, select the Plan View tab and select the Plot Plan
View box. To enable the plotting of a grid in the plan view window, select the Plot grid or image in
plan view box. Using the Browse button, locate and select the grid file to display.
9. To specify the profile window parameters, select the Profiles tab. To enable the plotting of a profile
window, select the Plot grid data profiles box. Using the Browse button, locate and select the grid
file to use to calculate the profile across the section.
The rectangle box to the right of the Browse button displays the selected Line Style. To edit the
line style, click in the box. The Line Attributes tool will appear.
10. To specify the page layout of the section plot, select the Page Layout tab. To specify the section
map layout, click the Map Layout button. The Section Map Layout dialog is displayed. This dialog
enables you to specify the layout of your section map. To accept the layout and return to the Page
Layout tab, click the OK button.
11. To enable the title parameters check the Plot Titles box and add your titles content as required.
12. Click the OK button on the Section Parameters dialog. The section map is created and displayed.
There are many additional section-plotting options that enable you to include other parameters.
As you become more familiar with the system, we recommend that you experiment with the
other options to create a custom map of your own.

Creating a Stacked Section Plot
Drillhole stacked section option enables multiple sections to be plotted to the same map. The same tools
for defining multiple sections to individual maps are now available to plot the same sections to a single
map.
To Create a Stacked Section Plot

1. On the DH-Plot menu, click Stacked Section.
The Section parameters dialog is displayed.
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2. To specify the number of stacked sections to plot, select the Section Location tab. In the Number
of sections box under Multiple Sections, specify the number of sections you want plotted to a
single map. Note that if you select multiple sections all sections will be displayed on a single map.
To create multiple sections on individual maps, see the Creating a Section Plot section.
3. To plot data along the hole traces in the sections, select the Data tab.
The Plot boxes enable/disable the Data selection dropdown list. This is a convenient way
to select or de-select individual data plots, without clearing or re-selecting the data from the
Data lists.
4. Using the Data dropdown lists, select the data channels available in the current Drillhole project
you want to plot.
5. Using the Plot Type dropdown lists, select the plotting type for the data selected.
Select plot type(s) from the dropdown list. Plot types displayed are based on the data type
of the selected Data. Numeric channel selections include Bar plot, Grid: Kriging, Grid: Min
curvature, Numeric bands, Post values, and Profile. String or text channel selections
include Comments, Post text, Rock code patterns, and Text bands.
6. Click the OK button on the Section Parameters dialog. The stacked section map is created and
displayed.
There are many additional section-plotting options that enable you to include other
parameters. As you become more familiar with the system, we recommend that you
experiment with the other options to create a custom map of your own.

Replot Holes on Existing Plan or Section
The Replot Holes on Existing Plan or Section option enables you to replot drillholes on a current Plan or
Section map.
This option enables you to regenerate your current plan or section maps by simply replotting the holes,
without eliminating any groups that have been added in, such as interpretations, images, or grids.
Replot Holes on Existing Plan
The Replot Plan: Hole Parameters dialog includes the following tabs; Collars, Hole Traces, Data, Plan
Grids, and Slices.
To Replot a Plan Map

1. Open and select (highlight) the Plan map to replot.
2. On the DH-Plot menu, select Replot Holes on Existing Plan or Section.
The Replot Plan – Hole Parameters dialog will appear. This tabbed dialog includes intelligent
default values, including the current Plan map parameters.
3. Once you have made your changes on the Replot Plan – Hole Parameters dialog, click the OK
button.
The current Plan map will be replotted with the updated hole parameters, retaining any additional
groups, such as interpretations, grids or images.
4. For more information on the Replot Plan – Hole Parameters dialog, click the Help button on the tab
of interest.
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Replot Holes on Existing Section
The Replot Section: Hole Parameters dialog includes the following tabs; Collars, Hole Traces, Data,
Topography, and Slices.
To Replot a Section Map

1. Open and select (highlight) the Section map to replot.
2. On the DH-Plot menu, select Replot Holes on Existing Plan or Section.
The Replot Section – Hole Parameters dialog will appear. This tabbed dialog includes intelligent
default values, including the current Section map parameters.
3. Once you have made your changes on the Replot Section – Hole Parameters dialog, click the OK
button.
The current Section map will be replotted with the updated hole parameters, retaining any
additional groups, such as interpretations, grids or images.
4. For more information on the Replot Section – Hole Parameters dialog, click the Help button on the
tab of interest.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Gridding refers to the process of interpolating data onto an equally spaced “grid” of values in a specified
coordinate system, such as X-Y. In the Surface Mapping component of Target, both the Minimum
Curvature and Kriging gridding methods are available. The Drillhole component of Target includes TIN
gridding as an additional gridding option.
This How-to Guide will demonstrate two of the Target drillhole gridding methods, Minimum Curvature
and Kriging.
See below for a short description of all the gridding methods available to Target users.
Minimum Curvature Gridding

Minimum curvature gridding is a gridding method that fits a smoothest possible surface to the data
points. It is best used when data is randomly distributed, sampled along arbitrary lines or if you want to
include tie lines.
Kriging

Kriging is a geostatistical gridding technique for random data, non-parallel line data or orthogonal line
data.Use the kriging method if the data is variable between sample locations, known to be statistical in
nature, poorly sampled or clustered. Kriging is ideally suited to geochemical or other geological samplebased data; it is rarely used with geophysical data, which tends to follow a natural smooth surface.
Tinning

The TIN gridding method requires one data point for each (X, Y) data location in the database. Tinning
provides the ability to sum or average duplicate samples - data that have multiple Z values at single point
locations.Geosoft Tinning provides a number of ways of visualizing the TIN, including the ability to plot
the TIN Nodes, the TIN Mesh (or Delaunay triangulation), the Convex Hull, the Voronoi cells of your data
and as grids.
For more detailed information on TIN Gridding, read the Tinning: Triangular Irregular Network
GriddingTechnical Note found on the www.geosoft.com web site.
The following are newer methods of gridding also available to Target users via the Grid and Image|Gridding
menu.
Gridding using Inverse Distance Weighting Algorithm

This new method creates a grid from point data using an Inverse Distance Weighting algorithm, and is
used primarily to interpolate geochemistry data.

Target Drillhole Gridding
Kriging Overview

Direct Gridding

You can create a grid from highly sampled data without using any interpolation. This method is intended
for use with over-sampled datasets such as LiDAR; it provides a quick gridded view of the datasets.
Sample Density Gridding

You can create a grid of the density of sample locations, rather than the value recorded at each location.
This method is useful for determining the spatial distribution of highly sampled data and enables you to
easily identify areas which are undersampled. Accessed via the Direct Gridding dialog.
Anisotropic Kriging

You can create a grid enhanced in a preferred direction using the strike direction and a weighting factor.
This method enables you to incorporate the dominant geologic strike and define a preferential weighting
in the strike direction, enhancing geological trends in your dataset.Accessed via the Kriging - Advanced
Options dialog.
For immediate assistance on using any of these gridding routines, click the Help button on the dialog of
interest.

Kriging Overview
The statistical gridding method (KRIGRID GX) uses the method of Kriging to determine a value at each
grid node based on the XYZ data. Kriging is a geostatistical gridding technique for random data, nonparallel line data or orthogonal line data. Use the Kriging method if the data is variable between sample
locations, known to be statistical in nature, or poorly sampled or clustered. Kriging is ideally suited to
geochemical or other geological sample-based data; it is rarely used with geophysical data, which tends
to follow a natural smooth surface.
Kriging first calculates a variogram of the data showing the correlation of the data as a function of
distance. The greater the distance between data points, the greater the variation between the points.
Based on the variogram, you can select a model that best defines the variance of the data.
The technique of Kriging uses this model to estimate the data values at the nodes of the grid. A
significant by-product of Kriging is the ability to estimate the error of the data at each grid node.
Geosoft supports ordinary Kriging as well as universal Kriging. Universal Kriging differs from ordinary
Kriging in that it allows the data to contain a regional trend. For a more in-depth understanding of
geostatistical analysis and Kriging, refer to Mining Geostatistics written by A.G. Journel and C.J.
Huijbregts, 1978.
Kriginghas the following capabilities:
Applies de-aliasing filter.
Applies linear and logarithmic gridding options.
Blanks un-sampled areas.
Calculates a variogram from the input data channel.
Output grids up to any size.
Processes unlimited number of input observation points.
Supports linear, power, spherical, Gaussian, exponential and user defined models.
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The actual maximum size of the grid that you can use depends upon the available free disk space
of your computer.
You will now use the Kriging method. You will first compute the variogram, adjust the advanced options
and then create the grid.
Drillhole Gridding Using Kriging
The Kriging option is ideal for clustered data and provides better control in anomalous or poorly sampled
areas.
To Grid Drillhole Data using the Kriging Method

1. Make sure your Drillhole project is opened.
2. On the DH-Plot menu, select Section. The Section Parameters dialog will appear.
3. Click the Data tab. The Data page opens.

4. Using the Data dropdown list, select the channel (column) to grid. Select Grid: Kriging from the
Plot Type dropdown list, and click the Define button to the right. The Grid data dialog will appear.
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5. In the Grid section of the dialog specify the File name, or accept the default name.
6. Specify the grid cell size. This should normally be ½ to ¼ the nominal sample interval. If not
specified, the data points are assumed to be evenly distributed and the default cell size will be. ¼*
(sqrt (grid area / #data points)).
7. Click the Advanced> button to specify a name of output for the variogram file and other advanced
parameters.

For more information on the Advancedgridding parameters, click the Help button.
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9. Click the OK button and to return to the Grid Data dialog and click the OK button again to return to
the Section Parameters dialog.
10. Click the OK button and the system processes the data and displays the grid in a “map” window
and adds it under Grids in the Project Explorer window.

Minimum Curvature Gridding Overview
The random gridding method (RANGRID GX) fits a minimum curvature surface to the data points using a
method similar to that described by Swain (1976) and Briggs (1974). A minimum curvature surface is the
smoothest possible surface that will fit the given data values.
Minimum Curvature gridding first estimates grid values at the nodes of a coarse grid (usually 8 times the
final grid cell size). This estimate is based upon the inverse distance average of the actual data within a
specified search radius. If there is no data within that radius, the average of all data points in the grid is
used. An iterative method is then employed to adjust the grid to fit the actual data points nearest the
coarse grid nodes.
After an acceptable fit is achieved, the coarse cell size is divided by 2. The same process is then
repeated using the coarse grid as the starting surface. This is iteratively repeated until the minimum
curvature surface is fit at the final grid cell size.
A very important parameter in the Minimum Curvature gridding process is the number of iterations used
to fit the surface at each step. The greater the number of iterations, the closer the final surface will be to a
true minimum curvature surface. However, the processing time is proportional to the number of
iterations.
Minimum Curvature stops iterating when:

www.geosoft.com

Target How-To Guide | 200

Target Drillhole Gridding
Minimum Curvature Gridding Overview

It reaches a specified maximum number of iterations, or
A certain percentage of the observed points are within a limiting tolerance of the surface
By default these limits are 100 iterations and 99% of points within 1% of the data range.
Minimum Curvature gridding has the following capabilities:
Accessing unlimited number of input observation points.
Adjustable internal tension.
Applying de-aliasing filter.
Applying linear and logarithmic gridding.
Applying projections.
Blanking un-sampled areas.
Outputing grids up to any size.
The actual maximum size of the grid that you can use depends upon the available free disk space
of your computer.
Drillhole Gridding using Minimum Curvature
The Minimum Curvature gridding option is best used when data is randomly distributed, sampled along
arbitrary lines or if you want to include tie lines.
To Grid Drillhole Data using the Minimum Curvature Method

1. Make sure your drillhole project is open.
2. On the DH-Plot menu, select Section.
The Section Parameters dialog will appear.
3. Click the Data tab.
The Data page opens.
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4. Using the Data dropdown list, select the channel (column) to grid. Select Grid: Min. curve from
the Plot Type dropdown list, and click the Define button to the right.
The Minimum Curvature Gridding dialog will appear.

5. Specify the Name of new grid file.
6. Specify the Grid cell size. This should normally be ¼ to ½ the nominal data sample interval. If not
specified, the data points are assumed to be evenly distributed and the default cell size will be. ¼*
(sqrt (grid area / #data points)).
7. Click the Advanced button. The Minimum Curvature - Advanced Options dialog appears.
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8. You can use this dialog to set a number of advanced minimum curvature gridding options. Set your
advanced options as required.
For more information on the Advanced gridding parameters, click the Help button.
9. Click the OK button to return to the Minimum Curvature Gridding dialog .
10. Click the OK button to return to the Section Parameters dialog.
11. Click the OK button and the system processes the data and displays the grid in a “map” window
and adds it under Grids in the Project Explorer window.
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Displaying a Grid in a Plan Map
The ability to quickly and easily integrate multi-disciplinary data into your maps (surficial, plan, section
and 3D maps) is one of the advanced visualization capabilities of the Drillhole system. For example, you
may have a magnetic grid supplied by a Geophysicist, or a topography grid that you want to place on
your plan view for comparison with your drillholes.
To Display a Single Grid on a Plan Map

1. Select the Plan map you want to work with.
2. On the DH-Plot menu, click Plan Map.
The Plan Map Parameters dialog appears.
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3. Make sure you are on the Plan Grid tab and select (check) the Plot grid or image in plan view box.
The Grid or image file parameters will be enabled.
4. Using the Browse button, select the Grid or image file from your working directory.
5. You may leave the Colour zones as the default and click the OK button. The grid is displayed on
the Plan map.
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For more information on the grid display parameters, click the Help button on the Plan Grid
tab.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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The Drillhole 3D Tools developed for Geosoft’s Target Surface and Drillhole Mapping applications
enables you to display downhole and surface data types in an interactive three-dimensional environment.
Drillholes are displayed in their “true” three-dimensional location.You can begin creating a 3D Drillhole
Map view once all the appropriate project information has been imported into your drillhole database.
Grids and layers created in 2D views can be displayed directly into the 3D view, in their correct
orientation, using Geosoft’s “on-the-fly” technology. Other grids and images (including bitmaps and
jpegs) can be opened and easily located in any specified orthogonal plane or draped over surfaces.
3D Voxel grids can also be displayed and modified in a 3D drillhole map. 3D Voxels can be created in
Target using the 3D|3D Gridding menu, or from the Utilities|3D Gridding menu in the 3D Viewer.
Using the 3D Tools you can interactively control the transparency of the individual planes (groups),
enabling the data to be displayed with a cumulative (light-table) effect. The 3D viewer supports a number
of imports such as MapInfo TAB or MIF files and DXF files.
Inside the 3D Viewer you can toggle on/off individual groups in the 3D view, enabling changes to the
displayed data, without having to recreate your 3D maps.
All data in the Target environment is dynamically linked; from the database through cross-section and
map through to the 3D environment.

About the 3D Viewer
The 3D Viewer has been redesigned to streamline your workflow and enhanced usability. The 3D
Viewer provides all of your 3D-mapping tools, functions and settings in one integrated 3D environment.
The Target 3D Viewer includes drillhole traces and attributes, voxels, grids, image files, Isosurfaces and
map surrounds.
When you display a 3D view, either by using the 3D|Open 3D Viewer menu option, or by selecting
(doubling-clicking) a 3D view in the View/Group Manager Tool, or by simply double-clicking a 3D view in
an open map file, the 3D view will be displayed in the 3D Viewer.
The 3D Viewer consists of an interactive dialog, with five main Menus: ((Add to 3D, Voxel, Wireframe,
Tools & Settings, Export and Help), a 3D Viewing window, a 3D Tools window and the bottom Status
Bar.

Target Drillhole 3D Tools
What Menu options are available?

What Menu options are available?
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Numeric to Lithology Voxel

What can I do in the 3D Viewing Window?
The following interactive viewing buttons are provided on the toolbar directly above the 3D Viewing
window.

What can I do with the 3D Viewer Tools?
The parameters available in the 3D Tools window are dependent on the type of 3D group currently
selected. Each group enables you modify different aspects of the 3D view within the 3D Viewer.
Each of the following 3D groups can be displayed in the 3D Viewer. See the Application help for more
information.
Planes and Surfaces
Vector Objects
Geosurfaces
3D Data Voxel
Lithology Voxel
Geostrings
Vector Voxels

What information is available on the Status Bar?
The status bar across the bottom of the 3D Viewer displays helpful navigation hints, along with the
current 3D view's coordinate system, the shadow cursor location, the view's inclination, azimuth and
look-at point (centre of rotation).
To modify or edit 3D views requires a licensed version of Target.
You can begin creating a 3D view once all the appropriate project information has been imported into your
drillhole databases; collar, survey, assay, and any other data that you are using in your drillhole project.

Creating a 3D Drillhole Map
3D maps provide a new perspective to traditional drillhole data. You can now view borehole traces and
gridded data from different angles—in 3 dimensions, making it easier to spot the relationship between
surface and sub-surface features.
Before you can start creating your 3D map you first must select the drillholes DH-Plot|Select Holes you
want to view in your map.
The 3D map options are provided in an easy-to-use tab dialog, enabling quick access to all the settings
from a single dialog. The dialog includes sensible defaults; enabling easy creation of your 3D map.
To Create a 3D Map

1. On the DH-Plot menu, select 3D map.
The Page Layout tab, on the 3D Map Parameters dialog, is displayed by default.
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2. Control the following page layout parameters from this tab; the Background Colour of the 3D view,
the Axis Colour and Font used for annotating the 3D view, selecting to Plot Legend (right side of
map), including company Logo (image file) and specifying the map Titles.
3. Select the Hole Traces tab. This tab dialog includes the following drillhole trace parameters; the
Colour of the Hole Trace, the Hole Labels including location, annotations, text size, colour and
font, and Depth Ticks (annotations etc.) along the hole trace.
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4. Select the Data tab. The Data and Plot Types are selected from dropdown lists, just as you would
select data for your Plans or Sections to be plotted.

In Drillhole 3D two sets of data can be plotted down hole along the trace (Left side and
Right side), at one time. When these data appear in the 3D Viewer, the point-of-view will
always remain the same, no matter how the image is rotated, panned or zoomed.
5. In the Plotting Orientation section, you can choose to plot your data as Perpendicular to trace or
Horizontal to the hole trace.
6. Plan oriented gridded data can be created from this tab. The three available gridding methods are
Minimum curvature, Kriging and a TIN based technique. To define the gridded data parameters,
click the Define button. The specified Gridding dialog will be displayed.
7. The Data channel (column) to be gridded is displayed. You can add a File name tag to the grid; this
is useful when distinguishing between grids created using different gridding parameters. The Cell
size can be left to the "intelligent" default, which is one quarter the average data separation based
on a statistical average.
8. The Colour zone file can also be left to the default file, or your own zone file (*.itr, *.tbl, *.zon) can
be selected.
9. The Location section of the tab enables you to specify the Relative Level (elevation of grid) and the
Averaging Interval (data within this elevation interval will be used to create the grid. Note that the
data values are averaged for this thickness).
10. The Multiple Grids section enables you to specify the Number of grids to create and at what
Increment. (For example, 3 grids with a Relative Level of 225 and an Increment of 50 downwards,
you will create grids at 225RL, 275RL and 325RL).
11. To specify additional gridding parameters, such as Log options etc., click the Advanced gridding
options… button. The "Gridding" – Advanced Options dialog is displayed. For detailed technical
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information, click the Help button. When you are satisfied with your selections, click the OK
button on the Advanced Options dialog.
12. The final parameter on the "Gridding" parameters dialog is Transparency. Using the slider you can
control the level of transparency of the gridded data in the 3D view. Click the OK button on the
"Gridding" dialog to return to the 3D Map Parameters dialog.
13. Select the Topography tab. If you have gridded topography data available you can check the Plot
Topography tab and using the Browse buttons, locate the Topography grid file and the Overlay grid
on topography file.

14. To enable the Grid Clipping check the appropriate box, and specify the Border size in ground units.
15. Select the Voxel tab. Check the Plot voxel file box to enable the voxel parameters and using the
Browse button, locate the Voxel grid file. Using the Browse button, locate a Colour zone file. (Note
that, the default Geosoft *.tbl files can be located in the ‘…\Oasis montaj\tbl’ directory.) Then,
using the Transparency slider set the transparency of the Voxel.
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16. Select the Load/Save tab. This tab is used to save the map and data parameters to a file for either
sharing with other users or so these particular map settings can be used at a later date.

17. Click the OK button and the 3D map will be created and display in your 3D Viewer.
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To help in viewing all of the data, on the Voxel tab, set the Transparency slider to
approximately 50%. You can also modify the X, Y, Z and Data sliders. Modifying the Data
slider (moving the left side towards the right) is the same as windowing the lower values of
your data, enabling easier viewing of all of your 3D data.

Create a 3D Voxel Grid
You can easily create a 3D Voxel grid (3D | 3D Gridding) or in the 3D Viewer Utilities| 3D Gridding), using
the Kriging, Direct Gridding, or the Inverse Distance Weighted Gridding methods. Additional Voxel tools
are provided enabling you to, report and modify Voxel information including, statistical and coordinate
system information, create new Voxels based on mathematical expressions or clipped (windowed)
areas, copy and convert Geosoft Voxels into a number of other data formats (and visa versa). Users are
also provided with the tools to extract section grids, plan grids, and Isosurface (contours) from a Voxel
and plot them to a Target 3D map.
To Create a Drillhole 3D Voxel Grid using either of the 2 methods:

1. Select the holes you would like included in your 3D Voxel grid using one of the DH-Plot | Select
holes menu items.
2. Select (highlight) the project database containing the data you want to use to create the 3D Voxel.
3D Gridding Methods in Oasis montaj
A "Voxel" is short for "volume pixel", the smallest distinguishable box-shaped element of a threedimensional image. A Voxel is the 3D conceptual counterpart of the 2D pixel.
You can create a Voxel using the 3D Gridding submenu, located on the 3D menu or in the 3D Viewer
from the Voxel|3D Gridding menu.
The 3D Gridding submenu offers 2 different gridding algorithms, each with a different focus:
The Kriging method best suits clustered data occurring in a region with otherwise sparse data
distribution, such as geochemistry data.
The Inverse Distance Weighted Gridding method is most suitable for gridding data collected along
specific directions - such as borehole data.
The data to be gridded must have defined X, Y and Z coordinates. To define the coordinates use the
menu, Coordinates|Set Current X,Y,Z Coordinates. The 3 dimensional coordinate system will locate the
data in 3D space. The Z axis is interpreted as positive up. The 3D workflow includes tools for creating,
displaying and processing voxels. The 3D Viewer enables visual inspection of voxels and comes with an
extensive set of 3D viewing tools.
When applying 3D gridding, halving the cell size increases both the file size and processing time
by a factor of 8 (2 3).
Creating a Voxel using the Kriging Gridding method

From the 3D Gridding menu, select the Kriging option to perform a statistical-based 3D gridding. The
input data must be supplied in a Geosoft database (GDB file). The output will be a voxel model within the
confines of the data extent.
To Create a 3D Voxel model using Kriging:
1. Open a Geosoft database containing X, Y, Z and the data channel you would like to grid. If the
coordinate system is not completely defined, a message will pop up and you will not be able to
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continue until the corrective action is taken.
2. In the 3D Viewer, select Voxel , then select 3D Gridding and then select Kriging (or on the main
Target 3D menu, select 3D Gridding and then select Kriging.
The 3D Kriging dialog appears.

If a database is not already open you will be prompted to open one.
3. From the dropdown list, select the Channel to grid. The first time through the process, the default
Output voxel file name will default to the provided channel name. The subsequent invocations of
this tool will remember the user specified file name. You can rename the output voxel file or accept
the default name.
4. Specify the Cell size. If you do not have a preset cell size, click the Calculator
button to
obtain a reasonable cell size based on the extents of your data. The cell size is calculated for a
single cube, assuming the volume is divided into 10000 individual cubes. The value is then
rounded down to give a more satisfactory value.
We recommend that your first attempt at gridding be using the defaults. After inspecting the
outcome however you may decide to modify defaults such as the Blanking Distance to fill
in the gaps, modify the Z cell increment, or generate the output on a logarithmic scale.
Additionally you can customize the variogram to best suit your data.
For more information, click the Help button on the 3D Kriging dialog.
5. When you are satisfied with your selections click OK. The Voxel is created and displayed in the
Voxel Viewer. An example is shown below:
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The Voxel Viewer provides additional viewing tools.
Creating a Voxel Model using the Inverse Distance Weighted (IDW) Gridding method

To Create a 3D Voxel model using Inverse Distance Weighted Gridding:
1. Open a Geosoft database containing X, Y, Z and the array data channel to grid. If the coordinate
system is not completely defined, a message will pop up and you will not be able to continue.
2. In the 3D Viewer, select Voxel , then select 3D Gridding and then select Inverse Distance
Weighted Gridding (or on the main Target 3D menu, select 3D Gridding and then select, Inverse
Distance Weighted Gridding).
The 3D Inverse Distance Weighted Gridding dialog appears.

If a database is not already open you will be prompted to open one.
3. From the dropdown list, select the Channel to grid. The first time through the process, the default
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Output voxel file name will default to a combination of the current database and provided channel
name. The subsequent invocations of this tool will remember the user specified file name. You can
rename the output voxel file or accept the default name.
4. Specify the Cell size. If you do not have a preset cell size, click the Calculator
obtain a reasonable cell size based on the extents of your data.

button, to

5. When you are satisfied with your selections click OK. The Voxel is created and displayed in the
Voxel Viewer. An example is shown below.

Inverse Distance Weighted Gridding of Borehole data
We recommend that your first attempt at gridding be using the defaults. After inspecting the
outcome however you may decide to modify defaults such as the Weighting power & slope
to alter the degree of influence of contributing data points relative to their distance , or the
Blanking Distance to fill in the gaps, or generate the output on logarithmic scale.
6. Specify the Cell size. If you do not have a preset cell size, click the Calculator
button, to
obtain a reasonable cell size based on the extents of your data. The cell size is calculated for a
single cube, assuming the volume is divided into 10000 individual cubes. The value is then
rounded down to give a more satisfactory value.
For more information, click the Help button on the 3D Inverse Distance Weighted Gridding
Help topic.
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Extract a Plan Grid (Horizontal Slice)
A “Plan Grid” (or horizontal slice) can be easily extracted from a Voxel using the Add to 3D|Grids|Level
Plan Grid(s) Extracted from Voxel option. Users can select the start elevation, the elevation increment
and the number of grids to extract.
To Extract a Plan Grid

1. Open your 3D view in the 3D Viewer.
2. On the Add to 3D menu, select Grids and then select Level Plan Grid(s) Extracted from Voxel.
The Extract Horizontal Slice Grids from Voxel dialog appears.

3. Use the Browse button or dropdown list to locate the Voxel file in your current working directory.
4. Specify the start Elevation, leaving the remaining fields blank if you wish, and click the OK button.
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The “Plan Grid” will be extracted from the voxel and displayed in the 3D Viewer, as shown below.

Extract a Section Grid (Vertical Slice)
Target includes the ability to extract vertical slices of a voxel grid as “Section Grids”. A Section Grid (or
vertical slice) can be easily extracted from a Voxel using the Add to 3D|Grids|Section Grid(s) Extracted
from Voxel option. The Section grid can be extracted using the voxel database or interactively from a
displayed map. To use the interactive map method, you should first have a “Plan Map” open in your
project, you will be prompted to interactively draw a profile line from the open Plan map.
To Extract a Section Grid:

1. Open your 3D view in the 3D Viewer.
2. On the Add to 3D menu, select Grids and then, select Section Grid(s) Extracted from Voxel.
The Section Grids from Voxel dialog appears.
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3. Use the Browse button or dropdown list to locate the Voxel file in your current working directory. In
the Output grid file box specify a name for your output grid.
4. Using the Section selection dropdown list, select the method you would like to use to choose your
section. You can leave the Grid cell size to the default value.
5. Click the OK button. If using the interactive methods, you will be asked to define the section
location on a map. The “Section Grid” will then be extracted from the voxel and displayed in the 3D
Viewer, as shown below:

You might need to hide (uncheck) some of the 3D groups displayed in the 3D Viewer to clearly
see the extracted section grid.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Target 3D Geology Surfaces
The Target 3D Geology Surfaces (Contact Surface from Geology Grids) tool enables you to create
subsurface topography grids, where the "Z" values correspond to the elevation of the top or bottom
surfaces of specific lithologies, based on drilling data.
The subsurface topography grids are displayed in the 3D Viewer as 3D grids. Using the 3D functions,
you can manipulate several characteristics of the displayed surfaces/3D grids, including colours,
transparency, sample resolution, etc.
For more information on using Target capabilities, see the Target Application Help system.

Preparing Collar, Survey, and Lithology Data
To create subsurface topography grids, as well as lithology voxels, you require three Geosoft databases:
A collar database
A survey database
A geology database that includes a From (depth) column, To (depth) column and a string column
containing lithology information
A string column (channel) contains plain text values, for example “LMSTN” for “limestone” or
“SDSTN” for “sandstone”.

Creating Contact Surface from Geology
You can create a relatively simple subsurface topography grid using the default settings of the Create
Contact Surface from Geology option, or change the settings to make a more complex one. Remember
that to create this grid, you must have an existing 3D view and open it using 3D|Open 3D Viewer or
create a new, blank 3D view by using 3D|Create a New 3D View.
To Create a Subsurface Topography Grid:

1. With the Drillhole project open, from the DH-Plot menu, select Create Contact Surface from
Geology.
The Create Contact Surface from Geology dialog is displayed.

2. From the Geology channel drop-down list, select a channel that stores lithology codes.
This drop-down list displays only string channels found in the lithology (“From – To”)
database. If the channel you want to select does not appear on the list, verify the database
type and format. Ensure that the data type of the required lithology channel is string. If it is
not, you need to define the lithology channel’s type correctly while re-importing the data.
(You define the channel type in the fourth dialog of Drill Hole Import Wizard).
3. From the Geology unit drop-down list, select the lithology (rock) type whose surface you want to
create.
4. From the Surface drop-down list, select top or bottom. “Top” refers to the upper surface of the
specified lithology unit. “Bottom” refers to the lower surface of the specified lithology unit.
5. From the Of the drop-down list, select first layer, second layer, or last layer. This parameter
refers to the location of the lithology unit (counting from the top of the hole) in case a hole
intersected a series of units of the same lithology.
6. For the Output grid name, use the Browse button to specify the name and location of the Contact
Surface grid file.
7. For theColour table, use the Browse button to select a colour table (.tbl) file, transform (.itr) file, or
colour zone (.zon) file for the grid.
8. Click More to display the advanced parameters for the Create Contact Surface from Geology
dialog.
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9. Fill out any of these advanced parameters for your grid to customize it further.
10. Click OK .
The grid is displayed in the 3D Viewer and a map containing the subsurface topography grid is also
created and displayed in the current project.
The images on the 3D map and in the 3D Viewer are identical, as shown in the example below:
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10. Use the 3D Tools functionality to rotate, resize, re-colour, and otherwise enhance the graphical
representation of the created subsurface topography grid. Click the Help menu on the 3D Viewer
for more information on what you can do with 3D views.
When you close the 3D Viewer the changes you have made are automatically reflected on the
map.

Verifying Surface Correctness
A surface you have created and displayed might not correspond to your drillhole data with desired
precision. With this procedure, you can check the new surface against the lithology data associated with
individual drillholes.
To Verify Surface Correctness:
1. Display your created surface in the 3D Viewer window (3D|Open 3D Viewer).
2. From the Add to 3D menu in the 3D Viewer, select Drillholes .
The Draw holes to an existing 3D view dialog will appear.
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3. Click the Data tab. The Data page opens.
4. Under the Left side section, from the Data dropdown list, select a channel that contains the
required data and using the Plot Type dropdown, select Rock patterns.
5. Click Define. The Pattern Bands - Rock Codes dialog opens.
For more information, click the Help button on the Pattern Bands - Rock Codes dialog.
7. Click OK to close the dialog and return to the Drawn holes to an existing 3D view dialog.
8. Under the Right side section, from the Data dropdown list, select a channel that contains the
required data and using the Plot Type dropdown, select Post Text.
9. Click Define if you would like to define this plot type for your data, and click OK. The selected
drillholes, along with the subsurface topography grid you created earlier, are displayed in a new
map and in the 3D Viewer.
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As you zoom into the resulting 3D map, you can see that sections of the displayed drillholes are coloured
and text-labelled according to the selected table of rock type codes.
10. Use the 3D Tool panning, resizing, and rotation functions to examine intersections of your
subsurface topography grid with the individual drillholes.
You might find that one or more intersections of the created surface does not correspond exactly with the
geological boundary you have requested. You can achieve more precise results by adjusting the surface
gridding parameters and choosing more specifically the holes to use.
Having adjusted a parameter’s value, you will need to repeat the surface creation procedure and examine
the results. Achieving satisfactory results may require several iterations.
It is recommended that you give each new version of the resulting grid a new name. If you need to
keep the same grid name, you will need to first delete the original grid from the map and from the
Planes & Surfaces section of the 3D Tool . Otherwise, the new grid will be displayed on the relief
surface of the original grid, and the subsurface topography grid changes will not display.
It is not recommended that you change multiple parameters in a single iteration. The results of
several changes made simultaneously might be contradictory and difficult to analyse.

Adjusting Surface Gridding Parameters
This section describes the meaning of the surface gridding parameters and the procedures used to adjust
them..
A subsurface topography grid created with the default gridding parameters may not fit with some of the
data in individual drillholes. A better fit between the hole data and the surface can be achieved by
decreasing the surface cell size .
A smaller cell size will decrease the amount of interpolation made between the drillholes, creating a more
constrained contact surface.
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To Adjust Cell Size:

1. Make sure you map is open and selected in the 3D Viewer.
2. In the 3D Viewer, select Utilities and then select Create Contact Surface from Geology.
The Create Contact Surface from Geology dialog will appear.
3. Specify the surface creation parameters as required for your project.
4. Click the More button. The dialog expands to display additional parameter fields.

5. Click the Calculator (
) button next to the Cell size field. The system calculates the default grid
cell size and displays it in the Cell size field.
6. Change the value of the Cell size field to a smaller integer.
7. Click OK. The system creates the requested surface using the specified cell size and displays it in
the 3D viewer. .
8. Compare the new surface (grid) with the original by toggling these grids on and off in the 3D
viewer.
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You can further improve the hole/surface agreement by setting the value of the Internal tension
parameter closer to “1”. The Internal tension field is located in the bottom section of the Create
Contact Surface from Geology dialog, which is displayed by clicking the down arrow button next
to the Gridding method field.

Compositing Gap
The compositing gap parameter allows for minor un-logged intervals in the data, where it can be
assumed that the lithology has not changed much in the space of a gap.
Any gap between two lithology intervals of the same type that is less than or equal to the value in the
Compositing gap field is “interpolated”; in other words, it is assumed that the gap contains the same
lithology. If this field is left blank, all gaps are treated as real (no interpolation is performed).
Compositing only considers missing data – places where the lithology channel is blank. Thin
layers of known lithology are not composited over, even if the compositing gap value is greater
than the layer thickness.
To Adjust Compositing Gap:

1. Open the 3D Viewer and from the Utilities menu, select Create Contact Surface from Geology.
The Create Contact Surface from Geology dialog will appear.
2. Click the More button.
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3. Change the default grid name in the Output grid name field.
4. In the Compositing gap field, specify 1 as an initial compositing gap.
5. Click OK .
The updated subsurface topography grid is displayed on the map and in the 3D Viewer .
6. Compare the second surface (grid) with the original by toggling these grids on and off in the 3D
Viewer.

Blanking Distance
The blanking distance parameter may be used to improve the grid accuracy. All grid cells farther from a
valid point than the value of the Blanking distance field are blanked out in the output grid.
The default value of the Blanking distance field is the nominal sample interval, i.e., 2*(sqrt (grid area /
#data points)). This field value should be just greater than the maximum sampling interval through which
interpolation is desired. If there are too many holes in the resulting grid, you increase the blanking
distance appropriately.
Blanking distance is important in datasets where drillholes are spaced irregularly, and where large gaps
exist between some but not other drillholes. Under such circumstances, you need to decide what is more
important across the larger gaps: interpolation of any kind or better confidence in the resulting grid.
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Adjust Blanking Distance
The Blanking distance parameter can be used to improve the grid accuracy. All grid cells farther from a
valid point, than the value of the Blanking distance, are blanked out in the output grid.
To Adjust the Blanking Distance

1. Open the 3D Viewer and from the Utilities menu, select Create Contact Surface from Geology.
The Create Contact Surface from Geology dialog will appear.

2. In the Output grid name field, change the name of the required output grid so you don't overwrite an
existing one.
3. Click the More button to expand the dialog.

4. In the bottom section of the expanded dialog, select minimum curvature as the Gridding method.
5. In the Blanking distance field, type your blanking distance number. Note that the value is given in
ground units.
If you are experimenting, try typing a very small number to explore an extreme case.
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6. Click OK. The created surface displays on the current map and in the 3D Viewer.

Other Parameters
You can change three more parameters while refining your subsurface topography grids:
Gridding method
Starting search radius
Internal tension
For descriptions of these parameters and the potential results of changing their values, click the Help
button on the Create Contact Surface from Geology dialog.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Target Lithology Voxels
The Target Lithology Voxels tool enables you to create a 3D grid (voxel) based on data contained in a
string channel within a from-to drillhole database. A lithology voxel can be created from any geological
attribute that is expressed as a string; common examples include rock type, alteration, weathering and
mineralization.
A lithology voxel is created by calculating top and bottom surfaces for each attribute (as defined from the
string channel), and then filling up the spaces between the top and bottom surfaces with 3D cells, each
of which contain the attribute string code. The cells are clipped to the convex hull of any drillholes
containing the individual unit at each Z level. This process is repeated for each attribute found in the
string channel until a complete voxel for the attribute is created.
Lithology voxels are displayed in the 3D Viewer . Using the 3D Tool functions, you can manipulate the
display of the voxel, such as selecting individual or multiple "lithology" units for display, data extents,
transparency, etc.
This How-To Guide walks you through the recommended workflow for creating a lithology voxel, as
outlined below:
1. Create a drillhole project and import collar, survey, and from-to data.
2. Select the desired from-to data to use for gridding. Available data channels will be displayed in the
dropdown menu within the Create Lithology Voxel dialog.
3. Choose an appropriate gridding method (minimum curvature or natural-neighbour TIN)
4. Check that the resultant voxel is to the user's satisfaction. If not:
Adjust gridding parameters (e.g., cell size, compositing gap, non-contact radius, and/or gridding
method) or select/de-select drillholes as required
5. Iterate through steps 2 – 5 until the desired result is achieved
For more information on creating lithology voxels in Target, including descriptions of the available options
and parameters, click the Help button on the dialog of interest.

Starting a New Target Drillhole Project
When you start a new Drillhole Project an empty "Collar" database is created and displayed in the project
window. With the Drillhole system, individual ‘data type’ databases are created to enable easier data
management, and are displayed in the Project Explorer. These databases are linked by a common
project name, which appears at the start of the individual database names. For example, separate
databases for collar, survey, assay, and geology are created and linked by project name.
In a Drillhole Project named "Prospect" the following databases could be created:
Prospect_Collar.gdb (collar information)
Prospect_Survey.gdb (hole dip-azimuth survey information)
Prospect_Geology.gdb (geology information – The "Geology" label is user specified)

Prospect_Assays.gdb (assay information - the "Assay" label is user-specified)
When the Drillhole system is used, it scans the open project for all the project databases
currently loaded in the project to see which data is available. If you close one of the project
databases, it will not be visible to the system and will not be used when processing your data.
While working with a Drillhole Project, if you wish to "hide" one of the project databases,
minimize it instead of closing it in order that Target can continue to access it. You can see which
databases are in your project by viewing the list under Databases in the Project Explorer.
Projections can be set during project set-up when the "Specify coordinate system on import?" is enabled
on the Edit|Oasis montaj Settings dialog.

Preparing Collar, Survey, and Lithology Data
To create subsurface topography grids, as well as lithology voxels, you require three Geosoft databases:
A collar database
A survey database
A geology database that includes a From (depth) column, To (depth) column and a string column
containing lithology information
A string column (channel) contains plain text values, for example “LMSTN” for “limestone” or
“SDSTN” for “sandstone”.

Selecting Holes
A key requirement for the geologists and geochemists that are evaluating and presenting drillhole data is
the ability to select various combinations of drillholes for optimal visualization and plotting. Selecting
holes is also necessary for querying and creating data, as one may need to interpolate across holes to fix
how their data is displayed. The Target system provides a comprehensive set of options for performing
this task. The basic methods of hole selections are listed below.
Selecting (or Deselecting) All Holes: Enables quick development of master plan maps or resetting
of drillholes prior to making new selections.
Selecting Holes by Name or Name Mask: Enables batch selection of multiple holes with
systematic drillhole identifiers. Requires a standard drillhole naming scheme for identifying related
holes. For information on Name mask parameters, click the Help button on the Select holes by name
dialog.
Selecting Holes by List: Enables custom selection of single or multiple holes via a list of all the
holes in the database. Requires pre-existing knowledge of holes.
Selecting Holes by Plan map: Enables rapid visual selection of single or multiple holes by using a
polygon defining tool to select holes along regular or irregular sections, on a plan map. Useful for quick
evaluation of project data.
Select Holes by Collar table data: Enables custom selection of holes based on values from a
channel in the collar table channel. Once a channel from the collar table has been selected, the twopanel selection tool is displayed with all the available items which can be selected. Select one or
more, and then all holes with corresponding matching values will be selected.
Select Holes by Polygon File: Enables the selection of holes based on a polygon (PLY) file. This is
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useful for claims boundaries, etc.
Select Holes by the Selection Tool: Enables interactive selection of single or multiple holes by
area. The Hole Selection Tool includes a plan view of the drill survey area as well as display and
selection tools.
In addition, the system also enables you to save and load your selections.
Save and/or Load Selections: Enables you to save the current hole selections, or load previous hole
selections from a selection file (*.sel).

Creating Lithology Voxels
With this procedure, you can create a relatively simple lithology voxel using the default settings of the
Create Lithology Voxel feature.
To Create a Lithology Voxel

1. From the DH-Plot menu, select Create Lithology Voxel .
The Create Lithology Voxel dialog is displayed.

2. From the Geology channel dropdown list, select the required lithology channel.
3. In the Output voxel name field specify a voxel name, or use the Browse button to select the
required voxel name.
4. Use the Browse button next to the Rock code file field to select a file containing the required table
of rock (lithology) codes.
5. Click the More button to access the advanced gridding parameters.
For more information, click the Help button on the Create Lithology Voxel dialog.
6. Click OK . The lithology voxel is created and displayed on the new map. It is also displayed in the
3D Viewer on top of the map.
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7. Use the 3D View and 3D Tool functionality to rotate, resize, re-colour, and otherwise enhance the
graphical representation of the created voxel. For more information on these tools, see the 3D
View and 3D Tool help files in the Application Help.
Verifying Surface Correctness
A surface you have created and displayed might not correspond to your drillhole data with desired
precision. With this procedure, you can check the new surface against the lithology data associated with
individual drillholes.
To Verify Surface Correctness:

1. Display your created surface in the 3D Viewer window (3D|Open 3D Viewer).
2. From the Add to 3D menu in the 3D Viewer, select Drillholes .
The Draw holes to an existing 3D view dialog will appear.
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3. Click the Data tab. The Data page opens.
4. Under the Left side section, from the Data dropdown list, select a channel that contains the
required data and using the Plot Type dropdown, select Rock patterns.
5. Click Define. The Pattern Bands - Rock Codes dialog opens.
For more information, click the Help button on the Pattern Bands - Rock Codes dialog.
7. Click OK to close the dialog and return to the Drawn holes to an existing 3D view dialog.
8. Under the Right side section, from the Data dropdown list, select a channel that contains the
required data and using the Plot Type dropdown, select Post Text.
9. Click Define if you would like to define this plot type for your data, and click OK. The selected
drillholes, along with the subsurface topography grid you created earlier, are displayed in a new
map and in the 3D Viewer.
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As you zoom into the resulting 3D map, you can see that sections of the displayed drillholes are coloured
and text-labelled according to the selected table of rock type codes.
10. Use the 3D Tool panning, resizing, and rotation functions to examine intersections of your
subsurface topography grid with the individual drillholes.
You might find that one or more intersections of the created surface does not correspond exactly with the
geological boundary you have requested. You can achieve more precise results by adjusting the surface
gridding parameters and choosing more specifically the holes to use.
Having adjusted a parameter’s value, you will need to repeat the surface creation procedure and examine
the results. Achieving satisfactory results may require several iterations.
It is recommended that you give each new version of the resulting grid a new name. If you need to
keep the same grid name, you will need to first delete the original grid from the map and from the
Planes & Surfaces section of the 3D Tool . Otherwise, the new grid will be displayed on the relief
surface of the original grid, and the subsurface topography grid changes will not display.
It is not recommended that you change multiple parameters in a single iteration. The results of
several changes made simultaneously might be contradictory and difficult to analyse.

Display Drillhole Data In a Voxel 3D View
You can easily add data to your 3D View while working in the 3D Viewer, via the Add to 3D menu.
To Display Drillhole Data in a Voxel 3D View

1. Open your voxel in the 3D Viewer (3D|Open 3D Viewer). Note that if your voxel is not yet
displayed in your 3D map, you can drag it from the Project Explorer (under Voxels) to the centre of
the 3D Viewer. Your voxel will be displayed in both the 3D Viewer Explorer and the Project
Explorer Windows lists, as shown below:
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The name of the voxel as it appears in the Project Explorer differs from how it appears in
the 3D Viewer Explorer. Voxels in the 3D Viewer Explorer have the VOX_ prefix, although
they can be edited at any time by clicking twice on their name.
2. From the Add to 3D menu, select Drillholes. The Draw holes on an existing 3D view dialog is
displayed.

3. On the Data tab, in the Left side section, from the Data drop-down list, select the channel that
contains the required data.
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4. From the Plot Type dropdown list, select the type of plot you are making.
5. Click the Define button if you would like to select a file that contains the codes for your plot type.
Click OK to close this dialog.
6. In the Right side section, from the Data dropdown list, select the channel that contains the
required data.
7. From the Plot Type dropdown list, select the type of plot you are making.
8. Click OK . The selected drill holes are displayed in the 3D Viewer along with the voxel you created
earlier.
If you see only some or none of your holes (because they are hidden within the voxel volume),
there are ways to expose the drillholes in the voxel view:
To Clip the voxel along X, Y, and/or Z axes
To Clip the voxel to specific lithology unit(s)
To Clip the voxel along a specified azimuth and dip (Angled Clipping)
To use the Transparency control to manipulate the voxel and drillhole groups
Clipping Voxel Along Axes
Using the Clipping tab on the 3D Viewer, you can apply clipping to each of the 3 independent axes (X, Y,
Z) enabling you to clarify the required details within your 3D view.
To Clip Voxel Along Specific Axes in Order to Reveal Drillholes:

1. In the 3D Viewer Explorer window, highlight the name of your voxel (the file with the
beside it).

icon

2. Select the Clipping tab.

3. Use the X, Y and/or Z sliders to clip the displayed voxel along the corresponding axes, which
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adjusts the extents of the voxel in the 3D Viewer window accordingly. You can now also modify
the orientation of the X, Y,Z Axes in order to perform Angled Clipping. Angled clipping works for all
types of groups and planes.

4. The drillholes are now revealed.
Clipping Voxel to Specific Lithology Units
The Lithology Unit Selection dialog, available on the Clipping tab of the 3D Viewer, enables you to select
the individual lithology units to display.
To Clip Voxel to Specific Lithology Units to Verify Correspondence with Drillhole Data

1. On the Clipping tab of 3D Viewer, click Lithology Unit Selection.
The Lithology Unit Selection dialog is displayed.
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2. Clear/check the Selected check boxes of to hide/display the corresponding lithology units in the
voxel 3D view.
3. Use the 3D Tool panning, resizing, and rotation functions to examine intersections of the bedrock
surface with the individual drillholes.
You can achieve more precise results by adjusting the voxel creation parameters. For
instance, you can adjust the voxel cell size, compositing gap, or noncontact radius.
Having adjusted a parameter’s value repeat the voxel creation procedure and examine the results.
Achieving satisfactory results may require several iterations.
It is not recommended that you change multiple parameters in a single iteration. The results of
several changes made simultaneously might be contradictory and hard to analyse.
Angled Clipping
The 3D Viewer provides the option to modify the orientation of the X, Y, Z Axes in order to perform
Angled Clipping. Angled clipping works for all types of groups and planes.
To Apply Angle Clipping to a Voxel

1. In the 3D Viewer Explorer window, highlight the name of your voxel (the file with the
beside it).

icon

2. Select the Clipping tab.
3. For the X (Y and/or Z) axes, check the Modify orientation checkbox. The Azimuth and Dip
parameters are enabled.
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4. Using the Arrows ( ) or by typing in a specific value, modify the Azimuth and Dip parameters to
angle clip the displayed voxel along the corresponding axes, which adjusts the extents of the voxel
in the 3D Viewer window accordingly.
Apply Transparency
The 3D Viewer enables you to apply Transparency to your Voxels, Grids and Images, providing a lighttable effect, enabling you to view all of your data simultaneously.
To Apply Transparency to a Voxel

1. In the 3D Viewer Explorer window, highlight the name of your voxel (the file with the
beside it).

icon

2. Select the Attributes tab.
3. Using your cursor, move the slider on the Transparency bar (
). To increase the transparency, slide the bar to the right
and to decrease the transparency slide the bar to the left.

Adjust Voxel Cell Size
In your project, a lithology voxel created with the default parameters may disagree with some of the data
in individual drillholes. A better agreement between the hole data and the surface might be achieved by
decreasing the voxel cell size.
Smaller cell size means longer processing time and a larger output voxel file. When dealing with
large datasets, be aware of the trade-off between the processing accuracy and processing time
(as well as disk space).
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To Adjust Voxel Cell Size:

1. With the map open and selected in the 3D Viewer, select Utilities, and then select Create
Lithology Voxel.
The Create Lithology Voxel dialog appears.
2. Using the Geology channel dropdown list, selected the channel to be processed and then click the
More button.
The dialog expands to display additional parameter fields.

3. Change the output voxel name so that you don't overwrite the original voxel.
4. Click the Calculator button next to the Cell size field. The system calculates the default cell size
and displays it in the Cell size field.

5. Change the value of the Cell size field to a smaller number. You can actually use a real number for
the cell size, for example a voxel cell size of 0.5 or 2.5m (any decimal fraction) is acceptable if you
desire.
6. Click OK. The system creates the requested voxel using the specified cell size and displays it on
the current map, as well as in the 3D Viewer .
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7. In the View/Group Manager Tool window, uncheck the original voxel to reveal the updated one
(unless you overwrote the original voxel).
8. Using the 3D Tool functions (including clipping along axes and clipping to specific lithology units),
navigate to the individual holes and verify whether the updated voxel satisfactorily corresponds to
the drillhole data. You can now also modify the orientation of the X Y and Z Axes in order to
perform Angled Clipping. Angled clipping works for all types of groups and planes.

Adjust Compositing Gap in 3D Drillholes
The compositing gap parameter allows for minor un-logged intervals in the data, where it can be
assumed that the lithology has not changed from what is present above and/or below that interval.
Any gap between two lithology intervals of the same type that is less than or equal to the value in the
Compositing gap field is “interpolated”; in other words, it is assumed that the gap contains the same
lithology. If this field is left blank, all gaps are treated as real (no interpolation is performed).
Compositing only considers missing data – places where the lithology channel is blank. Thin
layers of known lithology are not composited over, even if the compositing gap value is greater
than the layer thickness.
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To Adjust Compositing Gap:
1. If you have not done so already, draw your drillholes on the current 3D view using a lithology
channel that contains the required data (use Add to 3D|Drillholes).
2. On the Utilities menu select Create Lithology Voxel.
The Create Lithology Voxel dialog appears.

3. Change the default voxel name in the Output voxel name field to keep the original voxel intact.
4. Click the More button to expand the dialog.
5. In the Compositing gap field enter a value that is an estimate of the smallest visible gap in your
data.
6. Click OK . The updated voxel is displayed on the new map and in the 3D Viewer.
7. Zoom in to individual drillholes to check and see if your gaps have been composited over.

Adjust the Non-Contact Radius in 3D Drillholes
The non-contact radius parameter defines the radius of a “hole” in a contact surface grid produced by a
drillhole that did not intersect the contact surface lithology unit. This parameter is always set to a value
smaller than or equal to 50% of the distance from the non-contact point to the nearest contact point. If the
Non-contact radius field is left blank, the “hole” is sized for each contact individually, based on 50% of
the distance to the nearest contact. If the field is set to zero, no dummying is performed around holes
with no contacts.
To Adjust Non-Contact Radius:

1. Select (highlight) your database in your project workspace.
2. Display your existing voxel, either by opening it or by going to 3D|Create a New 3D View and
dragging your voxel from the Project Explorer to the centre of the blank 3D map.
3. On the Utilities menu, select Create Lithology Voxel.
The Create Lithology Voxel dialog appears.
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4. In the Output voxel name field, change the default voxel name (so that you don't overwrite the
existing voxel).
5. Click the More button.
6. In the Non-contact radius field, specify a value in ground units.
7. Click OK . The updated voxel is displayed on a new map, as well as in the 3D Viewer.
8. Put the initial and the new voxel views side-by-side in your project workspace for comparison.
Other Parameters
You can change other parameters while refining your lithology voxels:
Gridding method (Minimum curvature – default, or Natural-neighbour TIN)
For the Minimum curvature gridding method:
Blanking distance
Starting search radius
Internal tension
For descriptions of these parameters and the potential results of changing their values, click the Help
button on the Create Lithology Voxel dialog.

Practical Suggestions
This section presents some suggestions for overcoming known limitations of the Lithology voxel feature:
Pinched Out Layers

When a layer pinches out, it may not be possible to get reasonable results if there are more layers of the
same lithology unit in the dataset. The suggested approach is as follows:
1. Create surfaces for layers above the pinch-out as usual
2. Create a surface for the last layer of the unit sequence using the “last layer” selection
3. Exclude holes while creating a surface for the pinched out layer
4. While creating surfaces for layers below the pinch-out, create two separate confined grids to
represent a single layer
Folded and Faulted Layers

For folded and faulted layers, it may be necessary to adjust non-contact radius and/or blanking distance
to better represent regions that are missing due to the complexity of the geology.
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Differentiation between folded and faulted lithologies is difficult based on the surfaces created using the
Geology 3D procedure. It may be possible to distinguish between folds and faults by considering
behaviour of all the layers:
1. Folded layers bend about the same apex, while faulted layers may bend at different apexes.
2. Folded layers may have parts of the unit missing at the tops or bottoms of folds, while faulted
layers may have parts of the unit missing in the vicinity of the fault plane (less likely to look like an
apex of a fold).
3. When intruding units are involved, especially if there are several intrusions of the same type of
unit, it may be necessary to exclude certain holes from the surface gridding to produce reasonable
results.
4. In cases where a similar rock type has repeating layers in the subsurface, you achieve better
results by differentiating these units by using different names for each layer. This way you can
create surfaces for each successive layer.
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Digitizing Geological Interpretations on Section Maps
This document provides a description of the workflow to digitize geological interpretations on drillhole section and plan
maps. Using a combination of real data plotted on the map and expert knowledge, geologists can use their expertise to
draw interpretations on drillhole maps. The 2D interpretations for all the features on all the section maps can be saved to the
same geostring file. The single file solution makes it easy to manage the interpretations and to share your work with others.
The interpretations can later be joined to create 3D surfaces.
This document will guide you through:
Creating a new geostring file
Adding features to the geostring file
Digitizing geological interpretations
Editing interpretations
Deleting interpretations
Changing the properties of an interpretation
Viewing a summary of the interpretations in a geostring
Visualizing the geostring in the 3D Viewer

Section maps with downhole data
Before you begin digitizing geological interpretations that will be joined into a wireframe, you must first create a series of
section maps for your drillhole project. When creating the section maps, specify the downhole data to plot that you will use
as a guide when digitizing your interpretations on the map. After you have created your section maps, use the Geostrings
Tools Bar to create the geostring file, digitize interpretations, and manage the features and interpretations in the geostring
file.
Tips:
When creating the drillhole maps, plot the downhole data from composite databases to simplify digitizing and
snapping.
If you are plotting downhole lithology, you may also want to use Post text or Text bands from the Data tab. Offset
from the rock patterns, these items can be used to highlight lithologies of interest.
Decreasing the distance between section maps and trying to position the holes as close to the centre of the section
as possible will allow you to create more accurate interpretations and wireframes.

Geostrings Tools Bar
The Geostrings Tools Bar drives the digitizing workflow for drawing interpretations on your section maps. If the toolbar is
not loaded in your project, right-click in the toolbar area under the menus and select Geostrings Tools Bar.
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Geostring files
Geosoft geostrings are 3D vector files that store digitized interpretations drawn on section maps. Both polygon and polyline
features can be stored in the same file.
Geostrings store the following information:
XYZ locations
Coordinate system
Attributes including feature names and colours
Note:
The Coordinate system for your geostring file will automatically be set based on the current Target drillhole project. It
is recommended that you set the Coordinate system for your drillhole project before you create your section maps,
geostring file and any other output from your project. The Coordinate system for a drillhole project is set through DHData | Coordinate System.
To create a geostring file:
1. From the Geostrings Tools Bar, click New Geostring.
2. Enter a Geostring name.
To add a feature to a Geostring file:
1. In the New Geostring for Geological Feature Interpretations dialog box, to the right of Features to digitize, click Add
new feature

.

2. Enter a Name.
3. Select the display Colour for the Feature (this can be changed later).
4. The Digitization Type Polygon is selected by default. Change it to Polyline if required. Wireframing polygons will
create a closed body (or body, lithology body, etc...). Wireframing polylines will create an open surface (fault, vein,
etc...)
5. You can optionally enter a Description for the Feature.
6. Click Add.
7. Continue adding as many Features as you require for your project to the geostring file. A geostring file can store many
polygon and polyline features.
8. Click OK on the New Geostring for Geological Feature Interpretations dialog.
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Note:
If you need to change the Name, colour, digitization type or description for a feature that you added to the geostring
file, select the Feature to digitize in the New Geostring for Geological Feature Interpretations dialog and click Edit
selected feature.
If you are returning to a project and would like to continue digitizing and managing interpretations in an existing
geostring, click Open Geostring from the Geostrings Tools Bar. The interpretations in the geostring will
automatically display on the section maps they were drawn on.
To digitize geological interpretations:
1. Display one of the open section maps so it appears in front of any other open windows in the project.
2. On the Geostrings Tools Bar, select the Feature you want to digitize an interpretation of.
3. If Toggle Snapping is turned on (the snapping icon will appear active on the Geostrings Tools Bar), select an item to
Snap To. You can snap to True Drillhole Locations or Projected Map Groups or Geostring Features. You can Toggle
Snapping off if you prefer to digitize without it.
4. On the Geostrings Tools Bar, click Digitize Interpretations.
5. If Snapping is on, hover the mouse over different parts of the section and observe how it changes when it comes to
within 10x10 pixels of the specified Snap To item.
6. Use the left mouse button to add vertices for the polygon or polyline feature.
7. To end the interpretation (i.e. to close the polygon or end the polyline), right-click | Done.
8. Use steps 1 – 7 to digitize geological features on your other section maps. You can easily switch between section
maps by double-clicking a map listed under the Project Explorer.
Tips:
While digitizing, you can use the Undo/Redo options from the right-click context menu, or use the Ctrl+Z or Ctrl+Y
shortcut keys, respectively.
To pan and zoom while digitizing, right-click on the map and select an option from the context menu, or use the
assigned shortcut keys for each function that are listed in the context menu (i.e. "P" for Pan and "Z" for Zoom In).
Don't double-click to end the polyline or polygon as this adds two vertices at or near the very same location.
Digitizing more points will create smoother interpretations which will also create smoother wireframe surfaces once
the 2D interpretations are joined into 3D surfaces.
If you recreate a section map or replot the holes on a section map, the interpretations in the geostring file will remain
visible on the map.
In Oasis montaj and Target, an open geostring is displayed in the open section maps. When the Geostring
interpretations are closed they are no longer displayed in the map. if the geostring is open, but the Target Project
databases are not open, then the option to snap to true drillhole location cannot be used.

Snapping
While digitizing, if snapping is enabled, you can snap to the true drillhole locations, to a projected map group, or to an
existing geostring feature.
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True Drillhole Locations
The cursor will snap to the true X, Y, Z location along the drillhole trace for the from or to intervals in the specified drillhole
database.
If you allow the snapping cursor to remain still at a location, a tooltip will show the database being snapped to, the
distance away from the centre plane of the section and the true X, Y, Z position at that position.
Projected Map Groups
The cursor will snap to the X, Y, Z location of the specified map group projected onto the centre plane of the section. Only
vector groups can be selected, not grid groups.
If you allow the snapping cursor to remain still at a location, a tooltip will show the map group being snapped to and the X,
Y, Z position of the section plane at that location.
Geostring Features
The cursor will snap to the X, Y, Z location of the specified geostring feature.
If you allow the snapping cursor to remain still at a location, a tooltip will show the geostring feature being snapped to,
whether a vertex or edge is selected, and the X, Y, Z position of the feature at that location.

Manage Features
The Manage Features option
on the Geostrings Tools Bar allows you to add features, edit existing features (change the
name, colour and description) and delete features for a geostring file.
To edit geological interpretations:
1. Open the geostring file to be edited.
2. Click Select Interpretations

from the Geostrings Tools bar.

3. Select the geostring feature (polyline or polygon) to be edited.
4. Click Edit Vertices...
from the Geostrings Tools bar. The vertices are now highlighted by square symbols on the
map. Points on the section plane are white squares; points off the plane of the section will appear pink.
5. Use the mouse to move existing vertices.
6. To add new vertices, click Add Vertices...
from the Geostrings Tools bar (this is also available in the right mouse
button menu) then add new vertices between existing vertices.
7. To delete vertices, click Delete Vertices...
from the Geostrings Tools bar (this is also available in the right mouse
button menu) then select the vertices to be deleted.
Vertices can be added or removed from polygons by using the plus ( + ) and minus ( - ) keys on your Number
Keypad.
The plus ( + ) and minus ( - ) keys on the main alpha-numeric keypad will not work; you must use the Number
Keypad only.
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To delete an interpretation:
1. Click Select Interpretations

from the Geostrings Tools bar.

2. Click on an interpreted shape on the section map to select it. Once selected, it will be bounded in cyan.
3. Click Delete

on the Geostrings Tools Bar.

Note:
Any saved wireframe progress that is stored in the geostring will be deleted for the feature. This operation cannot
be undone.
To change the properties for an interpretation:
If you digitize an interpretation on the section map but realize that it was added to the wrong feature, you can reassign the
interpretation to the correct feature.
1. Click Select Interpretations

from the Geostrings Tools Bar.

2. Click on an interpreted shape on the section map to select it. Once selected, it will be bounded in cyan.
3. Click Interpretation Properties

on the Geostrings Tools Bar.

4. Select the correct Feature for the interpretation and click Save.
To view the Geostring Table:
The Geostring Table is a summarized list of section maps and features with interpretations.
1. Click the Geostring Table option from the Geostrings Tools Bar. The table displays the section maps that have
geological interpretations. Location information is also presented for each map. The number of interpretations per
Feature is shown for each drillhole map.
2. Click Close when you have finished viewing the information in the table.
Note:
You can double-click a row in the Geostring Table to open the map.
The Delete button
will delete all the interpretations for all the features for the selected section map. Any
wireframing progress for those features will also be removed from the geostring. This operation cannot be undone.
If you see a row in the Geostring Table highlighted in pink, this indicates that the section map cannot be found
because it was either moved or renamed. Select the row and use the Find missing map button
select the missing map.

to browse to and

To view the Geostring in the 3D Viewer:
The Geostring Table is a summarized list of section maps and features with interpretations.
1. Open the 3D Viewer for an existing 3D map or to create a new 3D map, use DH-Plot | 3D Map.
2. From the Add to 3D menu, click Geostring.
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3. Select the Geostring File and click OK. Your interpretations will display in the 3D Viewer. In the tree list, you will
see the geostring as the top layer; your features will be listed below this. Below each feature, the section maps with
interpretations for the feature are listed.
4. You can optionally toggle items on or off in the tree list to help you visualize your 3 model.

Tip:
Any edits made to the interpretations on your section maps will automatically be updated in the 3D Viewer.
How-To Guide Publication Date: 29/04/2014
Copyright 2014Geosoft Inc. All rights reserved.
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Geosoft Seeker Tool in Target
The Geosoft Seeker tool is designed to help you search for and download spatial data stored on global
and corporate spatial servers including Geosoft DAP servers and WMS servers, as well as data
discovered by the Dapple Search data service and spatial data indexed locally by Desktop Cataloger.
From the Seek Data menu, select Seeker to open Seeker and find relevant exploration data.
The steps to using the Seeker Tool:
1. Search – Use the search tools to define spatial and text criteria for the data you are seeking.
2. Results – Preview a dataset as a quick thumbnail view or in geographical context using the
Preview map, and review metadata.
3. Download – Download selected datasets directly into open map or project.

Searching for Data
Seeker enables you to find, view and download a dataset in 3 easy steps. The first step is to query your
list of servers to determine what data are available that match your area of interest (AOI). Available data
sources include DAP Servers, WMS servers, the Dapple Search data service, and local data indexed by
Desktop Cataloger.

Geosoft Seeker Tool
Searching for Data

When you open Seeker the initial Search extents are based on your current open map. If you do not have
an open map, the area of interest (AOI) is the world.
To narrow results by metadata, click the Advanced Search tab.
The Search tools include the Server list, Text Search, Area of Interest and Advanced Search.
To Use Search Tools

1. On the Seek Data menu, select Seeker.
The Seeker tool opens and the Search page is displayed.

If the AOI displayed in the window is not the same as your open map, click the Update
area of interest from current map extents button (

)

2. Narrow your search.
There are several methods to narrow the search to a specific region or data type:
Specify a keyword or phrase in the Text Search text box so that only datasets that intersect
your AOI and/or contain text that matches a text string will be displayed. You can type in
multiple words and use wildcards (*) and logical operators (AND, OR, AND NOT). Click
Results, the magnifying glass ( ), or simply press Enter when finished filling in the Text
Search box to move to the Results page.
Set the Area of Interest using the select a region dropdown list, which is provided through the
selected DAP Server. This is a very handy list that can include countries, province/state
boundaries, or mapsheet/quadrangle names. The Area of Interest map enables you to view and
redefine your AOI. Use the Navigational tools or Geographic (long, lat) search to redefine your
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Geosoft Seeker Tool
Viewing Results

AOI interactively while you view the changes in your map tab.
Click Advanced Search to select the intersection of the datasets with the AOI, as Overlap area
of interest or Inside area of interest. The Advanced Search tab also provides tools that enable
you to Narrow results by metadata, using Boolean operators and predefined dropdown lists
made available through the selected Server. Your metadata search can be Saved for future use
and then Loaded to reapply the same search criteria at a later time.

Some DAP Servers do not support metadata queries.
3. The selected Search results will appear on the Results page.

Read the How-To Guide
Geosoft Seeker Tool in Oasis montaj

Viewing Results
The Results page enables you to view the results of the current search for all your data sources: DAP,
WMS, the DappleSearch web service and My Data from your Desktop Cataloger.
The Results Tools include Text search tip, Server list, Results list, Preview Map tab and a Metadata tab.

www.geosoft.com

Target How-To Guide | 257

Geosoft Seeker Tool
Viewing Results

Server List - The server list expands the tree or displays the list of datasets from the selected server:
DAP including Desktop Cataloger results under My Data, Web, and WMS. The number of valid
results found per data source are presented. The number of results can be found to the right of the
server name in Tree view and below the Results list in List view.
Results List - The results pane enables you to view your search results in Tree View or List View.
The view may depend on the selected server (DAP, Web, My Data, WMS) you are viewing. Not all
data sources can be displayed in both views. Check a dataset, in any view, to display an image of the
dataset in the Preview Map tab, display the dataset's metadata in the Metadata tab, and add the
dataset to the Download list.
Preview Map - Preview an image of a selected dataset from the Results list. The Preview Map
includes Navigation Tools that enable you to zoom in, zoom out and zoom to full map and toggle the
Browser Map.
Metadata - Metadata (data about data) is captured by Target from the first time the dataset is touched.
The metadata information, which is based on ISO 19139 standards, is stored inside the data (if
supported) or as a companion XML file. For more information click the Help button on the Seeker tool.
To Use the View Results Tools

1. Click Results. The Results page opens, displaying your current server search results.
2. If desired, you can view other data source results from the Server list. The data results are
available in two views (Tree and List). Depending on the server, both views may not be available.
When viewing the results in tree or list view, if you hover your cursor over the data icons
a thumbnail image will be displayed.
3. Select a dataset by placing a Check in the box in front of the dataset name.
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Geosoft Seeker Tool
Downloading Selected Datasets

4. Click the Preview Map tab, and the selected datasets are displayed in the preview map window.
Click the Metadata tab to view the Metadata for the selected dataset.
5. When you are satisfied with your data selections, click the Download.

Read the How-To Guide
Geosoft Seeker Tool in Oasis montaj

Downloading Selected Datasets
The Download page enables you to prepare a dataset for download. The Download list is created from all
selected data from the Results page. Datasets from multiple servers (DAP, WMS, Web and My Data)
will be displayed in the list of selected data.
From the Download page, you can take several actions:
Download Properties - Enables you to specify download options for selected datasets. Select
(highlight) a dataset in the Download list to enable the Download properties options.
Download All - Downloads (or opens, if the data is in My Data), the selected datasets to a new or
current map, if applicable.
Datasets from My Data will be opened directly, not downloaded.
To Download Selections

The Download page includes a Download list, Download properties area, and Download All button, as
detailed below.
1. Select (highlight) the file to download.
To select multiple files for download use the <Shift> or <Ctrl> keys while selecting files.
2. When you are satisfied with the Download properties for each dataset, click Download All.
Downloaded data may be displayed in your current open map, or if you do not have a map currently
open, the downloaded data will be displayed in a new window as required.
You can remove datasets from the Download list by right clicking and selecting "Remove"
or using the Delete key.

Read the How-To Guide
Geosoft Seeker Tool in Oasis montaj

Desktop Cataloger
The Geosoft Desktop Cataloger is a free utility that helps you build a catalog of your spatial files from
your local drives, and enables you easily find that data when using the Geosoft Seeker tool.
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Geosoft Seeker Tool
Desktop Cataloger

With Desktop Cataloger, you build a My Data catalog of spatial files by selecting folders on your
computer or external drives (can not catalog network drives). You can also specify data types to be
cataloged from a preset list of spatial dataset file types. The list of supported data types includes ECW,
ERS, GDB, Geosoft VOXEL, Geosoft GRD, ArcGIS LYR, ArcGIS SHP, MapInfo TAB and GeoTIF
Images.
For more information or to download Desktop Cataloger, visit
http://www.geosoft.com/pinfo/free/desktop-cataloger.asp
How-To Guide Publication Date: 29/04/2014
Copyright 2014 Geosoft Inc. All rights reserved.
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Exporting and Printing Maps in Target
Target provides the ability to export interim processed data to another system for additional manipulation
or to a GIS system for creating final map products and integrating with other sources of data. Required
tools for exporting data to Geosoft XYZ and other formats are also provided.
Target uses your installed Windows system drivers to create printer or plotter output. Depending on your
installed driver, you may find it does not produce the highest quality output or that it takes a long time to
produce a plot.
Geosoft provides a special printer configuration capability that enables you to initialize an internal raster
engine that performs most of the print/plot processing and passes it to the driver for final output.
If you are not satisfied with your driver's performance, you can try selecting this option. Normally, with
high-quality drivers, you should not have to use this option but it can help with problem drivers or
PostScript printing.

Exporting Maps
Geosoft recognizes the need for the ability to move data, grids and images easily to other software
systems. Supported export formats for maps include:
Enhanced Metafile

MapInfo TAB

ArcView Shapefile

Geosoft Plot file

CGM Plot

DXF AutoCAD

Bitmap

DXF AutoCAD v12

PCX

JPEG

PNG

JPEG High Quality

Encapsulated Post Script

TIFF

TIFF Compressed

GeoTIFF

Geosoft COLOUR Grid

MapInfo TIFF

ER Mapper RGB

ArcView TIFF

ER Mapper ECW Compressor

Exporting and Printing Maps
Exporting Maps to a File

Exporting Maps to a File
The Export Map option enables you to export your maps to a file or the clipboard. For more information on
exporting data, refer to the How-To Guide: Importing and Exporting Databases.
To Export Maps to a File

1. Select an open map in your project.
2. On the Map menu, select Export.
The Export Map dialog appears.

3. Select the Output Format, such as *.EMF, *.TIF, *.PLT or as required.
4. Specify the Region to Export as Viewed Region, Full Map or Selection.
5. Set the Image Raster Resolution.
6. You can Export To to File or Clipboard.
7. From the Options dropdown list, select from Cluster Dither, Error Diffusion or No Dither.
For information on any of these parameters, click the Help button on the Export Map
dialog.
9. Click OK. The system exports the map.
If you selected to export to a File the system will display the Exported file name dialog.
Specify a name for the file and click Save.
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Exporting and Printing Maps
Printing Maps

Printing Maps
By default, the system is set up to use your current Windows driver. When you start printing maps for the
first time, you will most likely accept the defaults. Depending on your driver’s performance however, you
may want to add a new configuration that uses a more advanced printing option, such as Geosoft bands,
Geosoft bands and dither, or HP-RTL. Refer to the on-line help system for a complete discussion on the
pros and cons of the different printing modes.
Page and Printer Setup
For optimal printing, you may have to experiment with printer settings and properties. Different drivers
allow different selections (paper size, orientation, dithering patterns and colour controls). However, they
can be very slow especially for large plots.
To Configure Your Page Setup

Before you begin, verify your project is open.
1. On the File menu, select Page Setup.
The Page Setup dialog will appear.

2. From the dropdown lists, select your Paper Size and Paper Source.
3. Specify the Orientation: Portrait or Landscape.
4. If required, adjust the Margins.
5. Click OK to confirm the settings.
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Exporting and Printing Maps
Printing Maps

To Configure Your Printer Setup

Before you begin, verify your project is open.
1. On the File menu, select Printer Setup.
The Print Setup dialog will appear.

2. From the dropdown list select the printer Name.
You can click Network to browse for a different network printer.
3. Adjust the Paper and Orientation settings as desired.
4. Click OK to confirm the settings.
Change or Add New Printer Configuration
Use the Change Printer Configuration/Add Printer Configuration dialog(s) to change the configuration of
your printing mode, colour scaling and other print options.
To Add a New Printer Configuration

1. On the Print dialog, click the Add Config button.
The Add Printer Configuration dialog will appear.
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Printing Maps

2. Select your Print Mode.
If you want to use Windows drivers for printing, select Windows.
If you are having problems with your Windows drivers and want to optimize your printing speed,
select Geosoft bands or Geosoft bands and dither
Select Geosoft HP-RTL device if you have this type of printing device
3. Adjust the Colour Scaling to change the CYMK colour values, if required.
4. If you want to adjust the Image print resolution change the default dpi value.
5. Click OK. The system saves your new configuration and initializes it for use.
To change your printer configurations click the Change Config button from the Printer
Setup dialog.
Print Preview
Use the Print Preview dialog to display the active map, as it would appear when printed.
To Preview a Map Before Printing

1. On the File menu, select Print.
The Print dialog will appear.

www.geosoft.com

Target How-To Guide | 265

Exporting and Printing Maps
Printing Maps

2. Specify the Select Region to Plot and the Plot Scale.
3. If your map uses Panels, specify that option.
4. Click Preview. The system displays a preview of how your map will look when printed on paper.
5. Click Print if the map is ready for printing or click Close to return to the Print dialog.
Print a Map
Use the Print dialog to specify how you want your print job to appear and to send a job to the printer.
To Print a Map

1. Select (highlight) the map that you would like to print.
2. On the File menu, select Print.
The Print dialog will appear.
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Printing Maps

3. Specify the Region you want to print: Viewed Area or the Entire Map.
4. Specify the Plot Scale.
To maintain the map scale, select the Scale Factor option and specify a value, (1 = 100
per cent). If you use this option, the map may require more than one page depending on
the media to which you are printing or plotting.
5. If the plot uses Panels, specify either All panels or a Rangeof panels. If you are printing multiple
panels, you can specify an overlap in mm. This helps you to match panels later.
6. Specify the number of Copies to be printed.
7. If required, select the Print to File option box and specify a filename.
8. If required, select Centre on Page to centre the plot on the page. You can also centre the plot on a
paper roll by selecting Fit On Roll.
9. To move the map from its origin (lower left corner of page or plot), specify an Offset distance in
mm.
10. Click Print to send the map or plot to the currently configured printer or plotter.
Printing in Batch
For high efficiency automated printing and plotting, Geosoft provides a batch printing capability. This
capability enables a number of plots to be printed sequentially without any hands-on intervention.
To Print in Batch

1. On the File menu, select Batch printing.
The Print Multiple Maps dialog will appear.
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Exporting and Printing Maps
Printing Maps

2. On the Maps to Print box, specify the maps you want to print. To specify more than one map, map
names should be separated by a ‘|’ (vertical bar) character.
You can also select multiple files by clicking the Browse button. In the Maps to Print
dialog press and hold the Ctrl key and while clicking the left mouse button to select the
maps you wish to print.
3. Specify the other parameters as required.
For more information about Batch printing options click the Help button.
4. Click OK. The system sends the maps to the installed printer or plotter.
How-To Guide Publication Date: 29/04/2014
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